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Introduction 

Express Publisher for JhkMate is a pagedesign program that lets you 
easily combine graphics and text to mate professionalquality docu- 
ments. Use Express Publisher for DeskMate to create pt-looking 
newsletters, reports, flyers, announements, invitations, or presentation 
materials. You can import pictures and text from other graphics and 
word processing programs; or use Express Publishefs tat-handling 
features to create documents from scratck If you want complete artistic 
control, you can create your own page layouts; or use one of the 
provided templates to get professional results fast. Either way, you will 
have no trouble mating impressive work with Express Publisher. 

Layout Page layout in Express Publisher for DeskMate is as simple to 
understand as using scissors and tape, but much less aggravating. 
Once you learn the simple automatic layout functions, you'll be 
able to create great-looking pages in a fraction of the time you 
might spend using a word processor. While you work, Express 
Publisher displays your document on the screen as it will appear on 
the printed page. Feel free to experiment and make mistakes. You 
can move and change every element in a document. Don't worry 
about your drawing ability: you can draw perfect boxes, lines, and 
circles without any special skills using the drawing tools. 

Graphics Unlike other entry level publishing programs, Express Publisher can 
import several types of high resolution graphics. These file formats 
include scanner-generated TIFF, the most popular standard for profes- 
sional clip art; ART from Fmt Publisher; MAC files from h4acPaint; and 
PCX, created by k t  d e r s  PC Paintbrush8and Publishex's Paintbrush'? 
To help you get started, we've included a collection of high qual~ty TIFF 
pictures in both 150 and 300 dpi Once pictures are imported, they can be 
scafed to fit in with the rest of your work 

Text Express Publisher includes the text-handling abilities you need to 
create professional documents: several justification formats, cut and 
paste, and leading are just a few of the options. You can choose the 
typeset quality Cobb, Marin, and Dixon fonts. If you want more 
fonts to work with, you can purchase additional AECH FastFont 
typefaces. For super-fast formatting, Express Publisher's style 
commands can apply several formatting commands at once. 

I n t r o d u c t i o n  ix 



Express Publisher can keep track of several stories at once in a 
single document, flowing text from column to column, and even 
skipping over other stories and pages. Create all the text you need 
for your work inside of Express Publisher, or import files directly 
from several of the more popular word processors. Microsoft 
Works® versions 1.X and 2.0, Microsoft Word@ (versions 4.0 and 
5.0), WordPerfect®, versions 4.X and 5.X) DeskMate text, DeskMate 
Q&A Write, and ASCII can all be imported directly. 

System requirements 

Express Publisher for DeskMate has been tested on the following 
hardware: 

A Tandy 1000 TL/3; a Tandy 1000 RL/HD; a Tandy 2500 XL/2; 

640K of RAM. 
A Tandy Serial Mouse or PS/2 style mouse (2 button type such 
as Logitech, Microsoft and Mouse Systems). 
A hard disk with at least 3 Mb of available disk space and 3.5" or 
5.25' disk drive 
A Tandy DMP 107 printer, a Tandy DMP 134 printer, a Tandy 
DMP 240 printer, a Tandy DMP 302 printer, or a Tandy LP 950 
Laser Printer. (1.5 Mb of memory is recommended.) 
Version 3.0 or later of DOS (DOS 5.0 is recommended). 
Though not required, extended memory or LIM 4.0 expanded 

or a 100% IBM PC compatible computer. 

memory are suggested. 

The install program 

The install program copies Express Publisher for DeskMate onto 
your hard disk, and configures the program for your hardware. 
Express Publisher will not work if you to try to run it from the 
master disks. The only time you should use the master disks is to 
run the setup program or to make backup copies. 

Make sure that you have 3 Mb of disk space available on your hard 
disk before using the setup program to install Express Publisher. If 
you plan to install a lot of clip art, you may need considerably more 
space. You will need an additional 2 Mb to install all of the clip art. 

1. Start your computer. 

2. Put the disk labeled "Disk 1” in drive A. 

Note 
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DeskMate Users 3. If you have DeskMate, start it in the usual manner and press the 
F7 key. Follow the installation directions. If not, go to step 4. 

4. Make sure that the A> prompt appears on the screen. If it 
doesn't, type A and press ENTER. 

5. Type INSTALL and press ENTER. 

6. Follow the directions on the screen. 

The appendix, "Trouble shooting," contains information on possible 
problems with the install program and a list of the directories the install 
program creates. It also explains options for optimizing memory. 

If they are not already present, add the lines FILES = 20 and 
BUFFERS = 20 to your CONFIG.SYS file. Consult your DOS 
manual if you don't know how to do this. You will need to reboot 
after making this change. 

Setting up directories 

Express Publisher stores your data in one of four user-selectable 
subdirectories in your EXPRESS directory. The default directories 
(those that are automatically set when you run INSTALL the first 
time) are as follows: 

C:\EXPRESS\DOCS holds all documents and templates 
C:\EXPRESS\ART holds all clip art 
C:\EXPRESS\TEXT holds word processing and ASCII text 

C:\EXPRESS\FONT holds all fonts 

"Changing the default directories" in Chapter 3 explains these 
directories in more detail. 

To change one of the default directories, run INSTALL and type in 
a new directory. When you press the DOWN arrow key all of the 
remaining directories are automatically updated. 

Modifying an existing installation 

The install program copies itself onto your hard disk so that you 
can use it later to modify your configuration after installation. 

To run install from your hard disk, load DeskMate, press F2 Run 
and type install. You can install additional clip art and fonts. 
(See the appendix, "Trouble shooting" for more detail.) 
The main program directory cannot be changed after a first 
install. You can modify the directories for DOCS, ART, TEXT, 
and FONT. 

Users without DeskMate 

Note 

files for importing 
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Where to go from here 

Be sure to fill out and send in the postage-paid registration card. 
This helps establish your warranty commencement date and lets us 
keep you informed of program upgrades and enhancements. 

If you have used another desktop publishing program, you prob- 
ably won’t have any trouble learning Express Publisher for 
DeskMate. Express Publisher follows many conventions estab- 
lished by other programs. If you are new to desktop publishing, 
you should read the whole manual from start to finish. If you’re 
more advanced, read through the descriptions of the chapters 
below and decide what you need to read. 

The Express Publisher for DeskMate manual contains seven 
chapters. The information is presented in order from the most basic 
to the more specialized. There is a narrative from start to finish, but 
each chapter can also be read on its own if you feel you already 
understand what came before it. 

Chapter I ,  Beginning, explains everything you see on the screen- 
including how to use commands, dialog boxes, and tools-and 
introduces you to the concept of stories and text frames. 

Chapter 2, Tutorial, contains four lessons that convey a general sense 
of how Express Publisher works. The first two lessons provide a 
free-form introduction to working in Express Publisher. Lessons 
three and four lead you through the construction of a simple two- 
column newsletter using the program’s main features, and points 
out a few tricks and techniques along the way. 

Chapter 3, Fundamentals, explains how to create and save docu- 
ments, and how to resume work on existing documents. It also 
documents optional performance features. 

Chapter 4, Objects, details every function related to working with 
objects in Express Publisher: creating them, selecting them, and 
changing them. 

Chapter 5, Text, explains all of Express Publisher‘s text-related 
functions: importing text, typing text, editing, linking text frames, 
style sheets, and other text-related special features. 

Chapter 6, Printing, discusses all of Express Publisher‘s printing 
options and offers a few printer-specific recommendations. 

Using the manual 
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Chapter 7, Layout, offers general advice on page layout. It includes 
examples of how best to use Express Publisher to create a menu 
and a newsletter. 

The first appendix offers a review of basic DOS concepts. The next 
two appendices suggest ways you can use the templates and 
resolve problems. The other appendices display the clip art and 
fonts you can use with the Express Publisher package. 

This manual displays keys that you press in small caps, such as 
ENTER, F1, TAB, and ESC. UP is the up-arrow key. DOWN, RIGHT, and 
LEFT are the down-arrow, right-arrow, and left arrow keys. PGUP 
and PGDN are the page-up and page-down keys, respectively. 

Anything that you type is shown in Courier typeface, for example, 
Write project proposal. 

Italics are used to introduce new terms. 

Typographical 
conventions 

is our end of chapter symbol. 

Product support If you have a question about using the program that is not ad- 
dressed in this manual, the DeskMate product support staff is 
available for help in the usual manner. See your DeskMate manual 
for instructions on contacting technical support personnel. 
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Beginning 

This first chapter introduces you to the basics of working with 
Express Publisher for DeskMate. It explains how to start Express 
Publisher, what the words and pictures shown on the screen mean, 
how to choose commands, how to use the mouse, and how to move 
around in the file. It also explains how Express Publisher flows 
your text through the document so that when you edit portions of 
the text, the page layout you created is not disturbed. We highly 
recommend that you at least skim through this chapter to see if 
there is anything new to you. 

With Express Publisher for hkMate ,  you can create unique, 
flexible, and dynamic page layouts for newsletters, brochures, 
presentation graphics, and the like. Import text and graphics 
prepared in other programs, or LW? Express Publisher's text and 
graphic tools to enter text and create simple graphics and page 
designs. Once the information is in the file, you can resize the 
graphics, format and reformat the text, and direct the flow of text 
through your document as you desire. 

This chapter assumes that you have already installed Express 
Publisher using the install program. If you have not, follow the 
instructions for the install program found in the introduction. 

Here is a list of the sections in this chapter: 

Starting Express Publisher 
Understanding the Express Publisher screen 
Using the mouse 
Moving in the document window 
Using commands 
Using dialog boxes 
Using the toolbox 
Introducing stories and text frames 
Help 
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Starting Express Publisher 

Follow these steps to start Express Publisher: 

DeskMate Users 1. Turn on your computer and start DeskMate in the normal manner. 
2. If you are using the DeskMate version, move the cursor to the 

DeskMate Express Publisher application box and press the ENTER 
key. In addition, you can run Express Publisher using the File Menu 
F2 Run option by typing EPDM.PDM, or you can select the file from 
DeskMate’s Files View. 

Users Without 
DeskMate 

1. If you are using the Runtime version, move to the subdirectory 
containing the Express Publisher for DeskMate application files. 
The default directory is the EXPRESS subdirectory. Type EPDM 
and press the ENTER key. 

After loading, the Express Publisher screen appears. 

If you see the message, There is not enough free disk space 
to run Express Publisher, it means there is not enough free space 
on your hard disk to run Express Publisher. The program needs at least 
310 K of free hard disk space to make temporary working copies of 
your document while you are creating it. 

Note 

Understanding the Express Publisher 
screen 

You won’t have to decipher several screens full of information to 
learn your way around Express Publisher. Most of Express 
Publisher‘s features are available directly from the screen you see 
when you first start the program. 
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Express Publisher for DeskMate may look familiar to you even if 
you haven't read this part of the manual. It uses pulldown menus 
and tools to execute commands. The system that a program uses to 
communicate with users is called a human inte@ace. Many software 
developers have come to realize that a human (or user) interface 
combi ig  icons, pull-down menus, and dialog boxes is one of the 
easiest ways for human beings and software to exchange informa- 
tion. If you have used another program with a similar human 
interface you may only have to skim this chapter. 

Title bar: The Title bar displays the current date and time, 
program name, file name, and the help prompt. 
Menu bar: The menu bar lists the menu names. Each of these 
menus contains a list of commands that relate to a single topic, 
such as text. To find out how to use the menu bar to select a 
command, see "Using commands" later in this chapter. 
Menu options: Each of the commands on the various menus 
tells Express Publisher to do a different task, such as saving a 
file, or creating a new page. A shaded option on a menu means 
that the option is not available. Some options have accelerator 
keys next to them that can be used to perform commands 
without pulling down the menu. 
Toolbox: The toolbox contains a row of pictures, or tools, that 
represent various commands. Moving the pointer onto a tool 
and pressing the mouse button activates that tool. Many of 
Express Publisher's most basic functions can be executed by 
tools in the toolbox. For a complete list of the tools and what they 
do, see "Using the toolbox" later in this chapter. 
Rulers: The vertical and horizontal rulers help you measure 
objects in your document. The units of measure can be either in 
inches, centimeters, or picas. For more information about rulers, 
see "Setting Options" in Chapter 3. 
Current file name: The file name of the document you are 
currently working on appears in the Title bar. All new files are 
created as UNTITL+ED.EPD. 
Document window: The document you are currently working 
on appears in the document window. Whenever you start 
Express Publisher, the program automatically creates a one- 
column, one-page document. The lines you see within the 
document window in the picture above show the edges of the 
text column. To learn how to create a new document, work 
through the lessons in Chapter 2, 'Tutorial." 
Message line: The message line offers extra information you 
may need to make a decision while using Express Publisher. It 
describes the function of many commands and sometimes 
prompts you to take an action. 
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Pointer: The pointer moves as you move the mouse; it allows 
you to point to tools, menus, or to the place on the current page 
where you want to work next. The shape of the pointer changes 
depending on the tool you are using. 
Scroll bars: Use the Scroll bars to move up and down, or side to 
side in the document window. 
Elevator: The position of the elevator in the scroll bar indicates 
what part of the current page is visible in the document window. 
Current page number: The number of the page you are cur- 
rently viewing is always displayed in the lower right corner of 
the document window. 

Using the mouse 

You only need to learn a few basic procedures to use the mouse 
with Express Publisher. Moving the mouse moves the pointer on 
the screen. The shape of the pointer often changes to reflect the kind 
of work you are doing. The most common pointer shape is the 
arrow. 

Pointing: Pointing to an object is usually only the first step in 
performing one of the mouse routines described below. You 
point to an object by moving the pointer on top of it. If you are 
trying to indicate a very precise location, make sure that the 
pointer‘s hot spot is exactly where you want it to be. The hot spot 
is the precise point on the screen indicated by the active part of 
the pointer. With the arrow pointer, for example, the hot spot is 
always under the very tip of the arrow. Different pointers have 
different hot spots; you will become familiar with them as you 
work with Express Publisher. 

Clicking: Clicking means to press the mouse button and release 
it immediately while pointing to a specific location on the screen. 
Clicking initiates an action, such as selecting part of your document, 
or starting a command or displaying a different part of the screen. 
For example, to move the document window down you place the 
tip of the arrow pointer in the vertical scroll bar and click. 

Double-clicking: Double-clicking is pressing the mouse button 
twice in rapid succession. Beginners often don’t click fast 
enough. Press the mouse button twice in about the time it takes 
to say “express.” Double-clicking is usually used as a shortcut. 
For example, to open a file you can double-click it instead of 
selecting it and then clicking OK. 

Dragging: Dragging means to press the mouse button and hold 
it down while moving the mouse. Drag the mouse to define an 
area, select a menu command, or move an object. 
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Pointer shapes 

The arrow pointer 
rh 

The I-beam pointer 

I 
The four-headed pointer 

8 
The busy icon 

Scroll bars 

As you use different tools, the shape of the pointer changes to help 
you remember what you are doing. Here are the different pointer 
shapes. 

The most common pointer shape is the arrow. It allows you to 
select objects for layout. The pointer always changes to the arrow 
whenever you move the pointer off the document window to scroll, 
select a tool, or pull down a menu. 

The pointer looks like an I-beam when you are working with text. 

While moving objects the pointer changes to a four-headed arrow. 

The Tandy busy icon informs you that you must wait while Express 
Publisher carries out your latest request. 

You cannot do anything with the busy icon. 

There are other pointer shapes associated with more specific 
functions. They are explained later along with the function. 

Moving in the document window 

When you create a document with Express Publisher, the page you 
see on the screen is the same as the page that will be printed. 
However, most computer screens can only show one part of the 
page at a time. Scrolling and paging allow you to see different parts 
of the document. 

The scroll bars at the right side and bottom of the document 
window allow you to see diierent parts of the current page. Use 
the verticd scroll bar to move the document window up and down 
on the current page and the horizontal one to move from side to 
side. 

Each scroll bar has an arrow at each end and contains a small 
square box called an elevator or thumb. The position of the elevator 
in the scroll bar represents your location in the document. 

Click the mouse within the elevator area of the scroll bar to move 
your view of the document in the chosen direction by one full 
screen. 

To move in smaller steps, click the arrow that points in the 
direction you wish to go. 
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Drag the elevator to move to a certain location more quickly, 
such as the top or bottom of the page. 

Page up/down Use PAGE UP and PAGE DOWN to move the document window up 
or down the page by one full screen. 

Using commands 

All Express Publisher commands are available directly from the 
main screen on pull-down menus. The row of words across the top 
of the screen is called the menu bar. Each of the words represents a 
pull-down menu. These pull down menus are similar to the pull- 
down maps and diagrams used in classrooms. They stay out of the 
work area while you’re not using them. 

You can pull down menus and select commands using either the 
mouse or the keyboard. Each menu has its own accelerator or 
keystroke shortcut displayed next to the menu names on the menu 
bar. You can also use the ALT key with the first letter of each menu 
to open any of the pull-down menus except the Options menu, 
which can only be accessed with the F7 key or the mouse. However, 
because you can move through the menus with the left and right 
arrow keys, you could open another menu with a function key or 
an alt key combination and move to the Options menu with the 
arrow keys. 

These steps tell you how to select a command using a mouse: 

1. Point to one of the menu buttons on the menu bar and click the 

With the mouse 

mouse button. 

The menu drops down from the menu bar. The menu stays open 
until you pull down another menu, press the ESCAPE key, or 
click somewhere in the document window. 

2. Double-click the command you want to use or select it and press 
ENTER. 

The command is activated. 
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Note You can also use the mouse to ''Drag and Release." When you have 
activated a menu, continue to hold the mouse button down, move to 
the specific command you want to use, and release the mouse button. 

With the keyboard Many commands can be invoked without opening menus by using 
accelerators that are either CTRL key or mm key combinations. 
These accelerators are listed within the menus next to the com- 
mands. You can activate almost any command in just a few 
keystrokes. For example, to use the Cut command on the Edit 
menu, you need only press SHIFT-DEL. Follow these steps to select a 
command using the keyboard: 

1. Press the appropriate function key or ALT and the applicable 
letter to activate the menu while you are working in the docu- 
ment window. 

The menu drops down from the menu bar. 

2. Use the UP and DOWN arrow to select one of the commands on 
the menu, and press ENTER. Or, press the first letter of the 
command you want to use. If more than one command has the 
same letter, type the letter a second time to move to the second 
command. 

Pressing either the LEW or RIGHT arrow closes the current menu 
and pulls down the next menu to the left or right. 

Closing a menu To close a pull-down menu, move the pointer into the document 
window and click the mouse button, or press ESCAPE. 

Function keys The menus and the help files can be reached via the function keys. 
They are listed below. 

FI Help 
F2 File menu 
F3 Edit menu 
F4 Textmenu 
F5 Pagemenu 
F6 Objectmenu 
n Options menu 
F9 Menu 
FIO DeskMate accessories 
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Accelerators Some of the commands on the menus have accelerators, or key- 
stroke shortcuts. These accelerators are listed next to the command 
name on the menu. 

CTRL+O Open 
CTRL+S Save 
ESC Exit 
SHIFT+DEL cut 

SHIFT+INS Paste 
CTRL+D Duplicate 
CTRL+K Show Clipboard 
CTRL+C Clear Clipboard 
CTRL+P Previous 
CTRL+N Next 
CTRL+G Go to 

CTRL+INS Copy 

Using dialog boxes 

When Express Publisher needs more information to carry out a 
certain command, it presents a dialog box. All commands that 
invoke a dialog box are followed by an ellipsis (...) on the menu. The 
dialog box usually displays the name of the command that invoked 
it and lists the options available for that command. 

The basic method for using a dialog box is always the same. 

1. Use a command that invokes a dialog box. 

2. Follow one of the methods outlined below to set the options 

The options in many dialog boxes are preset to their default setting, 
that is, the one most commonly used. If an option is already set the 
way you want it, you don't have to change it. 

3. Click the button that executes the command (usually labeled OK). 

You can always click Cancel or press ESCAPE to cancel a command 
from a dialog box. 

There are several ways to select options from dialog boxes. 

Check boxes Check boxes let you turn off or on one or more options 
that modify the command you are using. An X in the box indicates that 
the option is on; an empty box means that the option is off. You can use 
either the mouse or the arrow or tab keys to move through and 
highlight options. The space bar toggles between on and off. 

Some menu items may be 
dimmed if unavailable. 

according to your needs. 

Note 
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Dialog boxes 

Radio button groups: Radio button groups present a series of 
options that are mutually exclusive. Radio buttons are similar to the 
row of buttons on car radios that only allow one button to be 
pressed at a time. An option is selected when the button appears in 
the down position. Selecting one of the options in a radio button 
group turns off any other that was selected earlier. You can click on 
an option or enter a group of option buttons with the TAB key. Use 
the arrow keys to move to the appropriate one and press the space 
bar to turn one on. 

Radio button group 
U WLll r l l s  

Edit field 
rrrnt hwc: r n r l  o pm. r q e :  a J pnUc: a 

Edit fields: Edit fields are areas where you can enter information to 
tell Express Publisher for DeskMate what you want it to work on. 
This could be the name of a new file you are saving, a range of 
pages to be printed, or a measurement. 

An edit field may appear with default information already in it. To 
accept the information, click OK. To change it, click the edit field to 
select all the text within it, and type in your own replacing the old. 
To mod* the existing text, click anywhere in the edit field and 
begin typing. The following keystrokes are helpful: 

BACKSPACE deletes the character to the left of the amor. 
DELETE deletes the character at the right of the cursor. 
LEFT and RIGHT arrows move the cursor. 
END moves the cursor to the end of the text in the box. 
HOME moves the cursor to the beginning of the text in the box. 
TAB moves the cursor to the next field in the dialog box. 

List boxes: List boxes list options by name, such as file names or, 
font typefaces. Since many lists do not fit entirely within the list 
box, there are arrows on the list boxes that let you scroll through 
lists. Click an item in a list box to select it. Pressing a letter on the 
keyboard while in a list box immediately selects the first item on the 
list be@ming with that letter. 

B e g i n n i n g  9 



Icons: Icons appear when visual information is helpful in making a 
choice between options. Each icon is a picture that represents an 
option relating to the command you are using. Clicking one of the 
icons selects the option. 

Dialog boxes 

Edit field 

Radio buttons 

Icons 

List box 

Check boxes 

Dialog box control 
keys 

In addition to all the mouse functions mentioned above, most 
dialog boxes can be controlled from the keyboard without using the 
mouse. 

TAB moves the cursor forward between list boxes and from 
option to option. SHIFT-TAB moves the cursor in the opposite 
direction. 
LEFT and RIGHT arrows moves the cursor in an option box, or 
moves to another icon. 
PAGE UP and PAGE DOWN move the cursor up or down the 
length of a list box. 
UP and DOWN arrows change the selected item in a list box or 
moves left/right in a dialog box. 
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File utility dialog 
boxes 

The Import Text dialog box 

Note 

SPACE BAR is used to toggle the state of a highlighted check box 
or select an option in radio button groups. 
ENTER is the equivalent of pressing a button that is highlighted. 
ESCAPE cancels the command and closes the dialog box without 
making any changes. This is the equivalent of clicking the 
CANCEL button. 

This type of dialog box appears when you open or save files. A text 
field is provided for entering a file name or wiId card search 
characters. An alphabetical list of the files in the current directory is 
displayed in a Files list box that you can scroll through with the 
arrow buttons. Additionally, the list box contains available drives, 
directories, and the two dots ".." if you are in a subdirectory. You 
can change to the parent directory by double-clicking on the two 
dots. Double-clicking on a file is the same as selecting the file and 
pressing ENTER. 

You shouldn't have to change drives or directories very often while 
using the program. Express Publisher automatically changes to the 
\EXPRESS\DOCS directory every time you save or open a docu- 
ment; it changes to the \EXPRESS\ART directory when you import 
a picture. Directories, drives and the parent directory in the Files list 
box are surrounded by brackets [like this]. 

Wild card characters 

You can enter wild card search characters in the Extension text box to 
change the list of files shown in the Files list box. Express Publisher 
recop2mthesamewildcardcharactersasDOS,socheckyourDOS 
manual if you're not sure how to use them If you don't understand wild 
card characters at all, don't worry about them They can help out in some 
cases but they are not quired to use any Express Publisher functions. 

These are the wild card characters recognized by Express Publisher: 

? Stands for any single Character in the exad same position. 

* Stands for any number of characters in that position. 
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Using the toolbox 

The Express Publisher toolbox appears directly beneath the menu 
bar. It contains tools that help you perform the most common 
desktop publishing tasks. This section identifies all the tools in the 
toolbox and tells you how to activate a tool. Each of the tools is fully 
explained later, in the section covering the tasks that it performs. 

To activate any tool, move the pointer onto the desired tool and 
click the mouse. After you use the tool, it will revert to the arrow 
pointer. Double-clicking on some icons, however, will allow you 
to use that tool until you choose another icon. 

If you activate a tool by accident, or decide not to use it after 
selecting it, you need to deactivate it before doing anything else. 

The Arrow tool Click the Arrow tool to deactivate the current tool and activate 
the arrow pointer. 

The toolbox The following tools are available in the toolbox: 

Arrow Text Text Frame 

Box Rounded Box Ellipse 

Line Set Line Set Fill 

Link Unlink Align 

Equate Text Wrap 
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Arrow activates the arrow pointer described in ‘‘Using the 

Text allows you to start typing text in a text frame. 

Text Frame allows you to draw a box and immediately start 

Box allows you to draw a rectangular object. 

Rounded Box allows you to draw a rectangular object with 

Ellipse allows you to draw ellipses and circular objects. 

Line allows you to draw vertical, horizontal, and diagonal lines. 

Set Line allows you to set the line type and width for boxes and lines. 

Set Fill allows you to fill an object you have drawn with a shade 

mouse” in this chapter. 

typing text in it. 

rounded corners. 

or pattern. 

Link connects, or links, stories on different parts of a page or on 

Unlink disconnects, or unlinks, frames so that text no longer 

Align allows you to line up two objects. 

Equate allows you to make two objects or lines the same size. 

Text Wrap wraps text around one side of a picture. 

different pages so that text can flow between them. 

flows between them. 

Introducing stories and text frames 

Express Publisher groups and stores text in a way that allows it to 
flow smoothly through your file. The formatting levels are 

Document 

Textframe 

These levels work together to produce the final page. Although this 
concept is described in more detail throughout the manual, the 
following description provides an overview. 

story 
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When you type or import text into Express Publisher, all of the text 
you enter is one story. You can have up to 64 separate stories in one 
Express Publisher document. A document can be from 1 to 32 pages 
long. Stories can be up to 64 K or about 30 pages. Whether you type 
text directly into Express Publisher or import it from a word 
processor, Express Publisher enters the text in frames. A text frame 
is simply a window through which you can view your text. A 
document consists of all the frames and stories in your file. 

See “About stories and text frames” in Chapter 5 for additional 
information, including how to apply commands to the various 
formatting levels. 

Help 

Almost all of the crucial information in this manual is available in 
the on-line Help Index. This help is organized by topic. 

1. Press F1 for help. 

The Help Index list box appears. Use the scroll bar to get to the 
desired topic, or press the first letter of the topic that you want 
and that item is selected. 

2. Double-click or press the ENTER key on the topic on which you 
want help in the list box. 

3. Click Cancel when you’re done. 
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2 

Tu to ria I 

This chapter leads you through a few simple lessons that illustrate 
most of Express Publisher's important features. You should make 
sure that you understand what was covered in Chapter 1, "Begin- 
ning," before you try to follow the tutorial. 

The tutorial contains four lessons. You can do them all at once or 
one at a time. The first two lessons offer a free-form introduction to 
the program. They provide examples of the major concepts that you 
need to understand in order to work with Express Publisher for 
DeskMate. The third and fourth lessons guide you through the 
construction of a simple document. 

The lessons in this tutorial are as follows: 

Getting started 
Lesson 1: Understanding objects 
Lesson 2: Entering text 
Lesson 3: Creating a newsletter 
Lesson 4: More advanced functions 

Getting started 

1. Turn on your computer and, if you use DeskMate, start 
DeskMate as you usually do. 

2. Move the cursor to the Express Publisher for DeskMate applica- 
tion list box and press the ENTER key. 

3. If you are using the Runtime version, move to the appropriate 
Express Publisher program subdirectory, type EPDM, and press 
the ENTER key. 

When you first start Express Publisher for DeskMate, you see the 
menu bar and toolbox across the top of the screen. Express Pub- 
lisher creates a one-page, one-column document. Notice that the file 
name UNTITLED.EPD appears above the menu bar. 
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Creating a new 
document 

To learn about Express Publisher from the ground up, it's best to 
start with a completely empty document. To get started, put away 
the one-column document and use the New command to create a 
blank, one-page document. 

1. Click the File menu, and then double-click the New command. 

The New Document dialog box appears. 
The New Document 

dialog box 

2. Click the Blank icon (it looks like an empty page). 

3. Click OK. 

Express Publisher creates a blank, one-page document. 

Lesson I: Understanding objects 

In Express Publisher for DeskMate, an object is any shape that you 
can place on a page and then change with a command or move 
with the arrow tool. Objects may be boxes, ovals, lines, or pictures. 
In this lesson you will learn how to create, import, and handle 
objects. Later, you will learn how to use them as elements in 
constructing a document. 

The simplest way to create objects is to draw them with the draw- 
ing tools. In the first exercise, you'll use the Box tool to draw a box. 

1. Click the Box tool. 

Objects 

The Box tool 

The shape of the pointer changes to a pencil. This is to remind 
you that you are drawing. While you are using the Box tool, or 
any of the drawing tools, tick marks appear on the rulers to 
show you the exact position of the pointer. 

2. Move the pointer somewhere inside the document window. 

3. Press and hold down the mouse button. 
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This marks the box's anchor point. 

Drawing an object anchor point 

I c ...................... 2' 
end point 

4. Without letting go of the mouse button, move the mouse down 
and to the right as shown above. 

5. When the box is the right size and shape, release the mouse 
button. This position is d e d  the end point. Notice that the pointer 
reverts to its original shape. If you had doubleclicked the icon, the 
tool would remain in effect until you chose another tool. 

All the drawing tools work the same way. After you click a draw- 
ing tool, the position where you click the mouse marks the object's 
anchor point. You then drag the mouse and release it to mark the 
end point. Express Publisher draws the object between the two 
points that you defined. Little black squares appear around an 
object right after you draw it; they will be explained shortly. 

The drawing tools TO get a better understanding of how the drawing tools work, try 
drawing an object using each of the drawing tools. Don't worry 
about making a mess, this is a learning experience. 

Selecting and So far you have only created objects. If you could only create objects 
Deselecting Objects and not change them afterwards, your work would be very diffi- 

cult. Express Publisher lets you move and change objects in many 
different ways. 

In order to do anything to an object you have to select it. Selecting 
an object tells Express Publisher that you want to change it with 
your next action. 

When an object is selected, little squares called handles appear 
around it, and the lines around it become heavier. You may have 
noticed this with the practice objects you have just drawn, because 
right after you draw an object, it is selected for you automatically. 
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The squares are called handles because they are used to manipulate 
the object. 

Deselecting is almost as important as selecting. If you inadvertently 
leave an object selected, your next action may affect the selected 
object instead of doing what you actually want. 

Follow these steps to learn how to select and deselect objects: 

1. Move the pointer over one of the objects that you drew earlier 
and click the mouse button. 

A selected object 

Handles appear around the object that you selected, and the 
lines around it get thicker. Now try to select another object. 

button. 
2. Move the pointer over another object and click the mouse 

Another selected object 

Notice that the handles around the object you selected earlier 
disappear, and new handles appear around the object that you 
just selected. When you select an object, any object that was 
previously selected is deselected. 

3. Move the pointer so that it is not over any object and click the 
mouse button. 

This deselects any selected object without selecting a new one. 
You can tell that no objects are selected because none of them 
have handles around them. 
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Changing objects You should understand how to create and select objects by now. 
@ce you understand these concepts you shouldn't have any 
trouble moving objects or changing their appearance. Express 
Publisher can change objects in many ways, but these functions are 
the most basic: moving, resizing, reshaping, filling, and deleting. 

Moving an object 

All Express Publisher objects can be moved around the document, 
either with the mouse or with a command. Start by using the 
mouse to move one of the objects you've been working with. 

1. Move the pointer over the center of one of the objects that you 
drew earlier. 

2. Press and hold down the mouse button. 

Moving a box 

r--- ------ r-1 t 
I 
I 
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The pointer should change to a four-headed arrow as soon as 
you move the mouse. If it doesn't, make sure that you are 
holding down the mouse button and that the pointer is over the 
object. Also, be sure to place the pointer in the center of the object 
and not over one of the handles when you press the mouse 
button. 

3. Without releasing the mouse button, move the mouse in any 
direction. 

This is called dragging. The object's outline moves with you as 
you move the mouse. 

4. When the object is where you want it, release the mouse button. 

Express Publisher redraws the object in its new location. Try 
moving several objects around to get a feel for how this works. 
Notice that while you are moving an object, tick marks on the ruler 
show you the position of the object's edges. This is very useful for 
placing an object in a precise location. 
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Moving lines 

You can drag a line the same way you drag any other object, you 
don't have to drag the center handle 

Moving a line 

Cutting and pasting Another way to move an object is to use the Cut and Paste commands. 
objects 

1. Select one of the objects on the screen. 

2. Pull down the Edit menu and choose Cut. 

The object disappears. 

3. Scroll to another part of the page. 

4. Pull down the Edit menu and choose Paste. 

The object is pasted in the center of the document window. 

Changing objects Not only can you move an object to a new location, you can change 
its size and shape. 

1. Select an object. 

2. Move the pointer so that the very tip of the arrow is on the lower 
right handle. 

3. Hold down the mouse button and drag the handle up and to the 
right as shown below. 

Stretching a box 

The outline of the object should move to indicate its changing 
size and shape. If the pointer changes to a four-headed arrow 
and the whole box moves without changing size, then you did 
not have the tip of the arrow exactly over the handle when you 
pressed the mouse button. Let go of the mouse button and try 
again. 
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4. When the object is the right size and shape, let go of the mouse 
button. 

Express Publisher redraws the object in the new dimensions. Try 
dragging different handles to change the size and shape of various 
objects in different ways. The handles in the middle of an object's 
sides let you change only one dimension at a time. The comer 
handles let you change both dimensions at once. 

Using fills 

You can fill a box with shading or patterns. When an object is filled, 
it becomes opaque. This means that you can't see the parts of your 
document that are covered by filled objects. 

Try changing one of the objects you created earlier so that it is filled. 

1. Select an object that you created earlier. 

The Set Fill tool 2. Click the Set Fill tool. 

The Set Fill Pattern dialog box appears. 

The Set Fill Pattern dialog 
box 

3. Click one of the fill types and then click OK. 

The dialog box disappears and the object displays the fill type 
you just chose. (If you chose white, you may not notice the 
change unless the object was covering some other objects.) 
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If you want to remove the fill pattern, click the Set Fill tool again, 
click once in the white box and click OK. The fill setting changes 
back to opaque. If you want to make the object transparent, click on 
the filled option to turn it off. This makes the object clear. 

Deleting objects 

After experimenting with what you’ve learned so far, you may find 
that your document is becoming cluttered with objects. You may 
want to delete some objects to clear up some space. 

1. Select an object. 

2. Press the DELETE key on your keyboard. 

Express Publisher stacks all objects in the order in which they are 
created. The first object you draw is at the bottom of the stack, and 
the last is on the top. Moving an object has no effect on its position 
in the stack. The last object you draw stays in the front until you 
draw a new object. If you draw an object and then move another 
object to the same location, the older object will be placed behind 
the object that you just drew. 

While creating documents, you may need to change the stacking 
order of objects. This is especially true if you use background 
images. The Bring to Front and Send to Back commands allow you 
to change the stacking order. 

1. Draw a box and choose a fill pattern. 

2. Draw another box overlapping the first box and fill it with 

Bring to Front/ 
Send to Back 

another pattern, as shown in the following picture. 
Overlapping objects 

The second box covers the first box because it was drawn later. 

3. Draw a larger box that completely covers the others and select a 
different fill pattern. 

The box you drew last is at the top of the stack, so it covers the 
earlier objects. Now use the Send to Back command to send the 
last box to bottom of the stack. 
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4. Select the larger box, pull down the Object menu and choose 
Send to Back. 

The larger box is sent to the bottom of the stack and the other 
two objects now cover it. 

Overlapping objects ................................ ................................ ................................ ................................ 

5. With the larger box still selected, pull down the Object menu and 
select Bring to Front. 

The larger box is returned to the front of the stack. 

Importing pictures Express Publisher can import pictures from several graphics 
programs. Once a picture has been imported, Express Publisher 
treats it as an ordinary object. You can select, move, and size 
pictures in the same way as other objects. When you change a 
picture with Express Publisher, it does not change the original 
picture on disk. Express Publisher only changes the picture within 
the document you are working on. 

1. Pull down the File menu and select Import Picture. 

The Import Picture dialog box appears. It displays an alphabeti- 
cal list of all of the files in the \EXPRESS\ART directory. The 
ART directory contains all of the clip art that you chose to install 
with the setup program. The files that show up on your screen 
may not match those shown in the picture below. 

The Import Picture dialog 

z :\ExpRESN1Rr 
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2. If you don't see the file FLAPPER.TIF in the Files list box, click 

3. Double-click the file FLAPPER.TIF 

the DOWN arrow to scroll through the list (see the picture above). 

While Express Publisher is importing the picture, it displays the 
wait icon. When it is finished importing the picture, Express 
Publisher displays it in the middle of the document window. 
Handles appear around the picture to indicate that it is selected. 

FLAPPER .TIF 

Moving a picture 

You can move a picture in the same way as any other object. 

1. Move the pointer over the picture. 

2. Press and hold down the mouse button. 

3. Without releasing the mouse button, move the pointer. 

The picture's outline moves as you move the mouse. 

button. 
4. When the picture is in the desired location, release the mouse 

Scaling a picture 

You can size a picture by dragging its handles, just like you did 
with other objects, but you will find that pictures become distorted 
unless you scale them proportionately. The Scale command 
preserves the original proportions of an object while reducing or 
enlarging it. You can use the Scale command to scale any object, but 
it is most useful for imported pictures. 
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1. Select the picture that you imported earlier. 

2. Click the Object menu to pull it down and double-click the Scale 
command. 

The Scale Object dialog box appears. 

The Scale Object dialog box 

3. Select the contents of the Scaling Factor text field and type 50. 

Express Publisher reduces the picture to 50% of its original size, 
maintaining its original proportions. 

Summary of lesson 1 You have already learned some of the basic concepts in Express 
Publisher. 

An object is a shape that you can move or change. Documents 
are made up of objects. 
To change an object you must first select it by clicking on it with 
the mouse. 

4 Once you have selected an object, you can move it, delete it, or 
cut and paste it. 
You can change a box's size and shape, and speufy a new fill type. 
All objects are stacked in the order in which they were created. 
You can change the stacking order with the Bring to Front and 
Send to Back tools. 
Express Publisher can import pictures from the included clip art and 
some other graphics programs. You can select, move, and size 
pictures in the same way as other objects. The Scale command sizes 
pictures proportionally. 

How to continue You have now completed lesson 1. You may now leave Express 
Publisher or clear the screen and go directly on to lesson 2. 

Exiting 

1. Click the FiIe menu. 

2. Double-click Exit. 

3. You don't need to save this practice document, so when the 
warning prompt appears, click No and you will leave Express 
Publisher. 
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Continuing 

1. Click the File menu. 

2. Double-click Close. 

3. You don’t need to save this practice document, so when the 
warning prompt appears, click No. 

Express Publisher removes your practice document and provides 
you with a new document for lesson 2. 

Lesson 2: Entering text 

This lesson focuses on entering and editing text in an Express 
Publisher document. You can type text directly in the document or 
import text created by most of the popular word processors. 

Feel free to experiment with entering text. If you are familiar with 
another desktop publishing program or word processor, you may 
find that Express Publisher works in many of the same ways. 

To enter text in Express Publisher, you must first use the Text Frame 
tool to create a box that you can type or import text into. The box with 
text in it becomes a special kind of object called a text frame. You can 
apply most of the commands you learned in Lesson 1 to the text frame; 
you can also use the Text tool to edit the text itself. 

This exercise shows you how to create a text frame. 

1. Draw a box at least 3” by 2” using the Text Frame tool. 

Text frames 

The Text Frame tool The shape of the pointer changes to an I-beam and a blinking line 
appears in the upper left corner of the box. This line is called a text 
insertion point or simply a cursor. The cursor marks the position 
where text will go when you start typing. 

2. Type Had I known who awaited m e  I never would 
have answered the door on tha t  April  morning. 

Text frame 
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When you reach the end of the line in the text frame, keep on 
typing; Express Publisher automatically starts a new line. This word 
wrap feature, common to many word processors, means that you 
don't have to press ENTER at the end of every line. You should press 
ENTER only at the end of paragraphs. 

The I-beam pointer allows you to type and select text. You cannot 
select or move objects with the I-beam, and you cannot select text 
with the arrow pointer. If you are working with a regular box, you 
can convert it to a text frame by clicking the Text tool, moving the I- 
beam pointer inside the box, and clicking the mouse button. 

As you enter text, the cursor moves to the right of each new 
character. You can move the cursor using either the arrow keys or 
the mouse. You cannot move the cursor outside of a text frame or 
beyond the end of existing text. 

Moving the cursor with the arrow keys 

Pressing an arrow key on the keyboard moves the cursor in the 
direction of the arrow. If you hold down an arrow key, the cursor 
moves continuously in that direction. 

Try adding a new word to the sentence that you just typed. 

1. Use the arrow keys to move the cursor between the words 

2. Erase the word "April" by pressing BACKSPACE. 

Note 

Moving the cursor 

"April" and "morning." 

The BACKSPACE key deletes the character to the left of the cursor. 
Notice that the other characters to the right are pulled back as 
you delete characters. 

3. Now type December to replace April. 

As you type the new characters, the existing characters move to 
the right. 

Moving the cursor with the mouse 

For moving longer distances, it is much faster to use the mouse to 
move the cursor. Just move the I-beam pointer to where you want 
to place the cursor, and click the mouse button. The cursor then- 
moves to the place where you clicked. You can only place the 
cursor within the text that is already in the frame. You can't place 
the cursor in an area that does not already contain text. 

1. Move the mouse so that the I-beam pointer is between the words 
"who" and "awaited" and click the mouse. 
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2. Backspace over the word ”who” and type what. 

Quick keys 

Here are a few keystroke shortcuts for moving the cursor: 

The HOME and END keys move the cursor to the beginning or 

The key combinations CTRL plus PGUP or CTRL plus PGDN moves 
end of the current line, respectively. 

the cursor to the beginning or end of the text in the current 
frame, respectively. 

Selecting text and 
changing fonts 

Just as when you are working with objects, you must select text in 
order to change it. Once you have selected some text, you can 
delete it or change its font. In this exercise you will select all of the 
text that you’ve entered so far and then change the font. 

Selecting text involves the same technique that you use when 
drawing objects: you establish an anchor point and an end point. 

1. Use the mouse to move the I-beam pointer just to the left of the 

2. Press the mouse button, and without releasing it, move the 

first character in the sentence. 

mouse down and to the right. 

As you move the mouse, the selected text is highlighted. If the 
first few characters are not highlighted, release the mouse button 
and try again, moving the mouse more slowly. 

3. When all the text is highlighted, release the mouse button. 

Selected text 

Any change you make at this point affects all of the selected text. 

4. Pull down the Text menu and select the Choose Font command. 

The Choose Font dialog box appears, listing all of the available 
fonts. (The fonts available on your system may not match those 
shown in the following picture.) 

28 E x p r e s s  P u b l i s h e r  f o r  D e s k M a t e  



The Choose Font dialog box 

5. Click Dixon in the Typeface list box, select 12 in the Size list box, 
and click OK. 

All of the selected text changes to the Dixon font. 

Deselecting text 

To deselect text, move the mouse to another part of the document 
window and click. If you move the pointer over some other text, the 
cursor moves to where you clicked the mouse. 

Now that you know how to select and deselect text, try selecting 
different parts of the text you’ve entered so far. Notice that you can 
drag the mouse in any direction to select text. As you drag the 
pointer, all of the text between the anchor point and the current 
location of the pointer is highlighted. As this lesson continues, 
you’ll learn some other ways to select text. 

In addition to changing the font, you can make text italic, bold, and 
underlined. These are called font attributes. 

To apply a font attribute, you need only select the text that you 
want to change, and choose an attribute. Start by practicing a 
shortcut for selecting whole words. 

1. Move the I-beam pointer and click anywhere on the word 

2. Double-click the mouse button. 

Changing font 
attributes 

“never.“ 

This should select the whole word. If it didn’t, you may not have 
clicked fast enough. Press the mouse twice in the time it takes to 
say ”express.” Also make sure that you don’t move the mouse as 
you double-click. 
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3. Select the Choose Font command from the Text menu. 

The Choose Font dialog box appears. 

then click OK. 

The word "never" is italicized and the rest of the text is un- 
changed. When changing selected text, the change you make 
affects all of the selected text, and only the selected text. 

The Cut and Paste commands are very useful for moving text 
around. The Cut command removes the selected text from your 
document and places it in a temporary storage area called the 
clipboard. The Paste command places a copy of the text on the 
clipboard back in the document at the cursor position. 

1. Select the text Wad I known what awaited me." 

2. Pull down the Edit menu and choose Cut. 

4. Click the Italic check box on the right side of the dialog box, and 

Cutting and pasting 
text 

Express Publisher removes the selected text from the text frame 
and puts it on the clipboard. If you want to make sure that it is 
on the clipboard, pull down the Edit menu again and choose 
Show Clipboard. Click OK when you are done looking at the 
clipboard. 

Now paste the text in a different location. 

3. Using either the mouse or the arrow keys, move the cursor to the 
very end of the existing sentence, between the word "morning" 
and the period. 

4. Pull down the Edit menu and choose Paste. 

The text that you cut earlier is inserted at the cursor position. 
You will have to adjust the spacing and capitalization to make 
the sentence correct. You should end up with, "I never would 
have answered the door that December morning had I known 
what awaited me.” 

While you are using the Text tool to work with text you can't move 
or select objects with the pointer; you can only work with text. 

Click the Arrow tool to put away the Text tool, or move the 

Putting away the 
text tool 

I-beam pointer outside of any box and click the mouse. 

The Arrow tool This changes the pointer back to the arrow, so that you may 
again select and move objects. Anytime you have selected a tool 
and you want to change the pointer back to the arrow, click the 
Arrow tool. 
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C h a n gin g a text 
frame 

Once you are working with the arrow pointer, you may select, 
move, and resize a text frame as if it were an ordinary object. 

1. If the text frame you’ve been working with is not already 
selected, move the arrow pointer inside the text frame and click 
the mouse button. 

2. Move the pointer inside the box, press and hold down the mouse 
button as you drag it any direction, and then release the mouse 
button. 

The text frame’s outline moves as you move the mouse. When 
you release the mouse button, Express Publisher redraws the 
text frame in its new location. 

3. Drag one of the text frame’s corner handles to change the size 
and shape of the box. 

Resizing a text frame 

Express Publisher reformats the text to fit in the resized box. 
Resized text frame 

4. Resize the text frame so that it is too small to hold all of the text 
you entered. 

The More Text marker Although some text disappears from the document, it has not 
been permanently lost. Express Publisher puts the More Text 
marker (shown at left) in the lower right corner of the text frame to 
tell you that there is more text than will fit in the text frame. If you 
stretch the box back to its original size, the text reappears. 
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Summary of lesson 2 Lesson 2 covered the most basic elements of text entry. 

Express Publisher handles all text within boxes called text 
frames, which you create with the Text Frame tool. 
You can also create a text frame by drawing a box, clicking on 
the Text tool, and then clicking inside the box with the I-beam 
pointer. 

shortcuts such as HOME or END to move the cursor within a text 
frame. 
While you are working with text, the pointer is shaped like an I- 
beam. You cannot select or move objects while working with 
text. If you click the Arrow tool, the pointer changes back to the 
arrow and you may again select and move objects. 
To change text after it has been entered, you must select it with 
the I-beam pointer. Selecting text involves using the same 
technique of dragging the pointer from an anchor point to an 
end point that you use when drawing objects. 

change its font, or change its style. Any change you make affects 
all the selected text, and only the selected text. 

boxes. If you change the size or shape of a box, Express Publisher 
reformats the text to fill it. 

Use either the mouse, the arrow keys, or one of the keyboard 

Once you have selected text, you can cut it to the clipboard, 

You can select, move, and resize text frames just like ordinary 

How to continue You have now completed lesson 2. You may now leave Express 
Publisher or go directly on to lesson 3. 

Exiting 

1. Click the File menu. 

2. Double-click Exit. 

3. You don't need to save this practice document, so when the 
warning prompt appears, click No. You return to the DeskMate 
or the DOS prompt if you are using the Runtime version. 

Continuing 

Go on to Lesson 3. 

Lesson 3: Creating a newsletter 

You now know enough about Express Publisher's basic features to 
create a simple document. This lesson leads you through the 
creation of a simple newsletter called "Club Talk." Along the way it 
tells you how to display an entire page of your newsletter on 
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screen, import text from a word processor, apply a preset style, 
zoom out to make layout change, add a text frame, align objects to 
each other, import a new story, add a second page to your newslet- 
ter, and link text frames. 

Completed newsletter in 
Show Page view 

Note Express Publisher looks different when run on different types of 
graphics display adapters, however it will print correctly. Don’t be 
concerned if your document doesn’t look exactly like the screen 
shots in the next two lessons. 

Creating a new The New command lets you define the number of columns, the 
document number of pages, and the page size for a new Express Publisher 

document. 

1. Pull down the File menu and select New. 

The New Document dialog box appears. 

The New Document dialog 
box 

2. Click the 2-Column icon, enter 1 in the Pages text field, and make 
sure Letter (8.5” by 11”) is selected as the page size. Click OK 
when all the options have been set. 

3. A graphic appears if you select 2 or 3 column explaining how 
text flows. 
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Express Publisher creates a blank page according to your specifica- 
tions. The frames on the page match the number of columns that 
you specified. Text will flow automatically from the left bottom 
column to the right unless you choose to change it. 

4. Click the Text tool icon and position the cursor in the wide 
horizontal text block at the top of the page (the header). 

5. Type Club Talk. 

6. Place the cursor in text box immediately before the text you have 

7. Click the Text menu and double-click the Choose Style command. 

8. Select Center from the style list box and click OK. 

9. Select all of the text. 

10. Click the Text menu and double-click the Choose Font command. 

11. Set the dialog box variables to Dixon, 70 pt, and both bold and 

just typed. 

italic. Click OK. 

You have just created a headline for the newsletter 

Until now, you have only entered text yourself. It is much faster to 
use an external word processor to write a long story, and then 
import it into Express Publisher using the Import Text command. 
The text for your newsletter is in a file called NEWSLTTR.WPS. 
This file was created by one of the word processors that Express 
Publisher supports. 

1. The column on the lower left side of the document window 

Importing a story 

should be selected. 

Make sure that the column is selected before going on to the next 
step; otherwise the text you import won’t be put in the right 
place. The selected frame should have heavy lines and handles 
around it as shown in the following picture. 

Selected text frame 
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2. Pull down the File menu and choose Import Text. 

The Import Text dialog box appears. 
The Import Text dialog box 

3. The file you want to import is in the \EXPRESS\TEXT directory. 
If the directory name displayed above the Files list box is not 
C:\EXPRESS\TEXT, use this method to change it. If it is, go on 
to the next step. 

Double-click “..” in the Files list box until you are in 
C:\EXPRESS. Change the extension to WPS. Then scroll down 
the list until the directory name TEXT appears. Double-click 
TEXT to display a list of the files in it. The Files list box should 
list the same files shown in the picture above. 

If you get lost while changing directories, re-read "Using dialog 
boxes'' in Chapter 1, “Beginning.” 

4. Double-click the file NEWSLTR.WPS in the Files list box. 

Express Publisher imports the text into your document. Notice 
that the text flows automatically from the left to the right text 
frames. 

Imported text 
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Saving your work You should save your work every time you make a significant 
change to the document. Saving means that you tell Express 
Publisher to make a copy of the document on the screen and store it 
as a file on your hard or floppy disk. Saving frequently allows you 
to experiment with confidence; if you make a big mistake you can 
always reopen the latest saved version of the document and start 
again. Saving also protects you from losing work if there is a power 
failure or a computer problem. 

The first time you save a document you need to enter a name. 

1. Pull down the File menu and choose Save As. 

The Save As dialog box appears. 
The Save As dialog box 

2. Type CLUBTALK in the File name edit field, and click OK. 

Express Publisher saves your work. Notice that the file name 
displayed in the center of the screen now reads "CLUBTALK.EPD." 
The document has been stored in the \EXPRESS\DOCS directory. 

Now that you have saved the document once, you can use the Save 
command and Express Publisher automatically saves the document 
to the same name and directory. 

Your document is starting to look like a newsletter, but you need to 
make the story headline stand out more clearly. To do this, you are 
going to apply a preset style to the headline. 

You already know how to change fonts and character sizes, but 
Express Publisher allows you to make several formatting changes 
at once with the Choose Style command. 

Creating a story 
headline 

Using a style 
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A style is a group of formatting characteristics that are identified by 
a single name. When you select a paragraph of text and apply a 
style, all of the formatting characteristics within the style are 
applied to the selected paragraphs. This means that with a single 
command you can change the type face, character size, character 
attributes, justification, spacing, margins and indents of your entire 
paragraph. 

Express Publisher comes with a number of preset styles that offer 
paragraph and character formats suited for particular purposes. For 
example, the Headline style instantly changes the text in the current 
paragraph to a larger bold font with extra space below the line. Try 
using the Headline style on the text that you just imported. 

1. Make sure you are using the I-beam text cursor. Use the mouse 

2. Insert the I-beam pointer just left of the word "Spring." 

to move it to the top of the left text frame. 

Selecting the headline 

3. Select Choose Style from the Text menu. 

The Choose Style dialog box appears. 
The Choose Style dialog 

box 

4. Click Headline in the list box and then click OK. 

Express Publisher increases the type size to 36, and changes the 
headline font to Dixon in bold. 
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Adding a subhead Subheads make it easier for a reader to find specific information in 
a story, and they also make the page look a little livelier. Let's add a 
subhead to this story. 

1. Move the mouse so the I-beam is at the beginning of the sentence 
"Last year's spring gala" in the second column and click once. 

You may have to scroll down the document to find the sentence. 
To do so, press PGDN. 

2. Press RETURN twice to create two blank lines and press Up once. 

3. Type Del Vechio Home Benefit. 

Now change the font of the subhead so that it's different from the 
story. Use the mouse and the I-beam pointer to select the line you 
just typed. 

Selecting the subhead 

4. Select Choose Font from the Text menu. 

The Choose Font dialog box appears. 

and click bold. 
5. Click Cobb in the Typeface list box, select 14 points as the size, 

6. Click OK. 

The text you selected changes to the new font and size. 

7. Click the Arrow tool to put away the Text tool. 

To make room for a second story, you need to clear some space on 
the first page of the newsletter. Shorten the second text column and 
add a frame for more text. 

1. Select the text frame on the right side of the page. 

2. Move the pointer over the center handle at the top of the frame. 

You may have to scroll up the document window: drag the 
elevator in the vertical scroll bar to the top of the screen. 

Adding a second 
story 
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3. Drag the handle down so that the top of the frame ends up 5” 
from the top of the page. Use the tick marks on the vertical ruler 
to measure the distance as you drag. 

Shortening the right text 
frame 

The text at the top of the second frame moves down, and some 
of the text disappears at the bottom. The text isn’t lost; Express 
Publisher stores the rest of the story that no longer fits in the 
frame. When you make more room, the text reappears. A small 
crooked arrow, called the More Text marker, in the bottom right 
corner of the text frame indicates that there is more text than will 
fit in the text frame. 

Now that you have a blank space at the top of the second 
column, create a new text frame for the second story. 

4. Use the Text Frame tool to draw a text frame that fills the space 
that you cleared. Make sure that the top of the text frame is even 
with the top of the text column on the left (use the tick mark on 
the vertical ruler to line it up). Try to make the new text frame 
the same width as the other text frames (see the figure below). 

Creating a new text frame 
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Aligning objects To look like a professional newsletter, the text frame you just 
created should line up on the left with the text frame beneath it. 
Since this is difficult to do by hand, try using the Align tool. 

1. Click the Align tool. The Align tool 

The pointer changes to the alignment pointer. 

dow, the same one you resized earlier. 

This identifies the text frame as the object to which you want to 
align another object. The second object that you click is the one 
that will be moved. 

2. Click the text frame at the bottom right of the document win- 

3. Click the text frame that you just drew. 

The Align Two Objects dialog box appears. It displays all the 
different options for alignment. The solid lines show which 
edges of the two objects will be aligned. For this example, align 
the left sides of the two objects. 

The Align Two Objects 
dialog box 

4. Click the second icon from the left in the top row and click OK. 

The left side of the text frame you drew is aligned to the left side 
of the older text frame. 

Now that the new text frame is in the right place, you can fill it with 
a second story. 

1. Click the text frame that you just aligned. 

2. Pull down the File menu and select Import Text. 

3. Change extension to WPS and double-click the file STORY2.WPS 

Express Publisher imports the file. Again, the More Text marker 
means that there is more text than will fit in the frame. In Lesson 4 
you will learn how to make space for the remainder of the story. 
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Club Talk with second story 
imported 

Changing the line 
type 

Express Publisher draws text frames created with the Text Frame 
tool with non-printing lines. Non-printing lines appear as dotted or 
shaded lines on the screen, but they do not show up when you 
print the document. The text frame you just drew has non-printing 
lines, as do the other three text frames in your document. In most 
cases you don’t want boxes to appear around all the text in the 
printed document, but you can use boxes to distinguish one story 
from another: for example, to set the second story you just im- 
ported off from the first story. The Set Line tool allows you to 
change the line type. 

1. Select the text frame into which you imported the second story. 

2. Click the Set Line tool. The Set Line tool 

The Set Line Type dialog box appears. 

The Set Line Type 
dialog box 

3. Click the Black option box, and click OK. 

Express Publisher changes the lines around the text frame to 
black lines. 
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Summary of lesson 3 In lesson 3 you learned some of the first steps you might take in 
creating a simple newsletter. 

The New command lets you specify the number of columns, 

It is very important to save your work frequently. 
You can change the font, attribute and type size of any selected 
text in a text frame. You may have different fonts and sizes 
within a text frame. 
Styles can apply a number of text formatting parameters to any 
selected paragraph. 
You can import text from other programs, or enter it directly into 
a text frame. 
Text frames created by the New command are linked together so 
that text flows from frame to frame automatically. 
Text frames can be resized just like any other object. 
Align any two objects to each other using the Align tool. 
The Set Line tool changes the line type of text frames. 

You have now completed lesson 3. You may now leave Express 
Publisher or clear the screen and go directly on to lesson 4. 

Exiting 

1. Press CTRL-S to save the work you have done in this lesson. 

2. Pull down the File menu and double-click Exit to leave Express 

Continuing 

Press CTRL-S to save the work you did in lesson 3 and go on to 
lesson 4. 

number of pages, and page size for a new document. 

How to continue 

Publisher. 

Lesson 4: More advanced functions 

Now you’re ready to try some more advanced techniques to 
complete your newsletter: flow stories from one page to another 
and wrap text around a picture. 

If you closed your newsletter document in Lesson 3, you will have 
to retrieve it in order to do lesson 4: Pull down the File menu and 
choose Open, then double-click CLUBTALK.EPD. 

In lesson 3 you imported two stories to create the first page of your 
newsletter. Now you need to add a page to hold the text that 
wouldn’t fit on page one. 

Opening a document 

Adding a new page 
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1. Pull down the Page menu and choose Create New. 

The Create New Page dialog box appears. It looks very much 
like the New Document dialog box. 

The Create New Page 
dialog box 

2. Click the 2-Column icon and click OK. 

Express Publisher adds a new two column page to your docu- 
ment and displays it in the document window. 

Linking text frames When you imported the first story on page one, the text flowed 
from the left to the right frame because they were linked together. 
Now you will learn to use the Link tool to make the second story 
continue on page two of your newsletter. The Link tool can link 
together text frames on a single page, or across different pages. 

1. Press CTRL-P to go to the previous page. The Link tool 

2. Click the Link tool. 

The shape of the pointer changes to remind you that you are linking. 

3. Click the text frame containing the second story. 

While you are using the Link tool you can change from page to 
page to find the frames you want to link. The Next and Previous 
commands let you move between pages. ~ L - N  activates the 
Next command, and CTRL-P activates the Previous command. 
The number of the current page appears at the lower right corner 
of the screen. 

4. Select Next from the Page menu, or press CTRL-N. 

5. Click the text frame on the right side of the page. 

Express Publisher fills the text frame with the remaining story text. 
Now use the same method to link the text frame on the lower right 
side of page one to the text frame on the left side of page two. 

6. Press CTRL-P to move to the first page. 

7. Click the Link tool. 

8. Click the text frame on the lower right side of the page. 
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9. Press CTRL-N to move to the next page. 

10. Click the text frame on the left side of the page. 

If you get confused while using the Link tool, click the Arrow tool 
to deactivate the Link tool. 

So far, your newsletter contains only text; it needs a picture to liven 
it up. This exercise shows you how to use the Text Wrap tool to 
wrap text around irregular pictures or any object. 

Start by importing a picture and placing it at the bottom left column 
of page one. 

1. If necessary, use the Previous command to change to page one. 

2. Press PGDN until you are at the bottom of the document. 

3. Use the horizontal scroll bar to move to the very left side of the 

4. Pull down the File menu and select Import Picture. 

Note 

Importing a picture 

document. 

The Import Picture dialog box appears. 

The Import Picture dialog 
box 

5. Double-click the file FLAPPER.TIF. 

Express Publisher imports the picture and places it in the middle 
of the document window. 

6. Move the picture into the following position. 
FLAPPER.TIF in the correct 

position 
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7. Click the Object menu and select Scale. 

8. When the Scale Object dialog box appears, type 50 and click OK. 

9. If necessary, reposition the picture in the lower left corner. 

10. Click the Text Wrap tool. 

11. Click the text frame, beyond the edges of the picture, but not 
outside of the frame. 

If you click the picture by mistake, a dialog box appears telling 
you that you must select a text frame first. 

The Text Wrap tool 

12 Click the picture. 

The text wraps around the picture. 

Show Page Your newsletter is ready for printing, but before you print you 
might want to see both pages of your newsletter at once on the 
screen. The Show command allows you to display single or double 
pages. 

1. Select the Show command on the Page menu. 

Express Publisher reduces the view of the document. 

2. Click the Two Pages button at the bottom of the screen. 

Express Publisher reduces the view of the document so that both 
pages are visible in the document window. 

Note Although you can read the type on the pages, you can’t make any 
changes to the document in this view. 

3. Click OK when you are done viewing the page. 

If you want, make adjustments based on what you saw. 

Printing Now that the newspaper is complete, you’re probably eager to see 
what it looks like on a printed page. 

1. Pull down the File menu and choose Print. Make sure that you selected 
a printer from F70 setup 

There are a number of printing options available on the Print 
dialog box, but the default options are suitable for your current 
needs. All of these options are explained in Chapter 6, “Printing.” 

2. Click OK. 

The Printing Progress dialog box appears. It indicates the current 
page number and the number of objects still to be printed on the 
page. 
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The Printing Progress 
message box 

If you’ve never printed from a desktop publishing program before, 
it may seem as though Express Publisher takes a long time to print. 
Express Publisher needs to send about a thousand times more 
information to your printer than an ordinary word processor. If 
you’re printing on a laser printer it may seem like nothing is 
happening. As long as the wait icon is present, you know that 
information is still being sent to the printer. 

In lesson 4 you began to learn about some of Express Publisher‘s 
more advanced features. 

You can add a new page to a document at any time. 
Text frames can be linked so that text flows from frame to frame. 
Text frames can be linked across pages. 
Express Publisher can wrap text around a picture. 
The Show command displays a reduced view of an entire page 

Summary of lesson 4 

in the document window. 

HOW to continue You are now ready to start using Express Publisher to create your 
own documents. If questions arise as you work, look up the subject 
in the index and read the section of the manual that discusses it. 

Exiting 

You may want to save this document to refer to as you practice 
some of the skills you have just learned. When you feel comfortable 
with your new ability, you can delete it. 

1. Press CTRL-S to save the work you have done in this lesson. 

2. Click the File menu. 

3. Double-click Exit. 

You return to the DeskMate or DOS prompt if using Runtime 
version. 
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3 

Fundamentals 

This chapter covers many of the basic functions you need to un- 
derstand before beginning work on your own documents. Most of 
these features relate to creating and saving documents. The chapter 
also explains how to move around in a document, and how Express 
Publisher for DeskMate's optional display settings work. 

Creating a new document 
Saving your work 
Resuming work on an existing document 
Using templates 
Document viewing options 
Moving between pages 
Adding and removing pages 
Undoing 
Setting options 
Closing and quitting 

Creating a new document 

The New command allows you to create new documents. When 
using the New command, you can choose between preset column 
layouts or you can choose blank and design your own layout. In all 
documents created by the New command, text flows automatically 
from column to column and from page to page. If you are learning 
Express Publisher for DeskMate, you probably should start with 
the preset options. 

You don't have to use the New command to start working. If you 
start Express Publisher without specifying a file to work with, it 
creates a one page, one column document. 

Using the preset options you can create professional-looking 
documents quickly without having to do a lot of calculations or 
designing. The presets allow you to choose between blank, one, 
two, and three column layouts. Text flows automatically from 
column to column in documents created by the one, two, and three 

Note 

Using Presets 
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column presets. The two and three column formats include space at 
the top of the page for a headline. The Blank option creates a 
document with no preset columns or first page header. Each of 
these column layouts can be placed on any of the four page size 
options. These include Letter (8.5” x 11”), Executive (7.25” x 10.5”), 
Legal (8.5” x 14”), and Ledger (11” x 14”). You can create a docu- 
ment of up to 32 pages. 

Follow these instructions to create a new document: 

1. Pull down the File menu and select New. 

The New Document dialog box appears. It contains four icons 
representing each of the column layout options, a text field for 
entering the desired number of pages, and an option box for 
choosing the page size. 

The New Document 
dialog box 

2. Click the icon representing the number of columns you want. If 
you don’t want any predefined columns, click Blank. 

3. Type the number of pages you want in the Pages text field, or 
leave the default setting at 1 page. The maximum setting is 32. 

4. Choose one of the preset page size options, or leave it set to the 
default 8.5” x 11”. Then click OK. 

Express Publisher creates the new document according to the 
options you selected. If you selected the two or three column 
presets, a picture appears in the document window showing you 
how the text flows through the document. You can press any 
key to delete the picture. 
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Saving your work 

You should save your every time you make significant changes to 
it. If you save frequently, you can always revert to the previously 
saved version if you are not happy with a change. Do not wait until 
you have completed the entire document before saving. Anyone 
who has lost several hours of work after a black-out or machine 
failure can attest to the importance of this habit. 

The first time you save a file, you must use the Save As command. 

These steps tell you how to save a document that you haven’t saved 
before: 

1. Choose Save As from the File menu. 

The Save As 
command 

The Save As dialog box appears. The current file name is 
displayed in the File Name text box. If you have not saved the 
document before, the default name will be UNTITLED.EPD. 
Below the File Name edit field and above the Files list box 
appears the drive and directory the document will be saved to. 
The default directory for documents is \EXPRESS\DOCS. You 
may find it less confusing to store all your documents in the 
DOCS directory. If you want to save a document in a different 
location, you can change drives or directories by double-clicking 
a new drive or directory in the Files list box. You can also use the 
radio buttons to specify whether your document should be 
saved as a normal document or as a template (templates are 
explained later under the heading ”Using templates”). 

The Save As 
dialog box Enter file name here 

Current directory 

Double-click here to return 
to the parent directory 

Click here to save as 
template 

Double-click here 
to change drives 

2. Type a name for the document in the edit field. 

3. If you want to save the document to a different drive or direc- 
tory’ choose the desired drive in the Files list box. Change drives 
or directories by double-clicking on the drive or directory name. 
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4. If you want to save your work as a template, push the Template 
radio button; otherwise leave it set to Document. 

The Template option is fully described in the section titled 
”using templates.” 

5. When all the options are set as you want them, push the OK button. If 
a document or template with the same name already exists, you are 
asked if you want to cancel or to overwrite the existing file. 

You may now continue working on your document, close your 
document, or quit Express Publisher. If you changed the name of 
your document, the new name is displayed at the top of the screen. 

You can change all of the Save options of an existing document 
using the Save As command. There are two main reasons why you 
might want to change some of the Save options: 

To create a new copy of a document with a different name, 

To save a copy of a document to a new location. 

The Save As command activates the Save As dialog box. 

1. Select the Save As command from the File menu. 

2. Follow the instructions for the Save As command, changing the 

leaving the old copy unchanged. 

variables you wish to be different. 

The Save command The Save command saves your document to disk after you have 
saved a document for the first time with the Save As command. 
After you have saved a document once, the Save command always 
saves the document using the same name and location you speci- 
fied earlier. 

The Save command can be activated through the menu or by 
pressing CTRL-S. 

There are, however some strict limitations imposed by DOS. A file 
name can only have eight characters. Express Publisher automati- 
cally adds the .EPD extension to every file you save. In the file 
name DOCUMENT.EPD, DOCUMENT is the file name and .EPD 
is the extension. 

For example, if you type MYFILE in the File Name edit field, 
Express Publisher saves the file under the name MYFILE.EPD. 

File names cannot contain spaces. They also cannot contain any of 
the following characters: * ? / . , ; [ 1 I + = \ : < >. 
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Changing the When you installed Express Publisher for DeskMate on your 
default directory computer, the setup program, INSTALL, created default directories 

to store your documents, word processing files, and clip art. If you 
didn’t reset those directories, they are as follows: documents are 
stored in the \EXPRESS\DOCS directory, word processing files in 
the \EXPRESS\TEXT directory, and clip art in the \EXPRESS\ART 
directory. The first time you use a command that opens a file dialog 
box, Express Publisher for DeskMate looks in the default directory 
for the corresponding file type you want. For example, the first time 
you use the Import Text command, Express Publisher lists all the 
word processing files in the \EXPRESS\TEXT directory in the Files 
list box. As long as you import a word processing file from that 
directory, the Import Text command looks to that directory first. 

These are the commands that use a file dialog box and the directo- 
ries that are associated with them. 

Command Default Directory 
Import Text TEXT 
Import Picture ART 
Open/Save As Docs 
Open Template DOCS 
Print (Print to disk) DOCS 
Print (Print to ASCII) TEXT 

Be careful, when using these commands, that you do not inadvert- 
ently save data to a directory you don’t mean to, making it difficult 
to locate next time. 

For more information about what the default directories are and 
how to change them, see the instructions in ”Setting up directories” 
and "Modifying an existing installation’’ in the Introduction. For 
more information, see your DOS manual. 

Resuming work on an existing docu- 
ment 

To resume work on an existing document, use the Open command. 

These steps tell you how to open an existing document from within Using the Open 
command Express Publisher: 

1. Pull down the File menu and select Open (or press CTRL-O). 

A dialog box appears listing all of the documents with the .EPD 
extension in the \EXPRESS\DOCS directory. 
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The Open File 
dialog box 

2. If necessary, change the current drive or directory by double- 
clicking or selecting the appropriate drive or directory and 
pressing ENTER. Only files with the appropriate extensions are 
displayed. 

The files displayed in the Files list box change when you switch 
drives or directories. 

3. Scroll through the listing of files. Select the document you want 
by clicking on it and then clicking the OK button, or simply by 
double-clicking on the file you want to open. 

Using wild card characters 

When opening document files, or importing text or picture files, 
you can use wild card characters to make your search for the file 
easier. If you can't remember exactly which file you are looking for, 
or if you want to look at a certain group of files, use wild card 
characters to view all the file names that have certain characters in 
common. 

For example, all Microsoft Works word processing files have an 
extension of .WPS. If you want to view only Works files in a 
directory that contains several types of files, you could type WPS in 
the Extension edit field of the Import Text dialog box. When you 
press TAB the listing in the Files list box changes to include only 
files that end in .WPS. 

Using templates 

A template is a document that contains most of the basic page 
elements needed to suit a particular purpose. For instance, a 
template for a weekly newsletter might already have the title in 
place and all the columns and picture locations defined. To com- 
plete the newsletter each week you would only have to import a 
couple of stories and type a headline or two. 
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Opening a template is very much like opening an ordinary Express 
Publisher document, except that all templates are opened without a 
file name. The file name UNTITLED.EPD appears until you save 
the document with a new name. This helps to ensure that you do 
not accidently overwrite a template. 

Express Publisher includes several templates that you may find 
useful. The setup program installed them in the \EXPRESS\DOCS 
directory. Most of the templates included with Express Publisher 
contain brief instructions or advice on how they should be used. 
You can delete the instructions as soon as you start to work on the 
document. Templates are stored on disk as separate files and can be 
identified by their file names. Templates have an extension of .EPT. 

Any document can be saved as a template and used as a starting 
point for other documents. If you need to create similar documents 
every week, such as a schedule or a status report, you should save a 
template that contains the basic elements of the document. 

Saving a document as a new template saves every object in the 
document, so you should consider carefully whether everything in 
the document is really necessary. In particular, pictures take up a 
lot of space on disk and should not normally be saved as part of a 
template. (PCX, ART and MAC pictures are always saved with the 
document. TIFF picture files are not stored in document or template 
files. This is discussed in Chapter 4, "Objects.") You can keep 
working on a document after you have saved it as a template. You 
can even save it as an ordinary document file. 

Follow these steps to create a template: 

1. Create a document that includes all the elements that you want 

2. Select Save As from the File menu. 

3. Type a name for the template. 

4. Click Template in the File Type option box. 

5. Click OK. 

Included templates 

Creating templates 

in the template. 

Express Publisher saves your work as a template. 

Revising templates 

To make changes to an existing template, follow these steps: 

1. Select Open from the File menu. 
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The Open File dialog appears listing all the files in the 
\EXPRESS\DOCS directory. 

directories in the Files list box. 
2. Change the Extension to EPT and, if necessary, change drives or 

3. Double-click the template you want to open in the Files list box. 

Express Publisher opens the template as a template. The name of 
the template with the extension .EPT appears in the middle of 
the menu bar. 

4. Make changes as necessary. 

5. Select save from the file menu, or press CTRL-S. 

Use the Open Template command to create a new document using 
an existing template. All template names end with the .EPT extension. 

1. Pull down the File menu and choose Open Template. 

The Open Template 
command 

The Open a Template dialog box appears. It is almost identical to 
the Open Document dialog box. It displays all of the templates in 
the \EXPRESS\DOCS directory. 

The Open Template 
dialog box 

2. If necessary, change by double-clicking the drive or directory in 

3. Double-click the template you want to open in the File list box. 

Express Publisher opens the template and names it 
UNTITLED.EPD You may start your work as if it were an ordinary 
untitled document. 

the list box. 
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Document viewing options 

Changing your view 
of the document 

In most cases only a small portion of your document is visible in the 
document window. You canchange your view so that the entire 
page is shown in the window by using the Show command. This 
allows you to see how all the page elements look in relation to each 
other. When you are viewing a page using Show, you cannot 
modify the document in any way, you can only look at it. 

To use the Show command, follow these steps: 

1. Pull down the Page menu and select Show. 

Your view of the document is changed so that the entire page is 
visible in a reduced state. 

2. If you have a multi-page document may change from page to page 
by clicking on the Next and Previous buttons while using Show. 

3. If you are working on a document with two pages or more, you 
can use the Two Pages button to display two pages side-by-side. 

4. Click OK to return to normal view. 

Moving between pages 

The Next and Previous commands move you from page to page in 
your document. The Go to command lets you jump to any page. 

To use the Next and Previous commands, select either of them from 
the Page menu; or press CTRL-N for Next and CTRL-P for Previous. 

Express Publisher immediately changes the current page. 

The Go to command is very useful for moving around in longer 
documents. 

1. Pull down the Page menu and select Go to, or press CTRL-G. 

GO to 

The Go To Page dialog box appears. 
The Go To Page dialog box 

2. Type the page number that you want to move to in the Page 
Number field and click OK. 

Express Publisher moves to the page you selected. 
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Adding and removing pages 

You can add new pages to your document whenever you like. 
When you create a new page you have the same options you did 
when you first created the document. However, new text frames are 
not linked to any other text frames on other pages and you cannot 
specify a new page size. You can also choose to copy the current page. 
You can insert a new page anywhere in a document. 

Follow these instructions to add new pages to your document: 

1. Pull down the Page menu and select Create New. 

Create New Page 

The Create New Page dialog box appears. You have the choice of 
selecting all the Same preset options you did in the New Docu- 
ment dialog box: blank, letter, two, or three column. You can also 
choose to copy the current page with the Copy Page option. 

2. Click the icon representing the style of page you want. 

3. Type the page number of the page you want to insert and click OK. 

The new page is inserted. If you inserted a new page two, the old 
page two is now page three. None of the text frames in the new 
page are linked to any other frames on the other pages; you must 
do that yourself. 

The Create New Page 
dialog box 

Copy page The Copy Page option in the Create New Page dialog copies every object 
(not text) on the current page to a new page. It is useful for duplicating 
irregular page layouts. If you create an uneven layout on page one of a 
document, use Copy Page to add identical pages as the document 
grows. 

1. If necessary, change pages so that the page you want to dupli- 

2. Select Create New from the Page menu. 

3. Enter the page number of the new page in the Page # field, or 

cate is displayed in the document window. 

leave the existing number. 
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4. Select Copy Page and click OK.. 

Express Publisher copies every object on the current page to the 
new page. 

The Delete command removes an entire page from your document, 
deleting every object that was on the page. It should be used with 
extreme caution, it is not Undo-able. 

1. Pull down the Page menu and choose Delete. 

2. Enter the number of the page you want to delete. (The current 

3. Click OK, or cancel the operation. 

4. A confirmation dialog box appears. 

You cannot delete a one page document. 

Delete page 

page is the default.) 

Note 

Undoing 

Being able to change your mind and correct mistakes easily is one 
of the major advantages of doing almost any type of work on a 
computer. You can undo many of the operations in Express 
Publisher by using an opposing command to reverse the operation. 
For example, when you use the Bring to Front command, in most 
cases you can use the Send to Back command to undo the change. 
Or, after you paste an object, you can cut it while it is still selected. 
Certain operations can be undone with the Undo Move command. 

The Undo Move command allows you to undo the following 
actions: moving an object, drawing an object, resizing an object, and 
deleting an object (except for a text frame). 

Undo Move 

To use the Undo Move command, pull down the Edit menu and 
select Undo Move. 

Your last action is undone, or a dialog box appears informing you 
that your last action cannot be undone. If there is nothing to be 
undone, the menu item is dimmed. 

Setting options 

The Options menu lets you control some of Express Publisher's 
optional display elements. 
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If you want to look at your document with no distractions, you can 
put away the rulers or the toolbox. 

To put away either the rulers or the toolbox, pull down the 
Options menu and select either Rulers or Toolbox. 

Each of these commands works like a toggle switch. If the toolbox is 
displayed, the Toolbox command puts it away. If it was already 
hidden, the command makes it reappear. A check appears next to 
the command when the option is on. 

The Units command changes the units of measure shown on the 
rulers. This setting determines the units for all the measurements in 
the program, (except for text character measurements, which are 
always in points). You can choose between inches, centimeters, and 
picas (a pica is 12 points, a point is approximately 1/72”). 

Follow these instructions to set the units of measure: 

1. Pull down the Options menu and choose Units. 

Units of measure 

The Units dialog box 

2. Choose either inches, centimeters, or picas from the dialog box. 

3. Click OK. 

The Display command controls three optional operation features. 
Collectively, they control the degree to which the document you see 
on the screen looks like the final print out. 

If you are working on a slower system or a computer with only 640 
K, you may want to turn off Display Bitmap Images. It is the one 
option that has a real impact on speed and memory. Each of the 
Display options is documented below. If you don’t understand an 
option, leave it alone. 

Display bitmap images : Displaying large bit-mapped pictures on 
the screen takes up large amounts of memory in your computer 
and slows down the screen display. With this option on, Express 
Publisher displays all bit-mapped pictures the way they will print 
out. If you are running low on memory, turn this option off to clear 
up some space; Express Publisher shows only a filled rectangle 
with the name of the image to mark the location of the bit-map. The 
pictures appear when you print the document. 

Display 
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Display hidden objects; This option makes objects visible, even 
those that were hidden with the Specifications command. If you 
have lost track of a hidden object, turn this option on to find it. 
Read about the Object Specifications command in "Specifications" 
in Chapter 4, "Objects." 

Make all objects selectable: This option makes all objects select- 
able, even those that were made non-selectable with the Specifica- 
tions command. Read about the Specifications command in "Speci- 
fications" in Chapter 4, "Objects." 

To change the settings: 

1. Pull down the Options menu and choose Display. 

2. Turn the various options in the dialog box off or on. 

3. Click on OK. 

Closing and quitting 

Closing a document To close a document is to put the document away without quitting 
Express Publisher. Close a document at anytime by choosing the 
Close command from the File menu. Express Publisher closes the 
document and clears the screen. 

If you made any changes to a document without saving, Express 
Publisher asks you if you want to save these changes. 

If you choose Yes, the document is saved with the current name 
and location. If the document is untitled, the Save As dialog box 
appears. 

abandoned. 

return to your document. 

If you choose No, the document is closed and the changes are 

If you choose Cancel, you are cancelling the Save option. You 

Quitting Express Publisher closes your document and ends your 
session. If you have made changes without saving, you are asked if 
you want to save the changes. 

This is not a recommended way of saving changes. We prefer that 
you save your document and then quit. You may lose work if you 
accidentally choose the wrong option while quitting. 
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1. Choose Exit from the File menu. 

If you haven’t made any changes to a document, Express 
Publisher returns you to DeskMate or, if you are using the 
Runtime version, to DOS. 

2. If Express Publisher asks you if you want to save any changes, 
select an option. 

If you choose to save changes, Express Publisher saves the docu- 
ment with the current name. If the document is untitled the Save As 
dialog box appears. 

If you choose not to save changes, the changes are lost. 
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4 

Objects 

Creating a document with Express Publisher for DeskMate is 
similar to creating a collage. Express Publisher handles a page as a 
collection of many page elements called objects. You can move and 
change every object without affecting surrounding objects. This 
chapter explains all of the different ways you can create and change 
objects. Since imported pictures are treated as ordinary objects, this 
chapter also covers all the issues related to importing and modify- 
ing pictures. The basic methods of working with objects in Express 
Publisher for DeskMate are the same no matter what type of objects 
you are working with. 

This chapter addresses all of the following object-related subjects: 

What is an object? 
Drawing objects 
Selecting objects 
Changing lines and fill patterns 
Moving objects 
Aligning objects 
Changing the size of objects 
Using the grid 
Cut, Copy, Paste, and the clipboard 
Specifications 
Duplicating objects 
Importing pictures 
Changing pictures 

What is an object? 

Objects are the elements in a document that you can change 
individually. Every image that you create with one of the drawing 
tools is a separate object; so are imported pictures and text frames. 

In the picture below, there are three objects: the box containing text, 
the ellipse, and the picture. 
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Three objects 

Drawing objects 

Every image that you create with one of the drawing tools is an 
object. The Express Publisher drawing tools are similar to drawing 
tools in other programs. All of the images, except for lines, are 
based on bounding boxes. When you draw an object, you are actually 
drawing a box around what will be its final image. While you are using 
one of the drawing tools, the pointer shape changes to a pencil. 

This example shows you how to draw a box, but every drawn 
image can be made in the same way. 

1. Click the Box tool. 

The pointer shape changes to a pencil. 

2. Move the pointer to where you want to place the upper left 
corner of your box and hold down the mouse button. 

This marks the anchor point for the box you are drawing. 

The drawing tools 

The Box tool 

3. Drag the pointer down and to the right. 

Drawing a box 

4. When the box is the desired size, release the mouse button. 

The pointer changes back to an arrow. The point at which you 
released the mouse button marks the box’s end point. 

Every drawn image is created in the same way. After you select the 
particular drawing tool, the point at which you press the mouse 
button marks the image’s anchor point. You then drag the pointer 
to define the image. When you release the mouse button you are 
marking the image’s end point. Express Publisher then draws the 
image within the rectangle you defined. Lines are the only drawn 
images not based on rectangles. Lines are drawn between the 
anchor point and the end point. 
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Note If you need to draw an object larger than the document window, 
drag the pointer off the edge of the document window and Express 
Publisher scrolls the window for you. 

If you double-click the Sticky icon, the current drawing tool 
remains active after you have used it and the sticky tool icon 
appears in the corner. This allows you to draw several objects 
without having to click a drawing tool between each one. 

1. Double-click one of the drawing tools. 

2. The Sticky tool icon appears in the lower right-hand corner of 
your screen. 

3. Draw an object. 

4. Draw another object. 

The Sticky tool 

Notice that the pointer does not change back to an arrow after 
drawing the object. It remains in the pencil shape. You can 
continue using the same drawing tool to draw objects until you 
click another icon. 

5. To put away the Sticky tool, click on the arrow. 

Snap To Grid is helpful for drawing objects in a certain location or 
exact size; it's also useful for drawing parallel lines. The grid is 
explained in this chapter under the heading, "using the grid." 

Using the grid 

Selecting objects 

To select an object is to choose the object that will be affected by 
your next action. Understanding how to select the object you wish 
to modify is an important step in mastering Express Publisher. 

The pointer reminds you of the tool you are working with at that 
moment. When selecting objects the pointer should be the arrow. If 
it is not, clicking the Arrow tool restores the arrow pointer. 

You can tell that the object is selected when little black squares 
called handles appear around the object. 

The Arrow tool 

A selected object 

Once you have selected an object, use any of Express Publisher's 
functions to manipulate the object. 
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Deselecting an object To deselect an object, move the pointer anywhere in the docu- 
ment window outside of the selected object and click the mouse 
button, or select another object. 

The object is deselected and the handles disappear. 

An Express Publisher page consists of several layers of objects. 
Think of a page as a stack of transparencies. The stack is in chrono- 
logical order. The first object you place on the page is at the bottom 
of the stack, and the last is on the top. 

Ordinarily, you select an object by moving the pointer to some area 
within the object that is not covered by another object and clicking 
the mouse button. It may not be immediately obvious that an object 
is covering another if there are several objects overlapping. You can 
always tell which object is selected because handles appear around 
its borders. It is not possible to select an object that is entirely 
covered by another object. In some cases, you may have to change 
the stacking order to be able to select a certain object. 

Over lap ping objects 

The order in which objects are placed on top of each other can have 
a big effect on the final appearance of your document. For example, 
you may want a shaded box to be placed behind a picture. If you 
place the picture first, when you draw the shaded box it will cover 
the picture. In this case you would use the Send to Back command 
to move the box behind the picture. 

The Bring to Front, Send to Back, Shuffle Up, and Shuffle Down 
commands on the Object menu help you to rearrange the stacking 
order of objects in your document. 

Bring to Front brings any selected object all the way to the top of 

Send to Back sends a selected object all the way to the bottom of 

Shuffle Up moves a selected object a layer up in the stack. 

Shuffle Down moves a selected object a layer down in the stack. 

the stack. 

the stack. 
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Bring to Front/Send to Back 

To bring an object to the front of the object stack, or send it to the 
back, follow these steps: 

1. Select the object you want to bring to the front or send to the 

2. Pull down the Object menu and select either Bring to Front or 

back. 

Send to Back. 

Shuffle Up/Down 

These two commands are very useful for working on documents 
that have background images. You might decide that you want one 
of your foreground images behind another, but not behind the 
background image. In this situation the Shuffle Down command 
lets you move an object behind one of the foreground images, but 
not behind the background. Remember that objects are stacked in 
chronological order in your document. The first object you create is 
at the bottom of the stack, and the last is at the top. Even if an object 
appears to be directly underneath another object, there can be 
several other objects placed chronologically between the two 
objects. The Shuffle Up and Shuffle Down commands move 
selected objects only one layer up or down in the stack, so in some 
cases you may have to repeat the command several times to move 
the object to the right position in the stack. 

These steps tell you how to use the Shuffle Up or Shuffle Down 
commands: 

1. Select the object you want to change. 

2. Pull down the Object menu and select either Shuffle Up or 

3. Repeat step 2 until the object is in the desired position. 

In some cases it can seem as though it is impossible to select an 
object. There are two situations that could cause this. 

Covered objects 

The most common problem in selecting objects is that an object is 
completely covering the object you are trying to select. Remember, 
many objects are transparent. If you drew an unfilled box or other 
shape around an object, you won’t be able to select the object inside 
until you send the covering object to the back. The example below 
illustrates this point. 

Shuffle Down. 
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1. Draw a small unfilled box. 

2. Draw a larger unfilled box that completely encloses the smaller 
box. 

Now try to select the smaller box. You are not able to, you can 
only select the larger box. Use the Send to Back command to 
remedy this situation. 

3. With the larger box selected, pull down the Object menu and 
double click Send to Back. 

You are now able to select the smaller box. Since the smaller box 
doesn't completely cover the larger box, you can still select the 
larger box. You can do the same thing with the Shuffle Down 
command. 

If you draw a box around a large area that contains many objects, 
make sure that you send it to the back or you won't be able to select 
any of the enclosed objects. New users often "trap" objects behind 
the text screen that appears on the default UNTITLED document. 
Simply select the text screen if that happens and click Send to Back. 

Non-selectable objects 

It is possible to make any object non-selectable with the Specifica- 
tions command. This is explained later in "Specifications." 

Note 

Changing lines and fill patterns 

You can change the line and fill type of some objects, or reset the 
default options. When you change the default line or fill type 
without having a object selected, the new option is the new default 
and is used each time an applicable object is created. 

Boxes can be either filled or unfilled. Filled boxes are opaque, they 
obscure anything that they cover. Unfilled boxes are transparent. 
The Set Fill tool allows you to specify whether a shape is filled or 
unfilled. It also lets you choose between the available fill patterns. 

Changing existing objects 

The Set Fill tool can change the fill pattern of a selected box, 
rounded box, or ellipse. 

Fills 

The Set Fill tool 1. Select a shape. 

Click the Set Fill tool. 
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The Set Fill Pattern dialog box appears. 
The Set Fill Pattern 

dialog box 

3. If you wish to change the fill pattern of the selected object, click 

4. Click OK. 

one of the fill patterns. 

The object changes to reflect your selections. 

If nothing happens 

If you choose white as the fill type it may not be obvious that 
anything has happened. However, if you move the white object 
over another object you will notice that it is now opaque. 

The Set Line tool lets you define the type of line to be used for drawing 
straight lines and rectangles. The Set Line tool invokes the Set Line 
Type dialog box. From this dialog box, you can choose a line thickness 
and type of ink. You can also choose to draw non-printing lines. Non- 
printing lines appear on the screen as dotted or shaded lines, but do not 
show up when the document is printed. They are useful for creating 
visual guidelines. To make an object transparent, turn off the Filled 
option in the Set Fill pattern dialog box. 

Changing selected objects 

Follow these steps to change the line type of a selected square- 
edged box, or line: 

Lines 

The Set Line tool 1. Select a square-edged box or a line. 

2. Click the Set Line tool. 

The Set Line Type dialog box appears. 
The Set Line Type 

diaIog box 
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3. Select a line thickness and choose either Black, White, or Non- 

4. Click ]OK. 

printing for the line color. 

The object changes to reflect your selection. 

Changing the default line type 

If you change the default line type, all applicable objects will be 
drawn with the line type until you choose a new default. 

To change the default line type, make sure that no objects are 
selected and use the Set Line tool to specify a new line type. 

Using white and non-printing lines 

Use white lines over black or shaded backgrounds, or if you don't 
want a line to appear on the screen. This is helpful for creating 
shaded areas with no borders. Non-printing lines give you the 
same final result, but white lines create a screen display that more 
closely resembles the final results. You can change the line type 
(ink) for ellipses and round rectangles. 

Moving objects 
All objects can be moved in the same way. 

1. Select an object. 

2. Move the pointer onto the object, then press and hold down the 
mouse button. 

The pointer shape changes to a four-headed arrow. 

3. Drag the pointer to where you want the object placed. 

Moving an object 

The object's outline moves with the pointer. 

4. When the object is in the desired location, release the mouse. 

Express Publisher redraws the object in its new location, 
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shortcut You can select and start moving an object at the same time. Just 
position the pointer on the object you want to move, press and hold 
down the mouse button, and immediately start dragging the 
pointer. 

Move a line by dragging the body of the line. Moving lines 

Moving a line 

Using the grid Express Publisher can automatically align objects to grid markers. 
This is helpful for moving objects to a certain location; it‘s also very 
useful for making parallel lines. The grid is explained later in this 
chapter under the heading, “Using the grid.” 

Aligning objects 
The Align tool can precisely align any two objects to each other 
according to your specifications. The Align tool works by aligning a 
secondary object to one or more areas of an anchor object. For 
instance, if you wanted to align the top of a picture to the top of a 
column of text, the column of text is the anchor object, and the 
picture is the secondary object. There are many alignment options, 
each of which are visually represented in the Align Two Objects 
dialog box. 

To align objects, follow these instructions: 

Click the Align tool in the toolbox. 

1. The pointer changes to the align shape. 

2. Move the pointer onto the anchor object and click the mouse. 

The anchor object is the object to which you align a secondary 
object. The anchor object is not moved during this procedure. 

3. Move the pointer to the object that you want to move and click 
the mouse. 

The Align Two Objects dialog box appears. 

The Align tool 
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The Align Two Objects 
dialog box 

Each of the icons stands for a different alignment option. The 
shaded box represents the object that will be moved. The white 
box is the anchor object. The solid lines show the sides that will 
be aligned. 

4. Click the desired alignment option. 

5. Choose OK to finish the operation. 

The second object is aligned to the first according to your 
selection. 

You can double-click the Align tool to align several secondary 
objects to a single anchor object without having to repeatedly select 
the Align tool. Double-click the Align tool, select an anchor object, 
and then select a secondary object. Select an alignment option in the 
dialog box. When the dialog box disappears, notice that the Align 
tool is still active. You can now select an additional secondary 
object. The tool stays active until you click another tool. 

Changing the size of objects 

You can change the size and shape of objects in a number of ways. 
All of the methods discussed below work on every type of object 
but lines. 

Express Publisher allows you to change the width of an object 
without changing its height, or vice versa. 

1. Select the object. 

2. Move the pointer to the middle handle in any of the 
object's sides. 

3. Hold down the mouse button and drag the handle. 

Notice that the object's outline moves with the pointer and that 
you can only change the single dimension. 
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Sizing one dimension 

4. When the object is the right size, release the mouse button. 

Express Publisher redraws the object in the new shape. 

These steps tell you how to change both the height and width of an 
object at the same time: 

1. Select the object. 

2. Move the pointer to one of the comer handles. 

3. Hold down the mouse button and drag the handle in any 
direction. 

The object's outline moves with the pointer to show you the 
changing size of the object. 

Sizing two dimensions 

4. When the object is the right size, release the mouse button. 

Express Publisher redraws the object in the new size. 
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Scaling objects The Scale command allows you to change the size of any object by 
an exact scaling factor. This ensures that the object‘s original 
proportions are preserved. This is especially important when 
scaling imported pictures. You can scale any object. 

Express Publisher uses percentages to express scaling factors: 100% 
is the object‘s current size, 200% is twice the object‘s current size, 
50% is half the object’s size, and so on. You can use any scaling 
factor between 1% and 999%) provided that the object‘s height or 
width does not reduce below 0.125” or expand beyond the page. 

Scaling factors apply to dimensions, not area. If you were to scale a 
1“ by 2” box by 200%, the result would be a 2” by 4” box. 

To use the Scale command, follow these instructions: 

1. Select the object that you want to scale. 

2. Choose Scale from the Object menu. 

The Scale Object dialog box appears. 

Note 

The Scale Object 
dialog box 

3. Type the desired scaling factor. Click OK to proceed. 

You can make two objects the same size with the Equate tool. The 
Equate tool works with two objects, even if they are of different 
types. The Equate tool equates the size of a secondary object to that 
of a primary object. The upper left corner of the secondary object 
stays in the same place as the object is resized. 

To make two objects the same size, follow these steps: 

Equating objects 
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The Equate tool 1. Click the Equate tool. 

The pointer shape changes to the equal sign (=). 

2. Select the first object. 

3. Click a second object that you want to change to the same size as 
the first object. 

The second object is made the same size as the first object. 

Note Lines can only equate to other lines. 

If you want to equate several objects at the same time, double-click 
the Equate tool. The Equate tool remains active and the icon 
remains in the equal shape (=) until you click another icon. 

Using the grid 

The grid is an optional layout feature that displays grid markers at 
fixed locations in the document window. Using the grid you can 
easily move or draw objects at exact locations or make them a 
certain size. Express Publisher can also automatically “snap” objects 
that you are drawing, moving, or resizing to the nearest grid 
marker. You can turn this function on and off with the Snap to Grid 
command. Using the Set Grid command, you can specify the 
intervals at which the grid markers appear, and turn the grid 
display on or off. 

The Set Grids command determines the placement of the grid 
markers and whether or not the grid is displayed on the screen. 
You can place grid markers at any interval over .25”, .635 centime- 
ters, or 1.495 picas depending on the current units of measure. 

1. Select Set Grid from the Options menu. 

The Set Grid Size dialog box appears. 

The Set Grid Size 
dialog box 

2. If you want to change the intervals at which the grid markers 
appear, type a new number in the Grid Size edit field. 

3. Click in the Display Grid check box to make the grid markers 
appear. 

4. Click OK. 
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Snap to Grid When Snap to Grid is on, Express Publisher “snaps” all objects that 
you move, draw, or resize to the nearest grid marker. The Snap to 
Grid command turns the function on or off. A check mark appears 
next to the command when the option is on. You can turn Snap to 
Grid on even when the grid markers are not displayed. 

To turn Snap to Grid on or off, select the Snap to Grid command 
on the Options menu. 

Moving objects 

When you move objects while Snap to Grid is on, Express Publisher 
always places the upper left corner of the object at the nearest grid 
marker. The following picture illustrates this point. 

Moving an object with 
Snap to Grid on 

Resizing objects 

If you resize an object while Snap to Grid is on, Express Publisher 
moves the edges of the object that you are changing to the nearest 
grid markers. The edges of the object that you are not changing stay 
where they are. The picture below makes this more clear. 

Resizing an object with 
Snap to Grid on 

Drawing objects 

When you draw an object while Snap to Grid is on, Express Pub- 
lisher snaps the anchor and end points of the object you are draw- 
ing to the nearest grid markers. 
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Drawing an object with 
Snap to Grid on 

Note The Scale and Specifications commands are not affected by Snap to 
Grid. Specifications is explained next. 

Specifications 

The Specifications command controls several specialized options 
relating to objects. It allows you to control the exact size and 
location of an object. It also lets you specify if an object is printable, 
selectable, hidden, locked, or filled. 

The Object Specifications 
dialog box 

Size and location Remember that all Express Publisher objects are bounded by 
rectangles. By defining the placement of the object's upper left 
corner, and its height and width, you can control the object's exact 
size and location. The Specifications command can be used to view 
these parameters, or to change them. 

Every object has these status options: Printable, Selectable, Hidden, 
Locked, and Filled. By default every object is printable, selectable, 
not hidden, and unlocked. For normal use, you don't need to 
change any of the status options. As you become more familiar 
with Express Publisher, you may find it useful to change them. 

Printable: If you turn off the Printable option, the object will not 
be printed, but it remains visible on the screen. This is useful for 
posting non-printing comments on a document. 

selectable. This is useful if you are working with a complex document 
and you don't want to accidentally select and change an object. This 
option can be overridden by the Make All Objects Selectable option in 
the Display Settings dialog box (see "Display settings" in Chapter 3). 

Object status 

Selectable: With the Selectable option off, the object is no longer 
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Hidden: If you turn on this option, the object becomes invisible. 
This option can be used to temporarily hide an object within a 
document. This option can be overridden by the Display Hidden 
Objects option in the Display Settings dialog box. 

Locked: Turn on the Locked status option if you want to lock an 
object in place. Locked objects can be selected, but cannot be 
moved or sized. 

Filled: With this option on, the object is filled, or opaque. With 
the option off, the object is unfilled, or transparent. 

Using Specifications 1. Select an object. 

2. Choose the Specifications command from the Object menu. 

The Object Specifications dialog box appears. It contains four 
text fields — From Top, From Left, Width, and Height — and 
several check boxes controlling the object status options. If you 
only want to view Object Specifications, click Cancel or press 
ESCAPE. You can alter the Object Specifications values by 
changing the numbers in the text boxes and clicking the various 
check boxes. 

3. Change the numbers in the From Top or From Left text boxes if 
you want to move the object. 

The units of measure are the same as currently displayed on the 
rulers and specified by the Units command. Note that the 
location parameters are based on measurements from the upper 
left comer of the document page. 

want to size the object. 

If you change only the size of an object, the upper left corner 
stays in the same place. 

4. Change the numbers in the Width or Height text boxes if you 

5. Click the check boxes to change the object status options. 

6. Choose OK. 

The object changes to reflect your selections. 

Cut, Copy, Paste, and the clipboard 

Express Publisher supports the popular Cut, Copy, and Paste 
editing commands. You may already be familiar with them from 
using other programs. Cut, Copy, and Paste are very useful for 
moving objects from one page to another in a document. 
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The clipboard The clipboard in Express Publisher is very much like a real clip- 
board. It is used to store information temporarily. Every time you 
cut or copy an object, it is stored temporarily on the clipboard. It 
remains on the clipboard until you cut or copy another object, or quit 
Express Publisher. Only one object can be on the clipboard at a time. 

These steps tell you how to see what is on the clipboard: 

1. Choose Show Clipboard from the Edit menu or press CTRL-K. 

A window appears displaying the contents of the clipboard. 

2. Click OK when you are done looking at the clipboard. 

The clipboard window disappears. 

Note Show Clipboard is disabled until something has been placed on the 
clipboard 

Cutting an object removes it from the document and places it on the 
clipboard. Copying an object places a copy of the object on the 
clipboard and leaves the original in the document. Both of these 
commands overwrite the previous contents of the clipboard. 

To cut or copy an object, follow these steps: 

1. Select the object. 

2. Choose Cut or Copy from the Edit menu. The accelerator for Cut 

Cut and Copy 

is SHIFT-DEL and the accelerator for Copy is CTRL-INS. 

The object is cut or copied to the clipboard. (See above.) 

Note If you cut a text frame to the clipboard, only the box ends up on the 
clipboard. The text that was inside the box is redistributed to other 
text frames in the same story. If there are no linked text frames, a 
dialog box appears warning you that you are about to lose the text. 

Pasting an object places a copy of the object currently on the 
clipboard into your document. The Paste command is not available 
if there is nothing on the clipboard. 

1. Cut or Copy an object to the clipboard, or use Show Clipboard to 

2. Pull down the Edit menu and select Paste. 

Paste 

see what is on the clipboard first. 

The object is pasted in the middle of your document view. 

To erase the contents of the clipboard, pull down the Edit menu 
and select Clear Clipboard or press CONTROL-C. 

Clear Clipboard 
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Duplicating objects 

Duplicate The Duplicate command makes a copy of the currently selected 
object and places it slightly below and to the right of the original 
object. If you attempt to duplicate a text frame, the frame will be 
duplicated but the text within it will not. 

1. Select the object. 

2. Pull down the Edit menu and select Duplicate or press CTRL-D. 

The new copy is placed slightly lower and to the right of the 
original object. This newly created object is then selected. 

Importing pictures 

This section explains the basic importing procedure. It goes on to 
discuss issues specific to certain types of pictures. It also offers advice 
on how to get the best printed results from imported pictures. 

To help get you started in using pictures, your Express Publisher 
package includes a large collection of high quality clip art. All of the 
clip art, except for one or two PCX images is in the TIFF format, 150 
and 300 dpi (dpi and TIFF are explained below). You can copy all of 
the 150 or 300 dpi clip art collection onto your hard disk using the 
install program. The install program copies clip art into the 
\EXPRESS\ART directory. Don’t try to copy the clip art directly to 
your hard disk without using the install program: to fit more 
pictures on each disk, the pictures were compressed. The install 
program decompresses them automatically as it copies them to 
your hard disk. 

Additional clip art 

If you want more clip art to work with, Power Up sells several clip 
art collections. You can contact our customer service department by 
calling 800-851-2917. 

There are several formats for storing pictures. Express Publisher can 
import pictures that adhere to one of the following standards: PCX, 
TIFF, ART, and MAC. Most graphics programs are capable of 
saving pictures in at least one of these formats. Each format has 
different characteristics. In most cases Express Publisher takes care 
of these differences so that you can treat them all the same way. 
Differences are explained later in this chapter under the heading 
”About picture formats.” 

Clip art collection 

Compatible picture 
formats 
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Note Certain graphics programs are able to create multi-plane color 
images. Express Publisher cannot import these images. It can 
import two-color, single-plane color images, converting every color 
to black. Basically, a multi-plane color image is one that uses more 
than two colors laid over each other to create the proper hues and 
tints. If you are having trouble importing an image into Express 
Publisher, consult your graphics program's documentation for 
information on how its images are created and saved. 

Follow these steps to import a picture file: 

1. Choose the Import Picture command from the File menu. 

The Import Picture dialog box appears. It displays all of the files 
in the \EXPRESS\ART directory. 

The Import Picture 
dialog box 

2. If necessary, change directories or disks to find the desired 

3. Double-click the desired picture file. 

picture file. 

The picture is opened and placed in the middle of the document 
window. It takes longer to import higher resolution picture formats. 

Insufficient memory 

If your computer is low on memory (not disk space), Express 
Publisher will import the picture but will not display it on your 
screen. In its place will be a gray rectangle the actual size of your 
picture. The picture will, however, print accurately, unless you are 
really short on memory. 

To view the actual picture, try placing it in a separate, empty file. If 
you still cannot view the picture, it is simply too large to display, 
using your computer's current memory. 

After importing a picture, you can find that it is taking longer for 
Express Publisher to refresh the screen. To speed up screen refresh, 
choose Display under the Options menu and turn off Display 
Bitmap Images. 
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Changing the default picture directory 

When you use the Import Picture command, Express Publisher 
always looks first in the \EXPRESS\ART directory. If you want to 
change the default picture directory, run the install program over 
again and specify a new path. Or, in the Import A Picture dialog 
box, use the files list box to change the path. Express Publisher will 
display the last path used when you next open that dialog box. 

About picture formats In most cases Express Publisher takes care of all the differences 
between the various picture formats so that you don’t have to 
worry about them. However, not every function works with every 
picture type. Some picture types also have different display or 
performance characteristics. 

PCX and ART 

You won’t run into any limitations when using PCX and ART 
pictures. All Express Publisher‘s features and characteristics will be 
normal. 

The only problem you may run into is with color PCX pictures that 
have more than four colors and one plane. Color PCX images will 
be converted to two-color images. PCX images that were originally 
more than two colors may not convert very well (most of the 
picture’s definition will be lost). Whenever possible, create and save 
PCX images as two-color (or black and white) images. To find out 
whether your picture will be usable or not, import it and see what 
you get. 

MacPaint 

Express Publisher can import MacPaint pictures without any 
special conversion process, but this doesn’t mean you can put a 
Macintosh disk in your Tandy drive and expect Express Publisher 
to open the file. You must first move your MacPaint file onto an 
MS-DOS formatted disk. You can do this with a telecommunica- 
tions program, a special Macintosh to PC conversion program such 
as Traveling Software’s MacLink®, or a network that supports both 
MS-DOS and Macintosh computers. 

MacPaint pictures are always a full page in size. In most cases you 
will only want to use a small portion of the original picture. Cut out 
the portion of the picture you want using a compatible program. 
White (or clear) dots take up just as much memory as black dots. 
An 8.5” by 11” picture with a tiny image in the middle uses the 
same amount of memory as a detailed picture of the same size. 
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TIFF 

Scanned pictures (TIFF) usually vary in resolution from roughly 75 
to 1200 dpi. Express Publisher displays and prints the image at the 
device’s resolution. Express Publisher does not support RGB, 
palette color, or grey scaled TIFF pictures. If you’re not sure what 
type of TIFF picture you have, try to import it anyway. Express 
Publisher tells you if the file is incompatible. You can import most 
standard black-and-white TIFF images, regardless of the compres- 
sion technique used when the image was scanned. Color and grey 
scale images cannot be imported. 

You should scan at 300 dpi to maintain the image’s original size in 
Express Publisher. Scanning at higher or lower resolutions will 
cause the images to increase and decrease in size respectively when 
you import the image into Express Publisher. 

TIFF images created by some presentation graphics or draw and 
paint programs appear in reversed colors when imported into 
Express Publisher. You can correct this problem by selecting the 
object and choosing Reverse Colors from the Object menu. The 
image will display and print properly. 

How TIFF files are stored 

Express Publisher does not save TIFF pictures as part of the docu- 
ment. It remembers the name of the picture file and where it was 
loaded from. Every time you open a document that has one of these 
types of picture, Express Publisher reloads the picture file from 
disk. To copy a document to a different system, you must also 
move the graphics files. 

Large pictures There are two limitations to importing large pictures: the physical 
size of your document, and memory. 

You cannot place a picture 9” wide on an 8.5” wide page. When 
you import a picture too large to fit on your page, Express 
Publisher applies whatever scaling factor is necessary to fit the 
entire picture on the page or tells you large PCX images are not 
supported (too many pixels across a page). The scaling factor is 
applied to both dimensions, so the original proportions of the 
picture are preserved. 

If the picture file you want to import takes up more than 64K of 
memory or if you have insufficient RAM to handle the file, 
Express Publisher will replace the picture on screen with a grey 
box that contains the file name. There is no simple way to tell 
how much memory a picture uses; the file size on disk is not an 
indication. You can figure out how many pixels your page width 
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will take: If you have an 8.5" wide page and the screen resolution 
is 80 dpi, the maximum pixel width for images is 680 (80 x 8.5). If 
you get an error message stating that the picture is too large to 
import, make it smaller using the program that generated it. 

A picture, as the term is used in this manual, is a collection of dots 
that form an image. Graphics programs that create these images 
work by turning dots off or on. These programs are frequently 
called paint programs. Your computer stores these pictures by 
saving a map in which dots are on (black) and dots are off (white); 
so pictures are sometimes called bit maps. 

It is important to understand the difference between the objects you 
create by using Express Publisher's own drawing tools, and 
pictures that you import from paint programs. If you were to 
import a picture of a box from a paint program, and draw a box of 
exactly the same size with the box tool, it can be hard to tell the 
difference between the two boxes on the screen. The real difference 
is in how the program creates and stores the information needed to 
present the two images. 

When you draw a box using the Box tool, Express Publisher keeps 
track of this information by remembering the characteristic of a box, 
where the upper left corner of the box is, and what its dimensions 
are. To display an imported picture of a box, on the other hand, 
Express Publisher has to remember where to place every single dot 
that makes up the image. Obviously this uses a lot more memory. 
By using this method, however, it is possible to present much more 
detailed and irregular images. 

What is a picture? 

A box drawn in Express 
Publisher (left), and a 

bit mapped box 

Resolution and print 
quality 

The number of dots per inch (dpi) that compose a picture deter- 
mines its resolution. The more dots per inch, the higher the resolu- 
tion and the better the print quality. 

Express Publisher imports PCX pictures at 80 dpi; it imports TIFF 
pictures at any resolution. The TIFF pictures in our clip art collec- 
tion are either 150 dpi or 300 dpi. 
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You can change the resolution of a picture by scaling it. Making a 
picture larger decreases the resolution, shrinking it increases the 
resolution. For example, if you import a 150 dpi TIFF picture that is 
2” by 2”, scaling the picture by 50% makes the picture 1” by 1”, and 
increases the resolution from 150 to 300 dpi. Express Publisher 
never adds or removes dots from a scaled picture; it simply redis- 
tributes the existing dots to fit the new size. 

The print quality of your pictures also depends on the resolution of 
your printer. You can get bad results if you try to print 300 dpi 
pictures on a printer that can only print at 120 dpi. To get the best 
results, make the picture’s resolution an even multiple of your 
printer‘s resolution. 

When your printer’s resolution is higher than the resolution of your 
pictures, make the pictures smaller to improve quality. If your 
printer can print at 300 dpi you don’t have to settle for 80 dpi 
quality, even if you are working with a PCX file that is 80 dpi. 
Reducing an 80 dpi PCX picture to 27% of its original size increases 
its resolution to approximately 300 dpi. Divide the resolution of the 
picture by the resolution of the printer to determine the best scaling 
factor (80/300 = .2666). 

Changing pictures 

If your printer‘s resolution is lower than the resolution of your 
picture, make the pictures larger. When printing a 300 dpi picture 
on a 150 dpi printer, you get the best results by scaling the picture 
by a factor of 200% (300/150 = 2). 

An imported picture is treated as a single object by Express Pub- 
lisher. It can be modified just like any other Express Publisher 
object. You can move it around by dragging it, and change its size 
by dragging its handles. Pictures can be duplicated, aligned, or 
equated just like any other object. 

Use the Scale command to change the size of pictures. The Scale 
command resizes a picture while maintaining its original propor- 
tions. This ensures that it will not be distorted. 

As explained in ”Resolution and print quality,” the printed quality 
of your pictures can vary depending on the scaling factor you select 
and how it relates to the resolution of your printer. 

Editing pictures 
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Reversing colors The Reverse Colors command on the Object menu creates a nega- 
tive image of any picture. It changes black to white and white to 
black. 

1. Select a picture. 

2. Pull down the Object menu and select Reverse Colors. 

Original picture and picture 
with colors reversed 

Ordinarily when you import pictures they are transparent. You can 
see objects that are within their boundaries in places where there 
are no black dots. 

Transparent and 
solid pictures 

You can use the Specifications command to make pictures solid, so 
that they obscure all objects behind them, or to change a solid 
picture back to being transparent. 

1. Select a picture and choose Specifications. 

Notice that there is no check beside the Filled option. 

2. Click in the Filled check box to change the setting and click OK. 
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5 

Text 

This chapter details all of Express Publisher for DeskMate's text- 
handling abilities. You can create all the needed text for your 
documents inside Express Publisher, or import documents from 
other word processors. Using Express Publisher's formatting 
abilities, you can specify the size and font of any text, change the 
justification of every paragraph, and cause text to flow around pictures. 

Express Publisher can keep track of up to 64 separate stories in one 
document, allowing them to flow from column to column and skip 
pages automatically. There are also many editing and formatting 
shortcuts that make your work go faster and look better. 

This chapter describes the following topics: 

About stories and text frames 
Entering text 
Editing text 
Linking text frames 
Importing text 
Fonts 
Basic text formatting 
Advanced text frame formatting 

Text and pictures 
using styles 

About stories and text frames 

Express Publisher groups and stores text in a way that allows you 
to choose exactly how much of the text is affected by the formatting 
command you give. By using a dialog box, many command options 
allow you to apply the command to a text frame, to a story, or to 
the entire document. The following paragraphs explain how these 
formatting levels work together to produce the final page. 

The most comprehensive formatting level is the document level. 
When you apply a command to the document, all text in the file 
will be affected by the command. 

Documents 
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Stories Whenever you work with a conventional word processor, each 
document you create is a single body of text, or a story as referred to 
in this manual. When you add characters to the middle of the story, 
all the following characters are pushed down the page. If you delete 
a whole paragraph, the rest of the text is pulled back up the page. 

Most word processors can only handle one body of text per docu- 
ment, but an Express Publisher document can contain several 
stories, each one completely independent from the others. 

Express Publisher for DeskMate lets you put different parts of a 
story in different places in a document. When creating a document 
with several stories, you can link a story that starts in a text frame 
on page one to a text frame on page four. The text will flow be- 
tween the linked frames automatically. If you add more text to the 
story on the first page, the rest of the text moves down, flowing 
from page one directly to page four. If you delete a paragraph on 
page one, text is pulled back from page four to fill the gap in page 
one. Other pages in the document may contain different stories that 
remain completely unaffected by the changes in the first story. 

Story capacity 

Express Publisher only allows stories up to 64K and can handle up 
to 64 stories per document. The program tells you if your story has 
reached this limit. If you want to continue adding to the story, you 
will have to divide it into two separate stories. This 64K limit can 
hold a lot of text (up to 30 pages worth), so you will not usually run 
into it. However, you may run up against this limitation when you 
import a word processing document using the Import Text com- 
mand. If you want to import a large file, you will have to split it 
into several smaller files first, using your word processing software. 

All text in Express Publisher is contained within text frames. A text 
frame is simply a box in which you have placed text. A text frame 
can be selected, moved, and sized just like any other object. Any- 
thing that you do to the text frame as an object (such as moving it 

Text frames 
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around in the document) does not change the story within the text 
frame. Think of the text frame as a window through which you are 
viewing the story. Express Publisher always tries to fit as much of 
the story in the text frame as possible, but if the frame is too small, it 
stores the rest of the story out of sight. If you make the text frame 
larger, Express Publisher displays the text that wouldn’t fit earlier. 

If your page layout does not allow you to make the frame large 
enough to display the entire story, you can display the remainder of 
the text in a linked frame. You may need to create several linked 
frames to display all of the text. Additional information about 
linking text frames can be found in “Linking text frames” later in 
this chapter. 

Sample document 
showing types of text 

frames 

Non-linked text frames 

Linked text frames 

Linked text frames 

Applying commands If you apply a command to a text frame, the command affects only 
the text showing in that frame, and not text in linked frames. 

If you apply a command to a story, the command affects all the 
frames that are part of that story, but does not affect unlinked 
frames or other stories in the document 

The following sections explain each text-related function in detail. 

Entering text 

All text in Express Publisher must be entered in a text frame. A text 
frame is no different from any other type of box in Express Pub- 
lisher. You can select, move, and scale, and otherwise change a text 
frame exactly as if it were a regular box. 
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Express Publisher creates text frames for you when you use the 
New command to create a document. You can also create your own 
text frames by drawing them with the Text Frame tool. 

When clicked from within a text frame, the Text tool allows you to 
work with text. You are able to select and modify text, but you 
cannot do anything to objects. When the Text tool is active the text 
pointer looks like an I-beam. 

Follow these steps to enter text: 

1. Click the Text tool. The Text tool 

The pointer changes to an I-beam shape. 

The I-beam pointer 2. Move the pointer to the upper left corner of an existing box and 
press the mouse button. 

A blinking line appears, marking the text insertion point; it is 
usually called a text cursor. 

The text cursor 

3. Type This is eas i e r  than I thought i t  would be, or 

The box is now a text frame. You can move the pointer to a new 
position in the text, or within a different box, and press the mouse 
button to place a new text cursor. 

Express Publisher recognizes the standard text editing keys. 

BACKSPACE deletes the character to the left of the cursor. 
DELETE deletes the character to the right of the cursor. 
INSERT tells Express Publisher to switch back and forth between 
insert and overstrike text entry. Insert means that new characters 
push existing characters to the right; overstrike means that new 
characters replace existing characters. 
LEFT and RIGHT arrows move the cursor in the direction of the 
arrow by one character. 
CTRL-LEFT and CTRL-RIGHT arrows move the cursor to the 
beginning of the previous or next word. 

whatever comes to mind. 

Text editing keys 
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UP and DOWN arrows move the cursor up or down one line of 

PGUP and PGDN move the cursor up or down one screen. 
CTRL-PGUP and CTRL-PGDN move the cursor to the beginning or 

HOME and E N D  move the cursor to the beginning or end of a 

text. 

end of the text in the current frame. 

line, respectively. 

There are other keystrokes useful for various text functions. They 
are explained in the sections relating to those functions. The quick- 
reference card lists all of the text function keys. 

While you are working with text you cannot select and change 
objects. When you want to stop working with text, you need to put 
away the Text tool in order to work with objects again. 

To put away the text tool, click the Arrow tool. 

Or, click the I-beam pointer outside of a box. 

The pointer changes back to the arrow, and you are able to select 
objects again. 

Selecting objects 

The Arrow tool 

Editing text 

Selecting text In order to use many of Express Publisher‘s text formatting com- 
mands, you must first select the text that you wish to change. 
Selected text is always highlighted. 

It is important to understand the difference between selecting text 
and selecting the text frame as an object. When you click a text 
frame with the arrow pointer, you are selecting the text frame as an 
object. You may manipulate a selected text frame like any other 
box, but you can’t change the text within the frame. (Review 
“About stories and text frames” earlier in this chapter if you are 
confused.) To select a block of text you must activate the Text tool 
(the pointer looks like an I-beam when the Text tool is active). Once 
you have selected text you can delete it, cut it, copy it to the clip- 
board, or change its size and font. 

You can select text with the mouse and the I-beam pointer or with 
the keyboard. 
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With the mouse There are several techniques for using the mouse to select text. 

Dragging 

You can drag the mouse across text in order to select it. 

1. Click the Text tool, unless it is already active. 

2. Move the pointer to the beginning of a body of text you want to 
select and hold down the mouse button. 

This marks an anchor point for the area you are selecting. 

3. Still holding down the mouse button, drag the mouse in any 
direction. 

The Text tool 

Selecting text Anchor point 

End point 

Notice that the highlighted area moves with the pointer. 

highlighted. 

Double-clicking 

You can double-click a word to select it. 

Move the I-beam pointer onto a word you want to select and 

4. Release the mouse button when all the text you want selected is 

double-click the mouse button to select it. 

Shift-clicking 

Shift-clicking is useful for selecting very large bodies of text within 
a single text frame. 

1. Move the I-beam pointer to the exact beginning of the body of 

2. Without holding down the mouse button, move the pointer to 

text you want to select and click the mouse to place a text cursor. 

the end of the body of text you want to select. 
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3. Hold down SHIFT as you click the mouse button again. 

All the text between the text cursor and the place where you 
shift-clicked is selected. 

Replacing text You can replace a block of text by selecting it and typing. The 
selected text is deleted and replaced with whatever you type. 

If you ever remove text accidentally this way, you can retrieve it 
from the clipboard by using the Paste command described below. 

The Cut and Paste commands make it easy to move text from one 
place to another in a document. 

Express Publisher does not retain font attributes when you use the 
Cut and Paste commands. 

1. Select the text that you want to place on the clipboard. 

2. Choose either the Cut or Copy command from the Edit menu. 

If you chose Cut, Express Publisher removes the selected text 
from the document and places it on the clipboard. If you chose 
Copy, it places a copy of the selected text on the clipboard. 

Note 

Moving text 

Note 

3. Move the cursor to where you want to place the text. 

Remember that you can only put text inside of a text frame. 

4. Choose Paste from the Edit menu. 

The text on the clipboard is inserted at the current cursor 
location. 

Moving a text frame You can also cut and copy text frames 

Cutting a text frame 

When you cut or copy a text frame, only the frame moves to the 
clipboard. The text moves to the next linked frame. If there is none, 
the text may be deleted. 

1. Click the Arrow tool. 

2. Click the text frame. 

3. Pull down the Edit menu and choose the Cut command. 

If there is another text frame linked to this one, the text moves to it, 
and the frame itself moves to the clipboard. 
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If there is no other text frame linked to this one, a dialog box warns 
you that the text will be lost if you continue. At this point, you can 
choose to cut the frame and lose the text, or cancel. If you still want 
to remove the frame, click the Text tool, select the text, cut it, and, 
for safety's sake, paste it in a new location. Then return to the 
empty frame and follow the steps above to cut it. 

4. To paste the frame, choose Paste from the Edit menu. 

Clear clipboard 

To clear the clipboard, pull down the Edit menu and select Clear 
Clipboard. 

The DeskMate Clipboard is supported for text. You can cut or copy 
text from Express Publisher DeskMate between other DeskMate 
applications. 

Duplicating a text frame 

You can duplicate a text frame. 

1. Click the Arrow tool. 

2. Click the text frame. 

3. Pull down the Edit menu and choose the Duplicate command. 

Note 

The duplicated frame is drawn on top of the original. 

Linking text frames 

Using the Link and Unlink tools, you can establish the manner in 
which stories flow between the various text frames in your docu- 
ment. Remember that stories are completely independent from text 
frames. In linking and unlinking text frames you are merely 
establishing a path for a story to follow. When you create a docu- 
ment with either the one, two, or three column preset options, all 
the text frames are linked together (except for the headlines). 

Follow these steps to link text frames: Linking text frames 

The Link tool 1. Select the Link tool in the toolbox. The pointer changes to the 

2. Move the link pointer to the text frame that you want to be the 

3. Move the pointer to the text frame you want to be the destina- 

link pointer. 

source frame in the linkage and click the mouse button. 

tion frame and click the mouse button. 
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After you click the second text frame, the pointer changes back 
to the arrow. Now if you fill up the first frame with text, text 
flows automatically to the next frame. 

Linking across pages 

You can use the Link tool to link text frames on different pages. 
After clicking the source frame with the link pointer, you may use 
the Next command, or the Go To command to change pages. The 
Link tool remains active as you change pages, Once you are at the 
desired page, click the destination frame. 

Double-click on the Link tool and the Link tool stays active so that 
you may link several frames together at once. The following 
example illustrates this point. 

1. Click the Link tool. 

2. Double-click a text frame with the link pointer to indicate it as 

The Link tool 

the source frame in the story. The Sticky tool icon appears in the 
lower right hand corner. 

3. Click a destination frame. 

Text flows into the destination frame. The pointer remains in the 
linking shape to indicate that the Link tool is still active. 

4. Click an additional destination frame. 

Text flows into the third frame. To deselect the Link tool, select the 
arrow pointer. 

Each text frame can contain only one story. 

You can link or unlink text frames, but the story itself is not affected. 
You can link boxes together before adding text, and then as you add 
text, the text will flow from one frame to the next automatically. 
Text flows between the frames in the order that they were linked. 
You can link text frames across as many pages as you wish, but 
you cannot link a text frame to a frame on a preceding page so 
that text flows to the earlier page. 

Principles of linking 

The More Text marker 

When there is more text in a story than fits in the current frame, 
Express Publisher places a crooked arrow at the lower right corner 
of frame. It is called the More Text marker. 

You can tell that all the text in a story has been placed if the More 
Text marker does not appear in the lower right corner of the last 
text frame of your story. 

The More Text marker 
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Unlinking text frames When you unlink a text frame Express Publisher removes the text 
and redistributes it to the other linked frames that hold the story. 
The text frame reverts to a plain box. 

1. Select the Unlink tool from the toolbox. The Unlink tool 

The pointer changes to the unlink pointer. 

the mouse button. 
2. Move the pointer to the frame that you want to unlink and click 

As soon as you click the frame with the Unlink tool, Express 
Publisher unlinks the text frame, and the text disappears. Remem- 
ber, the story itself has not been changed at all, so you have not lost 
any text. Unlinking a text frame simply removes one of your 
windows from the story. If you link the two frames together again, 
Express Publisher again displays the story text in the frame. 

A quick way to unlink a text frame is to delete it as an object. Just 
select it with the arrow pointer and press DELETE, or choose the Cut 
command from the Edit menu. The text is redistributed to any other 
frames in the story. 

If you try to unlink the only text frame in your document that is 
displaying a certain story, a dialog box appears asking you if you 
really want to do this. A story is lost if it is not displayed some- 
where in the document. 

Unlinking in a long story 

If you have linked several text frames together, unlinking one of the 
frames somewhere in the middle changes the sequence of the other 
frames in the chain. When you remove a frame, Express Publisher 
links the frame that preceded it to the one that came after it. The 
following example makes this more clear: 

1. If necessary, link together three text frames according to the 
instructions above and fill them with text. (It will help you to 
understand the example if all the frames are on one page.) 

Note 

2. Unlink the text frame in the middle of the story. 

All of the text disappears from the middle text frame and is sent 
to the third text frame. Text now flows directly from the first text 
frame to the third text frame. 

The Unlink tool stays active if you double-click the Unlink tool icon. 
You can unlink several frames at once by using the "sticky" tool. 
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Importing text 
Express Publisher can import text from the word processors listed 
below. However, DeskMate Text, DeskMate Q&A, and WordPerfect 
will not preserve bold, italic, and underlined status. 

Microsoft Word (versions 4.X and 5.0) and Microsoft Works 
(versions 1.X and 2.0) 
DeskMate Text 
DeskMate Q&A Write 
Wordperfect (version 4.X and 5.X) 

If you want to import text from a word processor that is not 
supported, you should be able to convert the documents to ASCII 
text files and then load them into Express Publisher. (ASCII stands 
for American Standard Code for Information Interchange. Almost 
every word processor is capable of loading and saving ASCII text 
files.) No text formatting is preserved when ASCII text is imported. 
To preserve paragraphs, you need two carriage returns, back to 
back, between paragraphs. 

Once text has been imported, you can use any of Express 
Publisher‘s text handling abilities to manipulate the imported text. 

Use the Import Text command to import a document from another 
word processor. 

1. Select a text frame for the imported text to flow into. 

2. Select Import Text from the File menu. 

The Import Text dialog box appears displaying all the files in the 
current disk or directory. If necessary double-click a new drive 
or directory in the Files list box until the directory you want is 
displayed. (Double-click “..” to move toward the directory.) 

The Import Text dialog box 

3. Double-click the document you wish to import. 
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Assuming that Express Publisher recognizes the document as one of 
the compatible formats, the text from the imported document flows 
into the text frame. If the frame is linked to other frames, the text flows 
through each of the linked frames until all the text is visible. If a More 
Text marker appears in the lower right corner of the last frame in the 
story, then there is more text in the story. To display it, add and link 
new frames to the story or make the existing frames larger. 

You don’t have to create a text frame ahead of time if you don’t 
want to. Go through the import routine as documented above 
without first selecting a text frame. When Express Publisher 
imports the file it creates a text frame to contain the new story, 
which can then be moved and modified in all the usual ways. 

As long as you choose the correct option, Express Publisher imports 
the file. If you choose the wrong file type, an error message appears. 

You can use the Import Text command to append new text to an 
existing story, or to completely replace it. 

If you choose to append, Express Publisher adds the new text to 
the end of the existing story. The new text does not always 
appear right away. There may not be enough room to display 
the new text in the currently linked text frames, or the story may 
end on another page. 

removes the old story from the document. The new story flows 
into all the text frames that were linked in the old story. 

If you choose to replace an existing story, Express Publisher 

Follow these steps to import text to an existing story: 

1. Select any text frame in the story. 

2. Choose Import Text from the File menu, select a word process- 
ing document from the Import Text dialog box, and click OK. 

The Place Story Text dialog box appears. In addition to the 
options discussed above, you may choose to create a new text 
frame for the imported text. 

The Place Story Text dialog 
box 
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3. Choose the desired placement option and click OK. 

Express Publisher imports text using the default font. To change the 
default font before importing, make sure that no objects are se- 
lected, and that no text cursor has been placed, and then use the 
Choose Font command. Your choice becomes the new default font. 

You can place text from more than one word processor into one text 
frame. 

Note 

Fonts 

About fonts As many as twelve typefaces (Atech FastFonts) can be loaded at 
one time. A font is a complete set of characters, comprising the 
alphabet, numbers, and punctuation, that has a unique design. If 
you're not familiar with what fonts are, notice the difference 
between the characters in the body text of this manual, and the 
characters in the headings. The headings and body text are set in 
two different fonts to make them more distinct from each other. 

Express Publisher can print characters in several fonts and sizes. It 
also changes fonts by adding attributes such as bold, italic and 
underline. These attributes are not mutually exclusive, you may apply 
all of them at once if you wish. The Choose Font command allows 
you to choose the typeface, size, and attributes of any text in your 
document. Express Publisher works with DeskMate fonts: Cobb, 
Marin, and Dixon. (See appendix for a full list of all supported 
Atech FastFonts.) 

Additional Atech Fast Fonts can be obtained using the coupon that 
comes with this manual. They can be installed using the INSTALL 
program. (See the appendix, 'Trouble shooting," for more details.) 

By default all characters are set to plain, meaning that no attributes 
have been applied. You may select plain to remove any attributes 
that were applied earlier. 

Bold, Italic, and Underline are all useful for emphasis. 

You can use the Choose Font command to change existing text or to 
specify a font before you start typing. 

Changing existing text 

The basic procedure for changing the font or attribute of text 
already in your document is as follows: 
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1. Use the Text tool to select the text that you want to change. 

2. Select the Choose Font command from the Text menu. 

The Choose Font dialog box appears. It displays the current 
settings of the first character in the selected text. 

The Choose Font dialog box 

3. Click a font in the Typeface list box. 

4. Click a size in the Size list box. 

The sizes are listed in points. A point is approximately 1/72”. 

5. If you wish to apply any character attributes, click the appropri- 
ate check boxes. 

6. Click OK. 

The selected text is changed according to your specifications. 

Choosing a font before entering text 

You can use the Choose Font command to select a font or attribute 
before you start typing. 

1. Without selecting any text, place a text cursor in a text frame, or 
click the Text Frame tool to open a new text frame. 

2. Select the Choose Font command from the Text menu and click a 
font in the Typeface list box. 

The new font appears when you start typing in that frame. If you 
want to import text into a specific font, follow these steps to 
change the default font. 

When you select some text and then change the font or attribute, 

When you place a text cursor in a body of text, the new charac- 
only the selected text is changed. 

ters you type will have the same font and attributes as the 
characters directly to the left of the cursor. 
Spaces and punctuation marks have fonts just like other characters. 

98 E x p r e s s  P u b l i s h e r  f o r  D e s k M a t e  



The default font is the one that appears when you enter or import 
text in a new text frame without specifying a new font. Unless you 
change the default font, it is Marin 12 point Plain. 

To change the default font, 

1. Make sure that no objects or text are selected, and that there is no 

2. Select a font. 

The default font only affects text that you are typing or importing 
into a new text frame. If you place a text cursor in an existing body 
of text, the characters that you enter will be in the same font as the 
characters to the left of the cursor. You cannot change the default 
font for the predefined, letter, 2-column, and 3-column page 
templates because the font is already specified. To change the font, 
you must first type in something new at the beginning of the story 
and change the font status of those new character. Everything to the 
right of the cursor would then appear in that new selected font. 

text cursor in any frame. 

Note 

Basic text formatting 

The following commands—Justify, Set Frame Margins, and Set 
Tabs-allow you to control how the text appears in a frame as 
opposed to individual characters or paragraphs. You may apply 
these commands to a single frame, every frame in the current story, 
or every frame in the document. 

Justification controls where lines of text are placed in a text frame. 
Express Publisher can justify the text within a text frame both vertically 
and horizontally. Horizontal justification determines how lines of text 
will relate to the right and left margins: left, right, centered, or full. 
Vertically, you may justify text to the top, middle, or bottom of a text 
frame. You may apply both kinds of justification to a text frame. 

The Justify command affects all of the text in a text frame. Later you will 
learn how to change the justification of individual paragraphs using 
Styles. This is covered later under the heading "Using styles." 

To change the text justification of a text frame, follow these steps: 

1. Place a text cursor in the frame you want to modify, or select it 

2. Pull down the Text menu and select Justify. 

Justification 

with the arrow pointer. 

T e x t  99 



The Justify Text dialog box appears displaying all the justifica- 
tion options. The selected horizontal justification icon reflects the 
currently selected paragraph. The selected vertical icon reflects 
the alignment of the current text frame. Each icon shows you 
what it will do to the text frame. 

The Justify Text dialog box 

3. Click a horizontal and/or vertical justification option. 

4. Click OK. 

The Apply Formatting To dialog box appears. 

5. Decide if you want the change to affect the current frame only, 
every frame in the story, or the whole document, and click OK. 

All the text in the frame is justified according to your selection. 

Using Center Justification 

When you select Center justification, Express Publisher centers the 
line between the top and bottom margins of the frame. However, 
because Express Publisher automatically adds a carriage return at 
the end of every line, Center justification places the line just above 
the center of the frame. If you want the text in the exact center, 
move the cursor to the end of the line and press delete to remove 
the carriage return. 

Using full justification 

When you select Full justification, Express Publisher lines up all the 
lines of text on both the left and right margins of the text frames. 
Most books and newspapers are still justified in this manner, but 
recently many publications have begun switching to left justified. 
This is only a design trend, and you can make your own choice. 
However, if you use full justified text frames, you should also take 
time to add hyphens where they are needed to compensate for any 
large gaps between words that may occur. You will need to manu- 
ally add a space after the hyphen to make the word wrap around to 
the next line. 
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Text frame margins Each text frame can have its own left, right, top and bottom mar- 
gins. The Set Frame Margins command controls the margins of 
individual text frames. By default the top and bottom margins are 
0.05”, and left and right margins are 0.125”. All decimal entries must 
be preceded by a leading zero as in the examples in this paragraph. 

The text frame margin setting also determines the amount of space 
between wrapped text and the object it is wrapped around. See the 
section “Text and pictures” for more information on this subject. 

The Set Frame Margins command also allows you to specify an 
indentation for the first line of each paragraph relative to the text 
frame margins. You can enter a negative number to make the first 
line extend beyond the left margin; this is called an outdent. 

This paragraph is an example of a first line 
indent. The first line in the paragraph is automati- 
cally indented; you don‘t have to insert a tab. 

This paragraph is an example of a first line 
outdent. The first line of the paragraph extends 
beyond the paragraph‘s left margin. 

The steps to using the Set Frame Margins command are as follows: 

1. Place a text cursor in the frame you want to modify, or select it 

2. Select Set Text Frame Margins on the Text menu. 

with the arrow pointer. 

The Set Frame Margins dialog box appears. It displays all of the 
current margin settings. 

The Set Text Frame Margins 
dialog box 

3. Enter the desired top, bottom, left, and right margins in the 
appropriate text boxes. If you don’t want to change a certain 
margin, don’t change the number. 

4. Enter a first line indent/outdent to control the placement of the 
first line in each paragraph relative to the frame margins. 

A negative number, such as -.5, causes an outdent. The value of 
the negative number cannot exceed the left margin. 
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5. Click OK when you finish. 

The Apply Formatting To dialog box appears. 

6. Decide if you want the change to affect the current frame only, 
every frame in the story, or the whole document, and click OK. 

If there is no response, and the Apply Formatting To box doesn’t 
appear, check the numbers you entered. If an entry is too large for 
the frame, Express Publisher will not accept the command. 

The Set Tabs command controls tab stops for each text frame. A tab 
stop places the cursor at an exact distance from the left edge of the 
frame. Entering tabs on successive lines creates a column of text, 
with the lines all indented the same distance. You should always 
use tab stops instead of spaces when you want to create a column 
of text or numbers, since inserting spaces does not always produce 
a straight vertical alignment. 

By default, Express Publisher assigns tab stops every half inch, but 
you can set custom tab stops for individual text frames using the 
Set Tabs command. Also, existing tabs can be moved if you want to 
change an indent or a column. 

Express Publisher supports standard left-aligned tabs and decimal tabs. 

Left tabs are the most common type of tab stop. They align the 
left side of a character to a certain horizontal position as shown 
below: 

one 
two 
three 
etc ... 

Setting tabs 

Decimal tabs align characters vertically around a decimal point 
like this: 

1.2324 

.234 
123.42 

854.45 

To use the Set Tabs command, follow these steps: 

1. Place a text cursor in or select a text frame. 

2. Select the Set Tabs command from the Text menu. 
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The Set Tabs dialog box appears. The dialog box displays a ruler 
of the same width as the current text frame. If the text frame is 
wider than the screen, a scroll bar allows you to move the ruler. 
Markers appear on the ruler displaying the current tab stops. As you 
move a tab, your exact position is displayed below the ruler. 

The Set Tabs dialog box 

Once you have activated this dialog box, you may do a number 
of things. You don’t have to specify all of the options if you are 
concerned with only a few. 

3. To create new tabs, select the type of tab you want to create by 
clicking on Left Tab or Decimal Tab. Then move the pointer to 
where you want to place the new tab and click the mouse (do 
not double-click). You can set up to 16 tab stops per text frame. 

4. Drag existing tab stops to move them. Any text that is aligned to 
an existing tab stop is moved along with the tab. 

5. Drag existing tabs all the way off the ruler to remove them. 

6. Once all the options are set, click OK, or cancel the operation. 

The Apply Formatting To dialog box appears. 

7. Decide if you want the change to affect the current frame only, 
every frame in the story, or the whole document, and click OK. 

Note You cannot place tabs in the text frame margins 

Advanced text frame formatting 

Set Line Spacing, Set Character Spacing, and Set Paragraph Spacing 
give you a great deal of control over the spacing of individual 
characters, lines, and paragraphs. They are all under the Text menu. 
All of these commands change entire text frames as opposed to 
individual characters or paragraphs. Each may be applied to one 
frame at a time, every frame in the current story, or every frame in 
the document. 

These functions are optional. You don’t need to worry about them 
when creating basic documents. As you become more familiar with 
Express Publisher, you may want to learn about them to gain 
complete control of your page designs. 
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Paragraph spacing Express Publisher automatically sets the paragraph spacing for the 
fonts you select. If you want your paragraphs further apart, the Set 
Paragraph Spacing command lets you specify an amount of space 
to be added between every paragraph in the current frame, story, or 
document. 

1. Place a text cursor in a text frame, or select it with the arrow 

2. Choose Set Paragraph Spacing from the Text menu. 

The Set Paragraph Spacing dialog box appears. 

pointer. 

The Set Paragraph Spacing 
dialog box 

The space between the A’s shown in the dialog box reflects the 
current paragraph spacing. You can change the spacing by 
clicking the More or Less buttons. The current amount of 
spacing is displayed in the Points text box. If you know the 
amount of spacing you want, you can enter the number of points 
(from -18 to 72 points) directly in the Points text box. 

3. Click the More or Less buttons to change the amount of space 
between paragraphs, or enter the desired number of points in 
the Points text box. 

If you click More or Less, the letter A characters on the side of 
the dialog box shift to indicate the change in spacing. 

4. Click OK. 

The Apply Formatting To dialog box appears. 

5. Decide if you want the change to affect the current frame only, 
every frame in the story, or the whole document, and click OK. 

The text in the frame is reformatted to reflect your choice. 

Line spacing Express Publisher lets you set the exact amount of space you want 
between each line of text. In typesetting this is called adjusting the 
leading. Express Publisher doesn’t limit you to single, double, or triple 
space. You define the exact amount of space you want. 
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Note Don’t confuse Line Spacing with Paragraph Spacing. Line Spacing 
controls the amount of space between every line of text. Paragraph 
Spacing only affects the distance between lines that are separated 
by a carriage return (a carriage return is placed when you press 
ENTER). Paragraph spacing supplements line spacing. 

These steps tell you how to use the Set Line Spacing command: 

1. Place a text cursor in a text frame, or select it with the arrow 

2. Choose Set Line Spacing from the Text menu. 

pointer. 

The Set Line Spacing dialog box appears. 

The Set Line Spacing dialog 
box 

The distance between the A’s shown in the dialog box reflects 
the current line spacing. You can change the spacing by clicking 
on the More or Less buttons. The current amount of spacing is 
displayed in the Points text box. If you know the amount of 
spacing you want, you can enter the number of points (from -18 
to 72) directly in the Points text box. 

3. Click the More or Less buttons to change the amount of space 
between lines, or enter the desired number of points in the 
Points text box. 

If you click More or Less, the letter A characters on the side of 
the dialog box shift to indicate the change in spacing. 

4. Click OK. 

The Apply Formatting To dialog box appears. 

5. Decide if you want the change to affect the current frame only, 
every frame in the story, or the whole document, and click OK. 

The text in the frame is reformatted to reflect your choice. 

Character spacing Express Publisher automatically sets the character spacing for each 
font, but you can increase or decrease the amount of space between 
all the characters in a text frame with the Set Character Spacing 
command. 
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Do not confuse character spacing with kerning. Kerning applies 
only to certain combinations of characters. Character spacing 
changes the amount of space between every character as shown in 
the following paragraph. 

increasing the character spacing can make your page 
designs look more sparse and modern (and difficult to 
read). 

The following steps document the Set Character Spacing command: 

1. Place a text cursor in the text frame you want to modify, or select 

2. Choose Set Character Spacing from the Text menu. 

it with the arrow pointer. 

The Set Character Spacing dialog box appears. 

The Character Spacing 
dialog box 

The space between the characters in the dialog box changes as 
you click the More or Less buttons. The number of additional 
points to be added between each character appears in the text 
box on the right. If you know the amount of spacing you want, 
you can enter the number of points (from -18 to 36) directly in 
the Points edit field. 

between the characters, or enter the desired number of points in 
the text box. 

4. When the right amount of space is between the characters in the 
dialog box, click OK. 

The Apply Formatting To dialog box appears. 

5. Decide if you want the change to affect the current frame only, 
every frame in the story, or the whole document, and click OK. 

Express Publisher reformats the text frame according to your 
selection. 

3. Click the More or Less buttons to adjust the amount of space 
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Using styles 
A style is a group of formatting instructions identified by a single 
name. Styles allow you to instantly apply several formatting 
instructions to a body of text—either to a paragraph or paragraphs, 
or to an entire story. For example, a single style might contain 
instructions telling Express Publisher to make a selected body of 
text bold, centered, and italic. 

Styles can be an enormous time saver and give you dynamic 
control of text formatting. You can set the style and all the text in 
the document controlled by that style will reformat automatically. 

The following styles have been created for you and are included in 
Express Publisher: 

Default styles 

Attributes 
Dixon, 70 pt. Centered, 20 points extra spacing 
Marin, 12 pt., .3” left margin, -.175” 1st indent, 
tabs 
Marin, 12 pt., .5” left margin, -.2’’ 1st indent, tabs 
Marin, 12 pt., .7” left margin, -.2” 1st indent, tabs 

Style Name 
Banner 
Bulleted 1 

Bulleted 2 
Bulleted 3 
Caption Marin, 10 pt., Italic 
Center Centered 
Headline Dixon, 36 pt., Bold 
Left Left justified 
Mouse Type Marin, 8 pt. 
Pullout Marin, 14 pt., Centered 
Quotation 

Right Right justified 
Subhead Dixon, 18 pt., bold 
Text Marin, 12 pt. 

We’ve tried to make the titles of these styles descriptive, but you 
should try them to see exactly what they are. 

Use Bulleted styles to draw the reader‘s attention to a specific item 
or to briefly list important points. 

Marin, 12 pt., Plain, ,0625” left margin, .625” right 
-gin 
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Example of bulleted styles 

Applying styles You can apply a style to a single paragraph or a series of selected 
paragraphs by first selecting the paragraph(s) you want to change. 

Applying a style to a paragraph 

The steps below tell you how to apply a style to a paragraph 

1. Place the text cursor in the paragraph you want to change. 

2. Select Choose Style from the Text menu. 

The Choose Style dialog box appears. 

The Choose Style dialog 
box 

3. Select the styIe you wish to apply and press ENTER. 

Express Publisher reformats the document according to the style 
that you selected. Styles always affect entire paragraphs. This is true 
even when only some of the text in a paragraph is selected, or if a 
paragraph continues in another frame. 
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Note If you apply a style that sets justification, spacing, or margins, the 
corresponding frame-level formatting commands found under the 
Text menu no longer change that text. These commands include 
Justify, Set Tabs, Set Character Spacing, Set Line Spacing, Set 
Paragraph Spacing, First Line Indent, and Set Frame Margins. If 
you want to use one of these commands on a paragraph that you 
previously applied a style to, you can remove styles by selecting No 
Style in the Choose Style dialog box. 

Applying a style to a range of paragraphs 

You can apply a style to several paragraphs at once. 

Highlight the paragraphs that you wish to modify and use the 
Choose Style command. 

The style changes all of the selected paragraphs. 

Removing styles from a paragraph 

If you no longer want a style applied to a specific paragraph or 
story, select the paragraph or story and select No Style from the 
Choose Style dialog box to remove any style that was applied 
earlier. You can apply No Style as if it were a style, using any of the 
methods discussed earlier. 

Text and pictures 

Wrapping text 
around pictures 

Express Publisher can wrap text around pictures. The Text Wrap 
tool changes the left or right margins of a text frame so that the text 
wraps around the picture. 

The procedure for text wrapping is very simple. 

The Text Wrap tool 1. Click the Text Wrap tool. 

2. Click the text frame that you want to wrap. 

3. Click the picture that you want the text to wrap around. 
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Text wrapped around a 
picture 

Express Publisher wraps the text around the picture. If you have 
difficulty selecting the right objects, make sure that the picture is in 
front of the text frame. If necessary, use the Bring to Front or Send 
to Back commands. 

If you do any text formatting within a text frame that has text wrap 
applied, your text wrap will be lost. To rewrap text, reapply Text 
Wrap or move the picture. 

Generally, you should wrap text around pictures after you have 
completed most of your text formatting and layout. 
If you move either the text frame or the picture after wrapping, 
the wrapping is completely undone. 
The distance between the wrapped text and the picture is 
determined by the settings in the Text Frame Margins command. 
To wrap text more closely around an object than it does by 
default, draw another non-printing box or line to delineate the 
existing object, and wrap the text around that new object. 
You may add or remove characters from the text frame, but if 
you use any formatting commands on the Text menu that 
change the spacing or justification of the text lines, you will 
probably have to re-wrap the text. 
Express Publisher cannot wrap text around both sides of a 
picture (if you place the picture in the middle of a text frame). 
If a text frame is too narrow, or if there is not enough space 
between the edge of a frame and a text wrap object, words may 
be split. In such a case you should widen the frame or make 
other adjustments so that there is more space. 

double-click the text wrap icon. 
If you are wrapping a single story around more than one picture, 
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6 

Printing 

Express Publisher for DeskMate offers a number of printing options 
that control the destination and quality of your output. This chapter 
addresses Express Publisher's printing functions and offers some 
advice on how to get the best results. 

This chapter covers: 

Printing a document 
Printingoptions 
Printing issues 

Printing a document 

Before printing a document, make sure that you have selected a 
printer. To choose a printer in Express Publisher for DeskMate, use 
DeskMate Setup available by pressing the F10 key. See your 
DeskMate manual for more information. 

Express Publisher supports all Tandy printers in their emulation 
mode, e.g. Tandy LP 950 laser printer is supported as an HP 
LaserJet Series II printer, Tandy DMP 302 24 printer is supported as 
an IBM XL24 Proprinter, Tandy DMP 240 printer is supported as an 
IBM Proprinter X24, Tandy DMP 134 9 pin printer is supported as 
an IBM Proprinter II, and the Tandy DMP 107 9 pin printer is 
supported as an IBM Graphics printer. 

These instructions tell you how to print a currently open document: 

1. Pull down the File menu and select Print. 

The Print File dialog box appears. 
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The Print File dialog box 

2. Select one of the possible printer destination options. (Discussed 

3. Type the number of copies you want in the Number of Copies box. 

4. Either leave the Print Range default set to All to print the entire 
document or fill in the edit fields From Page: and To Page: to 
print a range of pages in your document. To print a single page, 
set both From Page: and To Page: to that single page number. 

5. Click on Continuous if your printer has automatic paper feed 
and you do not need to change paper type within the document. 
Check Manual if you need to insert pages individually. 

6. Specify the quality of your printing by checking one of the Print 
Quality options. For the Tandy LP950 in HP LaserJet mode the 
graphic resolutions are 300 DPI for high, 150 DPI for Standard, 
and 75 DPI for Draft. The higher the resolution, the longer it will 
take for your document to print. 

7. Click OK or cancel the operation. 

in more detail in the printing options section below.) 

After you have set all the options in the dialog box and clicked 
OK, the Printing Progress dialog box appears. You can press 
ESCAPE to cancel printing at any time. 

The Printing Progress 
message box 

Express Publisher displays the number of the page being printed, 
and how many of the total number of objects on the page have been 
printed. It resets the number of objects printed when a page is 
completed. Some objects take a lot longer to print than others. For 
this reason, the program may stay on a certain count for a long time 
as it prints a large object (especially pictures). During printing, the 
pointer changes to the Tandy busy icon. 
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Printing options 

Express Publisher can print to three different destinations: a printer, 
an ASCII text file and a disk printer file. 

Printer: This option sends the output to the currently selected 
printer at the specified location. This selection takes place in the 
DeskMate Setup. 

ASCII text file: This option prints the text in your document to a 
file on disk; pictures and other objects are not printed. ASCII 
stands for American Standard Code for Information Interchange. 
Almost every word processor can read ASCII text files. They are 
also useful for sending text via modem to be used on other types 
of computers. 

When you select the ASCII Text File option on the Print dialog 
box and click OK, a standard file saving dialog box appears. 
Type a name for the new file and if you want to change the 
default directory specify a location using the files list box. When 
you click OK, the printing routine continues as usual. 

Disk printer file: The disk printer file option sends all the 
information that normally would be sent to your printer to a file 
on disk. You can print the file using the DOS COPY command 
without having to use Express Publisher. This option is useful if 
you do not have a printer installed on your system. Use the 
Choose Printer command to select the correct driver for the 
printer that the document will eventually be printed on. Then 
print the document to a file on your hard disk, copy the file to a 
floppy disk, bring the floppy disk over to the other system and 
print out your document using the DOS COPY command. To 
use the DOS COPY command to print, type COPY /B 
FILENAME.PRN <DESTINATION> where FILENAME.PRN is 
the name of your disk printer file and <DESTINATION> is the 
printer port you are using. For example, COPY /B INVITE.PRN 
LPT1 . 

When you select the Disk Printer File option on the Print dialog box 
and click OK, a standard file saving dialog box appears. Type a 
name for the new file and if you want to change the default direc- 
tory, specify a location using the Files list box. When you click OK, 
the printing routine continues as usual. 
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Printing issues 

This section addresses some of the most common printing issues. If 
you have a question about printing that is not answered below, 
read the ''Trouble shooting" Appendix. 

If you've never used another desktop publishing program, it may 
seem like your documents take a long time to print. Express 
Publisher has to send about a thousand times more information to 
your printer than an ordinary word processor. Express Publisher's 
printing speed is comparable to most other publishing programs 
for the PC. The time it takes to print relates directly to your com- 
puter and printer's speed, the printer's print quality and the 
document's complexity. The best way to speed up printing is to 
improve the performance of your hardware; you can also avoid 
time-consuming printing routines. 

Some printers have memory expansion options that effectively do 
the same thing as a computer-based print spooler. These printers 
can improve their print quality with additional memory. We 
strongly recommend adding memory to your printer if the option 
exists, especially if you plan to use graphics heavily. 

Other suggestions 

You have probably noticed the terms high resolution and low 
resolution used in this manual. Both terms are relative, but they each 
apply to how many dots per inch (dpi) your printer places on the 
page. The more dots per inch, the higher the resolution and the 
better the quality. Since Express Publisher has to tell your printer 
exactly where to put every dot, higher resolution printing takes longer. 

Pictures take a lot longer to print than ordinary objects and text. If 
you just want to see a rough layout of your document, leave out the 
pictures until you are ready to print the final draft, or make them 
unprintable using the Specifications command. 

Express Publisher allows you to place objects anywhere on the page 
regardless of printer margin. Some printers are not capable of 
printing to the very edge of the page. They have nonprinting areas 
of a half-inch at the top and bottom of the page, and a quarter-inch 
at the left and right margins. This can cause objects to be cut off at 
the edges of your documents. Print a test document with a box 
placed at the very top left and bottom left corners. Then measure 
the distance between the edge of the page and where the objects are 
cut off to determine your printer's margins. 

Printing speed 

Printer margins 
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7 

Layout 

Before desktop publishing, page layout was a tedious and demand- 
ing process that was better left to professional designers. Desktop 
publishing programs have made the process much easier, but a 
good sense of design is still required to produce professional 
looking documents. This chapter shows you how best to use 
Express Publisher for DeskMate to create a typical menu and a 
newsletter. It discusses some general design concepts and explains 
how you can use Express Publisher‘s automatic layout features to 
speed up your work. 

This section does not document each procedure referred to. All of 
the features have been documented in previous chapters. It is 
intended only to help you in approaching your work if you’re new 
to page layout and you’re not sure where to start. 

This chapter discusses the following topics: 

Layout overview 
Creating a menu 
Making a newsletter 

Layout overview 

Most graphic artists develop a routine for doing page layout. You 
will probably develop a system of your own as you become more 
familiar with Express Publisher for DeskMate, but this information 
should provide you with a good starting point. 

You should start planning your document by asking yourself two Where to start 
questions: 

Who is my audience? Who are you trying to reach with the 
document? What design will appeal to them? Should you 
challenge them, or do what they expect? Do you want to grab 
their attention quickly with a single thought, or intrigue them 
with some more complex ideas? 
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What am I saying? This question is not as easy to answer as it 
sounds. Without getting into a lengthy psychological discus- 
sion, we all realize that every document has at least two mes- 
sages: literal and visual. The literal meaning is the meaning of 
the text, the visual meaning is a combination of the text‘s 
meaning and the design of the page. Often the visual meaning 
of the page is more important than the text. Artists have de- 
bated between the importance of form and content for centuries. 
But in page layout, the content of your document will not get 
the attention it deserves if the form is confusing or cluttered. If 
you have a clear idea not only of what you are trying to say 
literally, but of the style you want to project, your document 
will have a much more coherent look and feel. 

Making decisions Decide exactly what type of document will best serve your needs: a 
multi-column page, a small card, a hand-out sheet, a form, a letter, 
or something else. Try to anticipate as many mechanical problems 
as you can. Are you going to reduce or enlarge the document after 
you create it, or create it in its final size? You should also take into 
account how it will be distributed. If you’re going to pass the 
document around the office, you don’t need to worry about room 
for an address. If it‘s a flyer that will be posted on walls, it should 
be readable from at least ten feet away. If it will be mailed, you 
should think about how to fold it to fit in an envelope. 

Before you start Express Publisher, it will help you to sketch the 
design of your entire document on paper. This is called creating a 
dummy and you should make several. A dummy doesn’t have to 
look exactly like your page, but is should have roughly the same 
proportions. Think about how many pages you will need, and what 
text will go where. There should be one basic design that applies to 
every page in the document. This will give the document a consis- 
tent appearance from page to page. Keep the dummy nearby while 
you create the actual document. 

Decide what the most important visual element of the document 
you are creating is and plan the design around it. In some cases it 
will be a catchy headline, or perhaps a picture. Look at some 
publications that you think are well designed and without thinking 
too hard about what you’re doing, notice the path that your eyes 
follow as they look at the page. In general, people look at a page 
from upper left to lower right, and they see pictures before they 
read text. The focus of attention is usually on the upper third of the 
page, but not the very top. You can add lines or draw boxes around 
certain items to guide the reader‘s eye, but be careful not to overuse 
this technique or your document will look cluttered and frag- 
mented. 

Sketching your work 

Follow your eyes 
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Hierarchy of ideas Arrange the contents of your document in order of importance. 
Decide exactly how the hierarchy of ideas will be apparent in the 
formatting. If one idea is more important than another, make sure 
that it is more powerful visually. 

This applies most clearly to headings in a newsletter. You may have 
a banner headline in 36 point type. To make that headline stand out 
you shouldn’t use 36 point type anywhere else in the document. 
Space around headlines and pictures will also make them stand 
out. All of the story headings should be smaller but still large 
enough to be headlines, 24 point type for example. You may want 
to have subheadings within stories. These should be the same size 
as the body text or close to it, but in a different font or made bold. If 
you need to distinguish specific text within the story, use italics or 
even upper-case letters. 

Once you have established a hierarchy! stick to it. Don’t put a 24 
point subheading in the middle of a story, it will only confuse the 
reader. At the same time, make sure that the hierarchy is clear in 
the formatting. The reader should be able to tell that he has com- 
pleted one section and is now reading about something new. 

Just because you now have a program that can handle several 
different fonts and bit-mapped graphics doesn’t mean you need to 
use every feature in every document. If you use too many fonts and 
pictures in your documents they will look cluttered and amateur- 
ish, and your readers will think you’re trying to show off your new 
program. 

Documents with plenty of white space are always easier to read 
and more pleasing to the eye. Don’t try to fit too much on one page. 

The fonts, sizes, and styles of text you choose for your document 
have a big effect on your message. Some fonts look friendly and 
warm, while others are serious and professional. Rules are made 
for breaking, but the following is a list of commonly accepted 
guidelines for formatting text: 

The body of your text should be between 9 and 12 point type. 
Anything smaller is hard to read, and anything larger is too 
distracting. 

Use restraint 

Don’t use more than two fonts and three or four type sizes in a 
publication. This manual, for example, uses two fonts and five 
sizes. (We said rules were for breaking - the additional size is 
only for page footers so we can get away with it.) If you need to 
make more distinctions, use bold and italic text. 
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Look for some contrast in the fonts you choose, but also make 
sure they look good together. Make sure that you use the same 
font for the same purpose throughout your document. Use one 
font for every headline, and try not to use that font in the body of 
the text. 

Keep your columns narrow, 24 to 50 characters is the most 
common range. Text columns that contain more than 50 charac- 
ters are sometimes hard to read, depending on what font you 
use. Again, if a column seems fine to you and it‘s 58 characters 
wide, don’t worry about it. 

Be a critic Try to evaluate your work honestly. After you complete the first 
draft of your document, print it out and look at it carefully. It‘s 
much easier to judge it on paper than on the screen. If you think it 
looks great and does what you want it to do, don’t bother with the 
points made below. If you’re not so sure, the ideas below may help 
you to find the problems in your work. 

Clarity 

Remember what your main idea is. If other elements are distract- 
ing, make them smaller, or move them away from the focus of 
attention. 

Balance 

Is one side, the top, or the bottom much more interesting than the 
other? The page should have a focus of attention, but there should 
be an overall sense of balance. Center your most important idea in 
the upper third of the page and distribute the attention-grabbing 
elements equally around the rest of the page. 

Clutter 

Remember, white space is not boring, it helps to emphasize the few 
things that are on the page. Remove anything that is not serving a 
purpose or is redundant. 

Style 

There should be a coherent look to every page. If any elements 
stand out in the wrong way, change or remove them. 
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Creating a menu 

Using Express Publisher, a restaurant can print a new, professional 
looking menu every week that shows all the week's specials. In this 
example you'll create a specials menu for Alexander's restaurant. 

Alexander’s motto is that they like to offer many seasonal specials 
each week. Until recently this meant a large indecipherable chalk 
board, but using Express Publisher and a well designed template, 
the process of designing and printing a new menu takes less than 
an hour, and the menu can be changed easily every week without 
having to start all over. 

In designing this sort of document, determine the parts that are not 
likely to change. These would include the name of the restaurant, 
the title of the menu, the address and phone number, and of course 
the basic design of the document. Taking all this into account, you 
will create a template that includes all the non changing elements. 
This will make it a simple matter to add each week's special 
entrees. 

The design of the menu is very stripped down and modern, in 
keeping with the restaurant's image. The entire document is set in 
the Marin font. This lends consistency to the design. There is plenty 
of white space to make the page elements stand out. 

The picture below shows you what the finished menu should look like. 
You'll find it useful to refer to this picture as you follow the example. 

A menu for Alexander's 
Restaurant created by 

Express Publisher 

Start your work by using the Blank option in the New command. 
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Creating a logo You may want to use another program to create a more complex logo 
that can be imported into Express Publisher. In this example, however, 
we will simply use box frames and a striking font for a logo. 

1. Create a text frame at the top right of the page and type 

2. Be sure the text frame is selected and click the Set Line icon. 

"Alexander's" in 60 point italic Marin. 

Choose the thickest of the line options. 

First part of the logo 

3. Create another box approximately the same size and position it 
slightly above and to the left of the existing text frame. Be sure 
that "Alexander's'' is not covered by the text lines. 

4. Be sure the second frame is selected and click the Set Line icon. 
Choose the thickest of the line options. 

5. If you choose, you can reposition the elements of this Logo in a 
position that is more pleasing to your sensibilities. 

Now that "Alexander's" is positioned the way you want it to 
appear in the finished menu, you can create the rest of the menu. 

1. Create a long narrow text frame with non-printing lines along 
the bottom of the page and type the address in 12 point Marin. 
Insert spaces or set character spacing to spread the text across the 
bottom of the page. 

Laying out the menu 

2. Create a single text frame to fill in the center body of the page 
where the text of the menu will appear. 

The menu template 
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Now you have completed laying out all the non-changing parts 
of the menu. This partially completed menu will serve as a 
template for all other menus. 

1. Pull down the File menu and choose Save As. Type a name for 
the template, select the Template option, and click on OK. 

2. Now use the Open Template command to open the template 
you just saved, it appears as UNTITLED.EPD 

Now all you have to do is type in the remaining text. The rest of 
the text is in 12 point. Each week you need only reopen the 
template you saved and type in the new entrees. 

Making a newsletter 

Producing a monthly newsletter can be very time consuming if you 
have to start from scratch every time. If your newsletter follows the 
same basic format from month to month, a simple template can 
take care of most of the work for you. In this example you will 
become the editor/writer/production department of the Dolores 
Park Association monthly newsletter. 

The Dolores Park Association publishes a newsletter called "The 
Park Watch" every month to keep local residents informed of issues 
that might affect them. Usually there is a feature story, and a 
community calendar. The second page is designed so that the 
newsletter can be folded in thirds and sent through the mail, Using 
Express Publisher's automated layout features and a simple 
template, you can make assembling the newsletter a half hour job. 
This example also shows you how easy it is to align and create 
objects in precise locations with the Snap to Grid feature. 

Park Watch, the Dolores 
Park Neighborhood 

Association Newsletter 
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These instructions assume that the default font is 12 point Marin. If 
you need to reset the default font, read "Choosing a font before 
entering text" in the "Fonts" section of chapter 5. 

1. Select the Create New command from the Page menu and use 
the 3-column preset to create a 2 page document. 

2. Use the Set Grid from the Option menu command to change the 
grid size to .25”, and turn on the grid display. Once the grid is 
displayed, turn on Snap to Grid. 

3. Type the title of the Newsletter in the text frame at the top of the 
page, but leave off the date. Put "The Park Watch" in 48 point 
Marin (see the completed template). 

4. Import the picture AUTUMN.TIF from the \EXPRESS\ART 
directory and place it to the right of the title, as shown in the 
completed template. You may have to scroll to the right with the 
horizontal scroll bar to reach the right side of the document. 

5. To clear space for a headline, drag the top edge of the left and 
center text frames down so that they are three inches from the 
top of the page. Use the tick marks on the vertical ruler for 
reference. 

6. Draw a box for the story headline. The upper left corner should 
be 2" from the top of page, and 3/4" from the left. It should by 
1" high and extend over the first two text frames (see the picture 
of the completed newsletter template). Once you have drawn the 
box, be sure it's line type is non-printing using the Set Line tool. 

Ordinarily/ the feature story takes up the first two columns on 
the front page, and all of the columns on the second page. The 
community calendar goes in the right column of the first page. 
To make your template more effective, you should link the text 
frames in the way that the stories normally flow. When you 
create a document with the three-column preset option, all of the 
text frames are linked together. You must unlink the right text 
frame on the first page in order to separate the community 
calendar from the rest of the frames. 

7. Use the Unlink tool to unlink the right text frame on page one. The Unlink tool 

Now that you have unlinked this frame, the first two frames are 
linked directly to the frames on the second page. You won't have 
to do any special linking when you import the feature story. 

Since the community calendar is a separate story, you should do 
more to separate it from the other story on the first page. 
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The Set Line tool 8. Use the Set Line tool to change the line type of the right text 
frame from non-printing to black. 

The community calendar has the same headline every month, so 
you may as well make it part of your template. 

9. Type "Community Calendar" in the right text frame, and change 
the font to 18 point Marin. 

Adjust in g the 
second page 

Now you're ready to lay out the second page of the newsletter 
template. This involves making room at the bottom of the page for 
the necessary mailing information. 

1. Press CTRL-N to move to page two. 

2. Move to the bottom of the page and drag the bottom edge of 

3. Draw a line along the bottom of the text frames as shown in the 

4. Create a text frame for the return address and enter the address 

each text frame up to the 7.5" grid marker. 

finished document. 

in 12 point Marin. 

5. Press CTRL-P to return to page one. 

You have placed all the unchanging elements of the newsletter, 
now you're ready to save your work as a template. 

1. Select the Save As command from the File menu. 

2. Type PARKWTCH in the File Name field. 

3. Click in the Template option box, and then click OK. 

Saving the template 

The newsletter template 
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Completing the 
document 

To make this example more useful, imagine that a month has 
passed and you’re ready to use the template you saved last month. 
You’ve just finished writing the stories using Word or DeskMate 
Text and you’re ready to assemble the newsletter. To complete the 
document you need only import the stories and type in the date 
and the story headline. 

1. Use the Open Template command to open PARKWTCH.EPT. 

The template you saved earlier appears as an untitled document. 
Start your work by clearing space for a picture. 

2. Drag the top of the center column down so that it is 4.5” from the 
top of the page. 

3. Import the picture HURDLES.TIF from the \EXPRESS\ART 
directory, and place it in the space above the center frame. 

4. Select the text frame on the left and use the Import Text com- 
mand to import the file FEATURE.WPS from the 
\EXPRESS\TEXT directory. 

The text flows through the first two frames directly to the second 
page. Switch to the second page if you want to make sure that it 
is there. 

5. Type “Dolores Park Festival Draws Thousands” into the frame 
for the story headline on page one. Change the font to 30 point 
Marin. 

directory into the frame on the right side of page one. Since the 
frame already contains the headline text, make sure that you 
append the imported text to the existing story instead of replac- 
ing it (the Place Story Text dialog offers you these choices during 
the import procedure). 

7. Type “November, 1992” in the title frame at the top of page one, 
(see the completed document). 

8. Use the Save As command to save your work as NOV92.EPD. 
This name will later inform you which issue of ”The Park 
Watch” is contained in the file. 

6. Import the file CALENDAR.WPS from the \EXPRESS\TEXT 

Your newsletter is now ready for printing. You might want to print 
a quick draft copy using one of the lower resolution options for 
your printer. Use the highest resolution possible for printing the 
final copy. 
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A 

Basic DOS 

If you are new to computers or unfamiliar with some of the DOS 
features referred to in this manual, this appendix is for you. It 
tells you what DOS is and describes 

the difference between computer memory (RAM) and disk 

how you can tell which version of DOS you have 
what a DOS directory is and how to create one 
what a path and a pathname are 
the CONFIG.SYS file 
the AUTOEXEC.BAT file 
RAM-resident or terminate-stay-resident programs (TSRs) 
how to back up your files 

While we strive to give you the latest and most accurate infor- 
mation possible, use your particular DOS manual as the final 
authority for any questions you may have. There are several 
versions of DOS on the market, which differ slightly. 

Any command that you type doesn’t take effect until you press 
ENTER (also called RETURN on some keyboards). 

space 

Don’t worry if what you 
see on your display isn’t 
exactly the same as our 

examples. 

Important 

Basic concepts 

DOS stands for disk operating system, and it is the program that 
controls your computer‘s basic procedures and functions. It’s the 
traffic manager between the different parts of the computer and 
between you and the computer. For example, DOS supervises 
input-output operations — how you get information into a 
computer from a floppy disk or telecommunications program, or 
send information out to a printer or modem. It keeps track of 
your information (stored in files on your hard or floppy disk) 
and implements the commands that you enter. 
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Get into the habit of 
regularly saving your files 

and backing them up on 
disk. 

Disks are permanent storage media. The amount of storage you 
have on your hard disk (usually from 10 to 100 megabytes) and 
on your floppy disks has nothing to do with your system memory 
(RAM). RAM is the working area, like your desktop; disks are 
where you store information, like file cabinets. 

When you turn on your computer, the start-up program takes 
DOS out of storage (floppy or hard) and puts it in RAM. You 
then take whatever application program you want to work with 
out of storage and put that in RAM: This is called loading the 
program. Before you turn off your computer, you must take 
whatever you’ve left in your temporary working space (RAM) 
and save it in storage (on disk). 

To work with most Power Up programs, your computer should 
have at least 512 kilobytes of RAM (and sometimes 640 K). If you 
get an Out of Memory error message, it means the desktop 
doesn’t have enough working space to run your program. To 
check how much RAM and disk space you have, type chkdsk 
from the root or DOS directory (whichever contains the 
CHKDSK.COM or CHKDSK.EXE program) and press ENTER. 

A program (or application) is a series of instructions that tells the 
computer how to perform a specific task or tasks. The program 
works on top of and with DOS. A command is the word that 
starts a program, such as VER or CCPLUS. Commands are 
executable files that you start by typing their first name. 

Your DOS manual or disk will show the version number, such as 
Version 3.30. You can also type ver from the DOS prompt (see 
the following section), and DOS will display the version infor- 
mation, such as IBM Personal Computer DOS Version 
3.30. 

In CCPLUS.EXE, CCPLUS is 
the first name and .EXE the 

extension. The extension 
tells you what type of 

file it is. 

What version of 
DOS do I have? 

To check the version of COMMAND.COM (the DOS command 
interpreter) on your system, type command from the root direc- 
tory of your boot drive (usually C:, but if you boot from a floppy 
drive, type command with your boot disk in the drive.) Your 
COMMAND.COM file should be the same version as your 
version of DOS. 
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Drives, directories, and paths 
DOS displays information in 

uppercase, but you can 
normally type data in either 
uppercase, lowercase, or a 

combination of both. 

The command line or DOS prompt usually shows the drive and 
directory that is active, such as C:\EXPRESS\DOCS>. 

The drive is the unit that rotates the disks and lets you read 
information from or write information on them. A and B are the 
drives into which you insert floppy disks; C is usually the hard 
disk drive (if you have one). If you work on a network, you’ll be 
working with F, G, and other drives as well. When you type in a 
drive name, you always follow it with a colon, as in 

C: 

A directory is an area of storage on the disk, like a folder in a file 
cabinet. It’s a way to organize your disks so that your computer 
can find your information easily. You can further subdivide 
directories into more directories. 
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Type cd\ to move to the 
root directory of the 

current drive. 

To see what directories you have on a disk, move to the root and 
type dir. For example, type dir b : to find out what directo- 
ries are on the floppy in drive B. You can also type dir from any 
directory to get a list of the files it contains. 

The backslash (\) stands for the root directory, like the file 
cabinet itself. To create a directory and subdirectory named 
CCPLUS and DATA, 

1. Type cd\ to move to the root directory. 

2. Type md\ccplus. DOS creates a directory called ccplus. 

3. Now, type cd ccplus to move to that directory. You’ll see 
the DOS prompt C:\CCPLUS>. (If you don’t, skip to ”Dis- 
playing your location,’’ then return to this section.) 

directory to hold all your documents. 

C:\CCPLUS\DATA>. Note that you don’t type a backslash 
because this is a subdirectory off of the current directory, 
which isn’t the root directory. 

4. From the C\CCPLUS directory, type md data to create a 

5. Type cd data. The DOS prompt will change to 

The DOS prompt is also 
called the command line. 

The DOS prompt C:\CCPLUS\DATA> is a path name. It tells 
DOS that you are in the C drive and in the DATA directory off of 
the CCPLUS directory. 

You can transfer files between directories. Let’s say you want to 
transfer a file named MYFILE in the C:\CCPLUS directory to the 
C:\TOP directory: 

1. Move to the CCPLUS directory by typing cd \ccplus 

2. Type copy myfile \top 

That‘s it. DOS copies MYFILE to the TOP directory. 

The CONFIG.SYS file 

When you turn on your computer, the DOS start-up program 
checks for your CONFIG.SYS file and then your 
AUTOEXEC.BAT file to see if you have special instructions. 

If the CONFIG.SYS file exists, DOS executes the commands 
listed in the file. This file tells DOS how your computer system is 

128 E x p r e s s  P u b l i s h e r  f o r  D e s k M a t e  



set up (configured). If you need to set up special software to run 
such devices as printers or expanded memory, this is where 
you’d do it. 

If this manual tells you to change your FILES=x statement to a 
minimum number, enter type config.sys at the DOS or 
root directory of the boot drive to see what your FILES statement 
says. See your DOS documentation for details. 

The AUTOEXEC.BAT file 

If the AUTOEXEC.BAT file exists, DOS goes ahead and performs 
the commands listed in that file. The .BAT extension tells you it 
is a batch file, which means it contains simple, one-line com- 
mands for DOS to execute. Here’s a sample Autoexec file: 

echo off 
prompt=$p$g 
path=c:\;c:\dos 
c:\mouse\mouse.com 
cls 

The first line tells DOS not to display (echo on the screen) these 
commands as they are executed. The second line tells DOS to 
display the path ($p) and the greater-than sign or prompt ($g). 
Check your DOS manual for options. The Path command tells 
DOS where to look for the files associated with the commands 
you enter. The Mouse command loads the mouse driver (the 
program that runs the connection between the mouse and the 
computer). Finally, the Cls command clears the screen so that all 
you see is the prompt. 

You should check your DOS manual for information on how to 
create or modify the AUTOEXEC file. If you have an 
AUTOEXEC file, enter type autoexec. bat from the root 
directory of your boot disk to check its contents. If you don’t 
have one, check your DOS manual or type the following lines at 
the root directory’s command line to create one: 

Make sure to use the Type 
command before creating a 

new AUTOEXEC.BAT file. 
The following commands 
wil l overwrite an existing 

AUTOEXEC.BAT file. 

When you see the word cd \ ENTER 
“ENTER,” press the ENTER copy con autoexec. bat ENTER 

key. echo off ENTER 

prompt $p$g ENTER 
CTRL-Z (hold down the Control key and press z) ENTER 
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The Copy Con command tells DOS to copy the text that follows 
to a file called AUTOEXEC.BAT. Con stands for console, which is 
another name for the keyboard and screen. The CTRL-Z ENTER 
sequence saves your commands as the AUTOEXEC.BAT file. 

Your new Autoexec file won't take effect until you restart DOS 
by pressing CTRL-ALT-DELETE simultaneously. You can also turn 
your computer off and on again. 

You or someone else may have already set up your computer to 
show the directory path (the road to where you are, beginning 
from the root directory). If not, your prompt displays as C>. To 
display the path, type prompt = $p$g at the DOS prompt. DOS 
will display your path until you turn off your computer. 

If you want DOS to show your path every time you turn on your 
computer, you need to add the Prompt command to your 
AUTOEXEC.BAT file, as explained in the preceding section. 

Restarting DOS is also 
called rebooting. 

Displaying your 
location 

Checking for RAM-resident software 

RAM-resident programs 
are also called TSRs for 

Terminate-stay-resident. 

Some RAM-resident programs you may have on your system — 

such as DOS menu programs (shells), print spoolers, disk cache 
utilities, and applications such as SideKick and Lotus Metro — 

use too much RAM or do not work with Power Up programs. If 
you have problems running one of Power Up's software prod- 
ucts, restart your computer from DOS on a floppy disk, so that 
your AUTOEXEC.BAT file doesn't go into effect: 

1. Insert a DOS disk into drive A and close the drive door. 

2. Press CTRL-ALT-DELETE at the same time to restart your com- 

3. The computer will start up from drive A, thus circumventing 

puter. 

any RAM-resident programs normally loaded from the 
AUTOEXEC.BAT file. 

4. Move to the drive and directory containing your Power Up 
program and start it up. See if the problem has gone away. If 
it has, then your RAM-resident software is incompatible with 
the Power Up program. 

5. Check each RAM-resident software you have to see which one 
is incompatible with the Power Up program. 
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Backing up your files 

DOS Copy command 1. If your original data file is on a hard drive, place a formatted 
disk in the floppy drive. (If you aren’t sure how to format a 
disk, consult your DOS manual.) 

If you are running your application from a dual floppy drive, 
place a formatted disk in the second drive. 

2. To copy all the files to a disk in drive A, type 

copy * . *  a: 
If you are copying to a drive with another name, substitute 
that name. 

3. To copy all the files with the same extension to a disk in drive 
a, type 
copy * .ex t  a: 

where ext is the file extension. For example, to copy all of the 
files with a .doc extension, type 

copy *.doc a: 

To copy one file, type the copy command, the file name with 
the extension, and the drive, for example, 

copy lablcopy.lb3 a: 

Restoring a file To restore the file, repeat the process above, but change the 
command slightly. 

1. Place your backup disk in the floppy drive. 

2. To copy all your files from a disk in drive A to drive C, type 

copy a:\*.* c: 

To copy one file, type the copy command, the full path name 
of the backup file name and the drive from which you are 
running the program. For example, 

copy a:\lablcopy.lb3 c: 
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Some DOS commands 

Here’s a short list of useful DOS commands. Be sure to check 
your DOS documentation for updates or warnings about using 
these commands. In most cases, you must be in the directory that 
contains the file you want the DOS command to work on. 

Command What you are telling DOS to do 

cd 

cd.. 

cd\ 

con 

Change from the current directory to the one 
specified, as in cd \express\art 

Move one directory closer to the root 

Move to the root directory 

The console (keyboard and screen), as in 
copy con autoexec.bat 

List all the directories and files in the current 
directory; use with /p  to display one screenful at a 
time, as in dir /p 

Make a directory, as in md \ccplus 

DOS’s name for the printer attached to your 
computer (by default, LPT1) 

Rename this file with this new name, as in 
ren april90.txt april90.old 

Redirect output to another device, such as a 
printer, as in dir > prn 

dir 

md 

Prn 

ren 

> 
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B 

Sample templates 

The following pages show examples of the templates that are 
included with Express Publisher. We’ve filled in the templates 
with artwork and suggestions for the style and pattern of the 
text. You can delete the text and artwork, then use the templates 
as they are or change them to meet your needs. ”Using 
templates” in Chapter 3 provides information about opening 
and revising templates. 
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Agenda Template 
(AGENDA.EPT) 

A. The "Agenda" B. This major heading is in C. Horizontal lines help 
headline is Dixon 36 pt. It Dixon 24 pt. bold text, center- 
is the non-changing text justified. This typestyle 
element on this template. shows up clearly on handouts D, Sub-items appear in 

and overhead projections. 

separate major topics. 

Dixon 18 pt. text. 
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Invitation Temp I at e 
(INVITE.EPT) 

You Are 
Invited 

To View 
New Fall Fashions 

From Our 
Pace Petites Dept. 

Saturday, November 25 
9:00 a.m. 

In Our BayPark Mall Store 

PIease RSVP 
by calling one of our associates in the 

Pace Petites Dept. 
(415) 555-4224 

Coffee, juice, and pastries 
will be served from 9 to 10 

A. This major heading is C. For the invitation D. For additional 
in Marin 36 Pt. bold-italic specifics, we suggest 
text. Marin 24 pt. italic text. 

The text shown here is 
B. Use the drawing tools centered with extra line spacing. 
or paste in clip art to add spacing (6 pts.) for a look 
flair to your invitation. that is classic, yet easy 

to read. 

invitation information, use 
Marin 14 pt. italic text, 
centered with extra line 
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Newsletter 1 Template 
(NEWSLTR.EPT) 

A. This headline is in D. Dixon 12 pt. plain F. The table of contents 
Dixon 57 pt. bold text. text is a clean, easy-to-read can be set apart from the 

typestyle, ideal for body body text by using Dixon 
B. Horizontal lines can add text. 10 pt. bold, italic text. 
definition to headlines. 

C. This major story or paste in clip art to add objects—even other text 

bold, italic text. to your newsletter. visual effect. 

E. Use the drawing tools G. Wrap text around 

heading is in Dixon 28 pt. logos, bullets, and graphics frames-for an exciting 
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Newsletter 2 Template 
(NEWSLTR2.EPT) 

A. This headline is in C. We've created a special E. A line provides a 
Marin 77 pt. plain text. underline effect under the subtle break between 

word Perspective by drawing stories, graphics, and 
B. We suggest Marin 8 two lines, one on each side of issues. 
pt. italic for the volume the lowercase p. 
number, issue number F. Wrap text around clip 
date, and other publishing D. Marin 14 pt. italic text art images for a smooth 
details. with extra line spacing flow of text through your 

helps set off quotes. newsletter. 
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C 

Trouble shooting 

Install problems 

Express Publisher for DeskMate requires DeskMate 3.5. The Install 
program will determine if DeskMate is present in your system or if 
your machine is running some other version of DeskMate and it 
will automatically install the Runtime 3.5 version of DeskMate. 

If the Install program asks whether you want DMFONT.RES 
upgraded, then it has been determined that an incorrect version of 
DMFONT.RES has been found during installation. You can either 
select OK to copy the file, or Cancel and the Install will not copy it. 

Installing Clip Art 

If you want to install all of the 300 dpi or all of the 150 dpi clip art, 
select the appropriate checkbox(es) and the Install program will 
copy the clip art to the art directory. 

InstaIling Fonts 

Copy the Atech FastFont(s) that you want to install into your font 
directory (the default is C:\EXPRESS\FONT). Run install and click 
on the Install Atech FastFonts checkbox. 

The list box on the left lists all of the fonts available in the Express 
Publisher font directory, The list box on the right lists all of the fonts 
that are already installed. 

Install Fonts 

Highlight the typeface(s) that you want to install and double-click. 
Continue highlighting and double-clicking on the typefaces. There 
is a limit of 12 typefaces that can be installed at one time. Click the 
Install button. 

TO properly run Express 
Publisher DMFONT.RES 

should be copied 
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Remove Fonts 

Highlight the typeface(s) that you want to remove and double-click 
Continue highlighting and double-clicking on the typefaces. Marin, 
Cobb, and Dixon cannot be removed. The are required by 
DeskMate. 

Problems starting Express Publisher 

Express Publisher won't start 

Solution 1: Check to see that you are using version 3.0 or later of 
DOS, and that your system meets Express Publisher's hardware re- 
quirements (listed in the introduction). 

Solution 2: See the discussion of memory resident programs in this 
chapter entitled "Memory problems." 

The message “Not enough available disk space to run" appears. 

Express Publisher for DeskMate needs at least 300 K of free disk 
space to run. If there is not enough space, this message appears. 
(This has nothing to do with the amount of space needed to install 
Express Publisher.) The program needs this disk space to make 
temporary working copies of your document while you are chang- 
ing it. 

Express Publisher also uses additional disk space as virtual 
memory, so the more disk space you have free, the better the per- 
formance will be. 

Memory problems 

The message "Not enough available memory to run" appears. 

640K RAM 
570 K or more available RAM 
A CONFIG.SYS file with the statement FILES=20 (or greater) 

Express Publisher requires a minimum of 570 K available RAM, but 
it performs best when 590 K or more is available. 

Your computer should have 640K RAM as its base memory (also 
called conventional memory). To see how much conventional RAM 
is available on your system, type chkdsk at the C:\> prompt (or at 

Note 
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the directory where your DOS files reside) and press ENTER. YOU 
will see a screen full of information about your system's memory. 
The last two lines display your available RAM. For example, 

655,360 bytes total memory (640 Kilobytes) 
528,384 bytes free (516 Kilobytes) 

In this example, there is only 516K available RAM. 

What if I have extended/expanded memory? 

Express Publisher can take advantage of extended or expanded 
memory, but DOS has some restrictions on how this memory can 
be used. Extended and expanded memory cannot make up for a 
lack of conventional memory. 

You can resolve most memory-related problems by changing the 
configuration of your system, thereby making more memory 
available to Express Publisher. 

Configuring your system 

When you start your computer, DOS checks for two files in your 
root directory: CONFIG.SYS and AUTOEXEC.BAT. If it finds these 
files, it executes the commands listed in them. If you don't have as 
much available RAM as you think you should, it may be due to 
commands in these files that load unnecessary utilities, device 
drivers, and memory resident programs (also called TSRs). 

There are two ways to configure your system to make more 
memory available for Express Publisher: 

Edit your CONFIG.SYS and AUTOEXEC.BAT files to prevent 
your system from loading any unnecessary programs. 
Create a DOS boot disk especially for Express Publisher so that 
you can prevent utilities, TSRs, and device drivers from loading 
only when you run Express Publisher. 

Resolving memory 
problems 

See appendix A, "Basic 
DOS," for more information 
about the CONFIG.SYS and 

AUTOEXEC.BAT files. 

Checking the contents 
of your files 

To decide which solution will work best for you, you should first 
check the contents of your CONFIG.SYS and AUTOEXEC.BAT files 
for any unnecessary commands that are consuming valuable 
memory. To do this, 

1. Check to see that your printer is plugged into LPT1, and make 
sure that it is on-line and has paper. 

2. Move to the directory that contains Express Publisher by typing 
cd\express and pressing ENTER. 

If Express Publisher is in a different drive or directory, substi- 
tute that pathname. 
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3. At the C:\EXPRESS prompt, type epsys and press ENTER. 

This sends a file to your printer that lists the contents of your 
CONFIG.SYS and AUT0EXEC.BAT files, the amount of 
memory available, and the version of DOS that you are using. 

4. Use this listing to help you determine the best memory configu- 
ration for your needs. 

First, search the listing of the CONFIG.SYS file for utilities and 
device drivers that are consuming memory. The left column 
below contains examples of lines to look for in the CONFIG.SYS 
file; the right column shows the approximate amount of RAM 
that the device uses. 

Do not delete the FILES=20 DEVICE = ANSI.SYS (1K) 
or the DEVICE=MOUSE.SYS DEVICE=DRIVER.SYS (1K) 
statements; they are neces- INSTALL=C:\DOS\FASTOPEN (2-10K) 

These are just examples. 
,Look for commands that 

load TSR's and device driv- 
ers that you don't use. 

DEVICE=C:\CONNECT\CONNECT.SYS (64K) sary for Express Publisher to 
run properly. 

DEVICE=CPCSCAN.SYS 3e0 2 1 (3-5K) 

Second, search the listing of the AUTOEXEC.BAT file for 
utilities, device drivers, and memory-resident programs that 
consume memory. The left column below contains examples of 
lines to look for in the AUTOEXEC.BAT file; the right column 
shows the approximate amount of RAM that the device uses. If 
you are not sure what your system needs, consult with your 
computer dealer or system administrator for assistance. 

Do not remove your MOUSE PRINT /D:LPT1 (5K) 
APPEND /E (5K) 

(10K) 
GRAPHICS (2K) 
DOSSHELL (40K) 
SIDEKICK (64-200K) 
C:\CONNECT\CCAM 
C: \CONNECT\CCAM.CFG (64K) 
XT (10-30K) 
Net3 (Netware) (55K) 
NC (Norton Commander) (3K) 

statement. It allows your 
mouse to work with Express 

Publisher. APPEND C:\DOS 

Sample system 
configurations 

Use the following system configurations to determine the mini- 
mum requirements for your type of computer. Please note that 
there are many variations of CONFIG.SYS and AUTOEXEC.BAT 
files. Your system may need additional drivers to operate properly. 
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Your mouse driver may ap- 
pear in either file. It is usu- 

640K system 

AUTOEXEC.BAT file and BUFFERS=20 
ally listed as MOUSE in an CONFIG.SYS FILES=20 

MOUSE.SYS in a 
CONFIG.SYS file. AUTOEXEC.BAT PROMPT $P$G 

PATH C:\;C:\DOS 

1MB 286/386 system (640K conventional + 384K extended memory) 

The statements MOUSE 
DEVlCE=HARDRlVE.SYS and 

DEVlCE=DMDRVR.BIN are 
required for some hard 

disks. CONFIG.SYS FILES=20 
BUFFERS=20 
DEVICE=C\EXPRESS\HIMEM.SYS 
DEVICE=SMARTDRV.SYS 256 

AUTOEXEC.BAT PROMPT $P$G 
PATH C:\;C:\DOS 
MOUSE 
SET TMP=[ramdrive letter]:\ 

2MB 286/386 system (640K conventional + 1408K extended memory) 

CONFIG.SYS FILES=20 
BUFFERS=20 
DEVICE=C:\EXPRESS\HIMEM.SYS 
DEVICE=RAMDRIVE.SYS 1024 /E 
DEVICE=SMARTDRV.SYS 256 256 

AUTOEXEC.BAT PROMPT $P$G 
PATH C:\;C:\DOS 
MOUSE 
SET TMP=[ramdrive letter]:\ 

Where to go from If, after examining the contents of your CONFIG.SYS and 
here AUTOEXEC.BAT files, you decide to modify them, follow the 

If you're not sure of which instructions below for doing SO. YOU should modify these files if 
lines to delete, it's a good you find that there are unnecessary programs being loaded into 

are and create a boot disk. 
idea to leave the files as they your system when you start your computer. 

On the other hand, if you have examined your CONFIG.SYS and 
AUT0EXEC.BAT files and found that all of the commands are 
necessary, go on to the next section entitled "Creating a boot disk." 

Making backup copies of your files 

Before proceeding further, you should make copies of your 
CONFIG.SYS and AUTLOEXEC.BAT files. 
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1. At the C:\> prompt, type copy config.sys config.old 
and press ENTER. This makes a copy of your CONFIG.SYS file 
and names it CONFIG.OLD. 

2. Then type copy autoexec. bat autoexec. old and press 
ENTER. This makes a copy of your AUTOEXEC.BAT file and 
names it AUTOEXEC.OLD. 

3. If you ever need to retrieve one of the original files for use, just 
execute the reverse of the command. For example, type 
copy config.old config.sys and press ENTER. After 
rebooting your computer, you will have your original 
CONFIG.SYS file again. 

See "Backing up your files" 
in Appendix A for more 
information on making 

copies of important files. 

Editing the files Follow these steps to edit your files. You may need to consult your 
DOS manual and documentation from other software programs 
that you use, so keep them nearby. 

1. Use the DOS line editor, EDLIN, or your word processor to edit 
the CONFIG.SYS and AUTOEXEC.BAT files. 

Consult your DOS manual for instructions on using EDLIN. If 
you use a word processor, make sure you open and save the 
files as ASCII text files. If you're not sure how to do this, check 
your word processor's manual for the steps necessary to open 
and save ASCII files. 

2. Remove the lines that load unnecessary utilities, device drivers, 
and memory-resident programs. 

Some statements are required to insure that your computer runs 
software properly. Examples are the FILES=20 and MOUSE 
statements that Express Publisher requires. If you are unsure 
about which lines to remove, contact your computer supplier, sys- 
tem administrator, or Power Up Product Support for assistance. 

3. After modifying and saving your CONFIG.SYS and 
AUTOEXEC.BAT files, reboot your computer by simulta- 
neously holding down the CTRL and ALT keys and pressing 
DELETE. Then start Express Publisher. 

Creating a boot disk When you use a boot disk, you bypass your regular CONFIG.SYS 
and AUTOEXEC.BAT files and make more RAM available for 
Express Publisher. Follow these steps to create a boot disk: 

1. Insert a blank disk into the A drive and close the drive door. 

2. At the C:\> prompt, type format a : / s  and press ENTER. Press 
ENTER again when you see the message asking you to insert a 
disk (you did that in step 1). 

3. When prompted to format another disk, press n and then ENTER. 

Note 
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4. At the C:\> prompt, type a: and press ENTER to log on to the A 
drive. 

5. Create a CONFIG.SYS file by typing copy con : config.sys 
and pressing ENTER. 

A blinking cursor appears on the next line. 

6. Type files=20 and press ENTER. 
7. Type buffers=20 and press ENTER. 

8. Press F6 to indicate that you are done creating this file. You will 
see the symbol ̂ Z appear on the screen. 

9. Press ENTER. You will see the message one f i l e  (s) copied. 
Do not remove the disk from the drive. 

10. Reboot your computer by simultaneously holding down the 
CTRL and ALT keys and pressing DELETE. Your computer will boot 
from the disk in the A drive instead of the hard disk. 

After you respond to the Time and Date prompts, you will see 
the A> prompt. 

11. Type c : and press ENTER to log onto the C drive. 

12. Load your mouse driver by typing mouse and pressing ENTER. 

Note The command to load your mouse driver might be different, or 
it may be stored in a subdirectory. If you encounter a Bad com- 
mand or file name error, check your CONFIG.SYS and 
AUTOEXEC.BAT files in your EPSYS printout, or your mouse 
manual, for the proper command(s). 

13. Run Express Publisher from DeskMate as you normally would. 

14. When you are done, label the disk with a memorable name such 
as Express Publisher boot disk. 

When you want to use Express Publisher, simply place this disk in 
your A drive and follow steps 10-13. 

To improve program performance 

If you are using a Tandy 2500XL/2, the machine was configured 
from the factory to run memory between 640 K and 1024 K as 
shadow memory. To improve program performance, run the Setup 
utility (SETUPXL2.EXE) program from DOS. In the setup program 
change the prompt labeled: Use shadow RAM as extended RAM to 
"Yes" and enter 384 K for the amount of extended memory size. The 
file HIMEM.SYS is automatically copied to your program directory 
(C:\EXPRESS) during the installation process. HIMEM.SYS 
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provides an extra 64 K of RAM to be accessed as conventional 
RAM. You should add a statement to your CONFIG.SYS file: 
DEVICE=C\EXPRESS\HIMEM.SYS. 

Problems running Express Publisher 

Mouse problems No mouse pointer appears when you start the program. 

Solution 1: If you have not run the mouse driver required by your 
mouse prior to starting Express Publisher, no mouse pointer will 
appear. Follow the installation instructions that came with your 
mouse. This usually involves running a program named 
MOUSE.COM, or calling a device driver named MOUSE.SYS in 
your CONFIG.SYS file. 

Solution 2: If you have trouble with any mouse that we do not ex- 
plicitly support, you should contact the manufacturer. In many 
cases the problems are due to incompatibilities in the mouse driver 
software. Often a newer version of the mouse driver software will 
solve the problem. 

Express Publisher runs out of memory quickly and works slowly. 

Solution 1: Try to free up more of your conventional RAM, so that 
you have 570 K or more available. Use the Display Settings com- 
mand to turn off to Display Bitmap Images (pictures). 

Solution 2: Add more memory to your computer. Express Pub- 
lisher automatically takes advantage of extended memory and ex- 
panded memory that follows the Lotus-Intel-Microsoft (LIM EMS) 
standard 4.0 or greater. 

You can't select an object. 

Solution: Read "If you can't select an object'' in Chapter 4. 

Objects seem to move on their own when you draw, move, or re- 
size them. 

Solution: Turn off Snap to Grid. Snap to Grid can be on when the 
grid is not displayed. Read "Snap to Grid" in Chapter 4. 

You can't move a very small object. 

Solution: Use the Object Specs command to move the object by 
specifying its placement on the page. Read "Object specifications" 
in Chapter 4, "Objects." 
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The Import Picture dialog box does not display a picture file in 
the \EXPRESS\ART directory. 

Solution: DeskMate can only address up to 255 files in a list box. If 
you exceed this limit, the files are not displayed. Either delete un- 
wanted files, or copy the extra files to a different directory. 

Accumulation of .$$$ files. 

Express Publisher creates temporary work files with the .$$$ exten- 
sion. These files are usually deleted automatically, if they begin to 
accumulate, you may delete them without disturbing the program. 

The printer doesn’t print at all. 

Solution: Check to make sure that the problem is specific to Ex- 
press Publisher; you may not be able to print from any program. If 
you can’t print from any program, you may be having a mechanical 
problem with the printer. Make sure that the printer is turned on 
and properly connected. Also check that your cable isn’t defective. 

Next, free up some memory and try printing again. If you have a 
switchbox, disconnect it and use a single cable to connect the 
printer and your computer. 

If the problem is specific to Express Publisher, check to make sure 
that you have selected the correct printer driver from the DeskMate 
Setup program. 

The printer runs out of memory. 

Solution: This usually occurs on laser printers. In most cases the 
printer ejects the page and displays an error message. Switch to a 
lower resolution graphics mode using the Choose Printer com- 
mand. To print at 300 dpi on an HP LaserJet, the printer must have 
1.5 MB of memory. 

Characters are missing. 

Solution: Express Publisher can create characters (or fonts) up to 
144 points in size. When Express Publisher generates a character, it 
creates a bit-mapped image. Creating and manipulating this bit- 
mapped image can use up a lot of memory. In some cases, the 
image may require too much memory, and Express Publisher will 
not be able to generate it. 

There are several variables that determine how much memory a 
character will require: the print resolution (dots per inch) of the 
printer and the size of the character. 

Printing problems 
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Objects or characters cut off, objects not printing, and extra form 
feeding. 

Solution: All of these problems are due to placing objects outside of 
your printer's print area. The print area is the part of the page that 
your printer is physically capable of printing on. Express Publisher 
allows you to put objects anywhere on the page, even if they are 
outside of your printer's print area. 

Express Publisher can't find TIF pictures during printing. 

Solution: Express Publisher does not store TIF files with the rest of 
the document. It stores only a low resolution version of these pic- 
tures for screen display. At print time, Express Publisher prints the 
pictures directly from the original files on disk. If you move or de- 
lete one of these pictures, or if you move a document to a different 
system, Express Publisher stops during printing and asks you 
where to find the picture file. 

If you move a document file to a different system, you must copy 
all of the TIFF pictures separately. For example, a document named 
DOC.EPD contains a TIFF picture called FLAG.TIF. To move 
DOC.EPD to a different computer, you must copy both DOC.EPD 
and FLAG.TIF onto the other system. 

Directories created by the install program 

The install program creates several directories on your hard disk. 
The table below displays the contents of these directories. There 
may be additional files if you install more fonts or clip art. 

Directory of \EXPRESS 
Express Publisher program files Font 
INSTALL.PDM MSTRFONT.DAT 
EPDM.PDM SLVEFONT.DAT 
EPMDM.PDM 
EPDMHELP.PDM 
EPDM.RES 
EPDM.CL1 
EPDM.CL2 
EPDM.CL3 
EPDM.INI 
EPDMACLN.PDM 
FONTINST.PDM 

Directory of \EXPRESS\FONTS 
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HlMEM.SYS 

Directory of \EXPRESS\DOCS 
Sample templates 

AGENDA.EPT 
INVITE.EPT 
NEWSLTR.EPT 
NEWSLTR2 EPT 

Directory of \EXPRESS\TEXT 
Sample text files for Tutorial and Layout 

CALENDAR.WPS 
FEATURE.WPS 
NEWSLTTR.WPS 
STORY2.WPS 

Directory of \EXPRESS\ART 
Clip art 

AIRPLANE.PCX 
FISH.PCX 
AUTUMN.TIF 
FLAPPER.TIF 
HURDLES.TIF 
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D 

Supported printers 

Included printer 
drivers 

Express Publisher comes with all of the printer drivers listed 
below. The column on the left includes the file names of the 
printer drivers. These file names appear in the Driver Name list 
box in the Choose Printer dialog box. The column on the right 
lists all of the printers supported by that printer driver. This 
table is especially useful if you are using an HP LaserJet with 
font cartridges. 

IBM Graphic IBMM0.PRS 
IBM Graphic Compatible IBMM1.PRS 
IBM Proprinter II IBMM2.PRS 
IBM Proprinter II Compatible IBMM3.PRS 
IBM Proprinter XL IBMM4.PRS 
IBM Proprinter XL Compatible IBMM5.PRS 
IBM Proprinter X24 IBMM6.PRS 
IBM Proprinter X24 Compatible IBMM7.PRS 
IBM Proprinter XL24 IBMM8.PRS 
IBM Proprinter XL24 Compatible IBMM9.PRS 
Tandy DMP 106, IBM Mode 
Tandy DMP 107, IBM Mode 
Tandy DMP 130, IBM Mode 
Tandy DMP 132, IBM Mode 
Tandy DMP 133, IBM Mode 
Tandy DMP 240, IBM Mode 
Tandy DMP 300, IBM Mode 
Tandy DMP 430, IBM Mode 
Tandy DMP 440, IBM Mode 
Tandy DMP 442, IBM Mode 
Tandy DMP 2100P, IBM Mode 
Tandy DMP 2102, IBM Mode 
Tandy DMP 2110, IBM Mode 
Tandy DMP 134, IBM Mode 
Tandy DMP 302, IBM Mode 
Tandy DMP 2103, IBM Mode 

IBMM10.PRS 
IBMM11.PRS 
IBMM12.PRS 
IBMM13.PRS 
IBMM14.PRS 
IBMM15.PRS 
IBMM16.PRS 
IBMM17.PRS 
IBMM18.PRS 
IBMM19.PRS 
IBMM20.PRS 
IBMM21.PRS 
IBMM22.PRS 
IBMM23.PRS 
IBMM24.PRS 
IBMM25.PRS 
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Included printer drivers (continued) 
Tandy DMP 2130, IBM Mode IBMM26.PRS 
Tandy DMP 202, IBM Mode IBMM27.PRS 
Canon BJ-10-E, IBM Mode IBMM28.PRS 
Canon BJ-10e Compatible, IBM Mode IBMM29.PRS 
Citizen 200GSX, Epson Mode IBMM30.PRS 
Citizen 200GSX Compatible, Epson Mode IBMM31.PRS 
Tandy DMP 136, Epson Mode IBMM32.PRS 
Tandy DMP 135, IBM Mode IBMM33.PRS 
Epson FX-850 IBMM34.PRS 
Epson FX-850 Compatible IBMM35.PRS 
Epson LQ-2550 S2.PRS 
Epson LQ-2550 Compatible S3.PRS 
Epson LQ-2550 Compatible S10.PRS 
Epson LQ-850 S17.PRS 
Epson LQ-850 Compatible S18.PRS 
Epson LQ-1050 S19.PRS 
Epson LQ-1050 Compatible S20.PRS 
HP LaserJet LASR0.PRS 
HP LaserJet Compatible LASR1.PRS 
Tandy LP 1000, HP Mode LASR2.PRS 
Tandy LP 950, HP Mode LASR3.PRS 

Printer specific information 

HP LaserJet, HP LaserJet compatible, Tandy LP 1000, and Tandy 
LP 950 can print on most versions of the laser printer at 75, 150, 
and 300 dpi. 

Running out of memory 

Unlike other printers, the laser printer stops printing and ejects 
the page when it runs out of memory. To print a large or com- 
plex Express Publisher document at 300 dpi on the laser printer, 
you must have at least 1.5 Mb of memory expansion installed in 
your printer. If your laser printer displays the out of memory 
error message and prints an incomplete page, switch to a lower 
resolution. 

152 E x p r e s s  P u b l i s h e r  f o r  D e s k M a t e  



E 

Included clip art 

300 dpi images 
All of the following images 

are included with your 
Express Publisher disks. 

They are stored in a 
compressed format. You 

must install them with the 
setup program. Do not try to 
copy them to your hard disk 

with the DOS COPY 
command. (The following 

images have been reduced 
to conserve a little paper.) 

This software allows the 
user to print trademarks and 

service marks which are 
proprietary to their respec- 

tive companies or organiza- 
tions. The inclusion of these 

marks is not intended to 
constitute an endorsement 

of this software by any of 
these companies or 

organizations, neither is it 
intended to signify a 

connection between any of 
these companies or 

organizations and Power Up 
Software Corporation. 

1STPRIZE.TIF AMERFLAG.TIF ATHENS.TIF 

AUTUMN.TIF BARBEQUE.TIF BULLSEYE.TIF 

BUSNESMN.TIF CALCULTR.TIF CHEF.TIF 

COINS.TIF COMPUTR1.TIF COMPUTR2.TIF 

COMPUTR3.TIF CONGRATS.TIF COWBOY.TIF 

All artwork © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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DELIVVAN.TIF FlRSTAlD.TIF FRNCHHRN.TIF 

GOLFING.TIF GRADUATN.TIF HLLYBELL.TIF 

HLLYBRRY.TIF HOMACCTG.TIF HURDLES.TIF 

LADYSEYE.TIF LASSO.TIF INVITATN.TIF 

MACOMPTR.TIF MARIGOLD.TIF MATCH.TIF 

MOVlECAM.TIF NEWSMAN.TIF PISA.TIF 

All artwork © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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PRINTER.TIF PROGOLFR.TIF QUOTES1.TIF 

QUOTES2.TIF QUOTES3.TIF ROSES.TIF 

SNOWFLAK.TIF SPRING.TIF STARTBLX.TIF 

SUMMER.TIF TREE.TIF TREE3.TIF 

TROPHY.TIF TULIPS.TIF TYPWRITR.TIF 

WATERSKI.TIF WEDCAKE.TIF XMASHORN.TIF 

All artwork© 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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150 dpi images 

ALARMCLK.TIF AMEX.TIF ANCHOR.TIF ARROW4.TIF 

ARROW5.TIF ARROW6.TIF ARROW7.TIF ARROW8.TIF 

BASSDRUM.TIF POINTER.TIF BOUQUET.TIF BULLDOG.TIF 

CAUTION.TIF CHEESES .TI F CHKMARK.TIF COFFEE.TIF 

COUPON.TIF COUPON2.TIF CURVROAD.TIF DIVROAD.TIF 

DLLRBIL1.TIF DLLRBIL1.TIF DLLRFIST.TIF DLLRSIGN.TIF 

All artwork © 1976, 1980-1989 SCW Art Services. All rights reserved. 
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DRMAMASK.TIF EAGLE.TIF FIREMAN1.TIF FNCYDRNK.TIF 

HAND1.TIF HAND2.TIF HANDSHAK.TIF JACKPOT.TIF 

MEMO.TIF MSTRCARD.TIF NOTlCE.TIF REDCARPT.TIF 

ROW MACH .TI F SIGAHEAD.TIF SLOW.TIF SNAKTRAY.TIF 

STAR.TIF STOP.TIF STORK.TIF SWlMMING.TIF 

THANKS.TIF TLKTURKY.TIF UMPIRE.TIF USMAP.TIF 

All artwork © 1976, 1980-1989 SCW Art Services. All rights reserved. 
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VISA.TIF WEDCARD.TIF 

All artwork © 1976, 1980-1989 SCW Art Services. All rights reserved. 
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F 

Additional clip art 

This software allows the Clip art adds interest and impact to your documents. If you use a 
user to print trademarks and laser quality printer, such as an HP Laserjet or Deskjet, or a 24- 

service marks which are pin dot matrix printer, you should always use 300 dpi bitmap- 
ped art, like the high resolution images included with Express proprietary to their respec- 

tive companies or organiza- 
tions. The inclusion of these Publisher. Low-resolution 72 dpi clip art prints out rough and 

marks is not intended to jagged, and EPS clip art only works with Postscript printers (not 
constitute an endorsement HP Laserjet or Deskjet type printers). 

of this software by any of 

The best value in 300 dpi clip art that you can use with Express these companies or 
organizations, neither is it 

intended to signify a Publisher is the Express Art/300 packages. These four portfolios, 
connection between any of Business I, Business II, Education, and Special Occasions, each 

these companies or contain over 100 high-quality 300 dpi TIFF images. Because all 
organizations and Power Up Express Art/300 images are 300 dpi, they will push your printer 

Software Corporation. to produce the crispest, sharpest graphics possible, and they can 
be scaled larger or smaller with virtually no loss of resolution. 
And because they are in the industry standard TIFF file format, 
you can use Express Art/300 images with almost every DTP and 
graphics program you may own. 

disk Price “ Product 
Express Art/300, Business I 2446B 2446A $59.95 
Express Art/300, Business11 2448B 2448A $59.95 
Express Art/300, Education 2450B 2450A $59.95 
Express Art/300, Sp. Occasions 2452B 2452A $59.95 

This appendix shows the entire contents of our Express Art/300 
portfolios. You can find them at your local software store, or you 
can order them directly from Power Up by sending a check or 
money order along with the item number of the portfolio you 
wish to the following address: 

Power Up Software Corporation 
P.O. Box 7600 
San Mateo, CA 94403-7600 

Add $4.95 for shipping and handling, CA, MA, NY, PA, and WA 
residents add the appropriate sales tax. 

The following images have been reduced to conserve a little 
paper. 

Note 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Business 1 portfolio 

Business 
Humor 

1STPLACE.TIF CHEMIST.TIF SEWING.TIF BARREL.TIF 

JUDGE.TIF HOG.TIF WORRIED.TIF CRZYDAYS.TIF 

Off ice 
Equipment 

ADDGMACH.TIF CALCTR.TIF TYPEWRTR.TIF CHAIR .Ti F 

PHONE1.TIF PHONE2.TIF FORMS.TIF COFFMAKR.TIF 

COPIER.TIF FILECAB.TIF DESK.TIF WORKSTAT.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Food and 
Travel 

AIRPLANE.TIF ANNVCAKE.TIF BUFFET.TIF 

FLYGCORK.TIF DNRTOAST.TIF COFDONUT.TIF CRUISHIP.TIF 

CAR .TI F VACSCENE.TIF VAN .TI F SUITCASE.TI F 

Business 
Symbols 

ARROW1.TIF ARROW2.TIF ATTACHE.TIF CANDLE.TIF 

CRYSBALL.TIF STACKS.TIF LlTEBULB.TIF KEYS.TIF 

DOLLAR2.TIF TROPHY2.TIF DART1.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Business 
People 

2BIZMEN.TIF BUSRVEW1.TIF LADYPHNE.TIF 

MANOFFCE.TIF MANPHONE.TIF MEETING.TIF 

VISlONRY.TIF TRIOMEET.TIF RATRACE.TIF 

WRHSEMEN.TIF WOMANEX2.TIF WOMANEXC.TIF 

Hands 

FLIPCOlN.TIF FNGCRSS.TIF OKHAND.TIF POINTING .TI F 

REMNDHND.TIF THUMBSUP.TIF WITHCOIN.TIF WITH PAPR.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Industry 
Images 

COMMERCE.TIF CONTSRCN.TIF SHIPPING .TI F 

TELECOMM.TIF RADAR.TIF OlLMlLL.TIF AGRICLTR.TIF 

REFINERY.TIF TRUCKING.TIF TRAIN.TIF 

Office 
Supplies 

SCISSORS.TIF FILEFLDR.TIF COPYPAPR.TIF FILECART.TIF 

STAPLER.TIF INBOX.TIF PENCILS.TIF STPLREMV.TIF ROLODEX.TIF 

BINDER.TIF TAPEDISP.TIF ADMCTAPE.TIF MEMOPAD.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Industry 
people 

BINOCULR.TIF MICROSCP.TIF CONWRKR.TIF RXSYMBOL.TIF 

CADUCEUS.TIF REALTSYM.TIF PUBLISHG.TIF MDRESRCH.TIF 

Mortises 

SWEEPER .Ti F SUNBURST.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Business 2 portfolio 

General 
Headings 

ANNOUNCG.TIF EXTRA!.TIF ' FREE ! .TI F 

GRDOPEN1.TIF WOW!.TIF WELCOME4.TIF 

THANKS2.TIF GRDOPEN2.TIF NEW1.TIF 

WELCOME1.TIF MOVING.TIF 

THANKYOU.TIF NOW .TI F 

Seasonal 
Sale Headings 

AUTMSALE.TIF BLOOMBRG.TIF WTRCLRNCE.TIF 

READYSMR.TIF HOTBUYS.TIF HARVEST.TIF 

SPRGARRV.TIF SUMRSPEC.TIF RAINYDAY.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Real estate 

AGENT.TIF BLNKSGN1.TIF HOMEOWNR.TIF 

HOMESALE.TIF BLNKSGN2.TIF OPENHSE1.TIF 

GATE.TIF OPENHSE2.TIF SOLDSIGN.TIF 

Sale 
headings 

SUPERCPN.TIF TAGSALE.TIF WHSESALE.TIF 

READYDEA.TIF PRCHOPPD.TIF COUPONSV.TIF 

SPECIALS.TIF FINLSALE.TIF 

SALE!.TIF CLEARNCE.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Food 
Headings 

STEAK.TIF MEXICAN.TIF WINE&BRD.TIF SEAFOOD.TIF 

ITALIAN.TIF CHINESE.TIF BARGRILL.TIF 

BURGERS.TIF PIZZABOX.TIF SALADBAR.TIF CAFESIGN.TIF 

Other 
Headings 

DOLLDAYS.TIF PIONDAYS.TIF WILDWEST.TIF FIRESALE.TIF 

Christ mas/ 
Hannukah 
Headings 

BDAYSALE.TIF ANNVSALE.TIF 

MERRYXMS.TIF SESNGRTG.TIF HANNUKAH.TIF 

HAPPYHOL.TIF XMASGOTH.TIF XMASSNOW.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Travel 
images 

LDYSPAIN.TIF CASTLE .TI F RANGER.TIF EIFFTOWE.TIF 

VSPECIAL.TIF CRUISE.TIF GUARD.TIF BEACH.TIF 

VACNEEDS.TIF 

HULAGIRL.TIF JAPAN.TIF BOAT.TIF PLANE1.TIF 

Health and 
money 

Money 

DENTIST.TIF STHSCOPE.TIF DOCTOR .TI F WALKGAID.TIF 

VAULT.TIF CASHREG.TIF PIGGYBNK.TIF HANDFUL.TIF 

TAXDESK.TIF CASH.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Mortises 

$SIGN1.TIF $SIGN2.TIF APPLE1.TIF ARROW3.TIF 

PAINT2.TIF BURST1.TIF COUPON1.TIF BAGNHND.TIF 

GIFTBOX.TIF COUPON2.TIF SPECBRST.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Special occasions portfolio 

Christ mas 

CANDLE.TIF SNOWMAN1.TIF GIFTS.TIF TREE1.TIF 

TREE2.TIF STOCKING .TI F XMASCENE.TIF 

SANTA1.TIF SANTA2.TIF SANTA3.TIF SANTA4.TIF 

SANTA5.TIF SANTA6.TIF CAROLING.TIF 

Patriotic 
Holidays 

HORSE1.TIF WREATH.TIF MARTKING.TIF LABOR.TIF LINCOLN.TIF 

COLUMDAY.TIF CANFLAG.TIF WASHING1.TIF WASHING2.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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New Year 
Thanksgiving 

and Halloween 

Halloween 

NWYRBABY.TIF CHAMPGNE.TIF CHINENYR.TIF PARTYHAT.TIF NYEARELF.TIF 

GHOST.TIF WITCH.TIF TRICKTRE.TIF 

PUMPKIN1.TIF PUMPKlN2.TIF SCRCROW2.TIF 

Thanksgiving 

CORNACOP.TIF PILGRIM .TI F TRKYDINR.TIF TURKEY1.TIF 

Other 
Holidays 

APRLFOOL.TIF CUPID.TIF VALENTIN.TIF FATHER1.TIF 

FATHER2.TIF MOTHER1.TIF MOTHER2.TIF LEPRECHN.TIF CLOVER.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Special 
Themes 

CARNIVAL.TIF CIRCUS .TI F OKTBERFS.TIF 

ANTIQUE.TIF 

BEERBUST.TIF MASQRADE.TIF PARADE .TI F 

CINCO.TIF BELL.TIF HAYRIDE .TI F ICECREAM.TIF 

CASINO.TIF WESTERN.TIF PICNIC.TIF VACATION.TIF 

Music 
and Party 

CONDUCTR.TIF ROCKGRP.TIF BIGBAND.TIF JAZZGRP.TIF 

COCKTAlL.TIF PARTY1.TIF BARBRSHP.TIF WESTNGRP.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Family 
Events 

WEDBELLS.TIF ANNIVSRY.TIF BALLNS.TIF BDAYCAKE.TIF 

GRAD1.TIF BABYBOY.TIF NEWBABY.TIF WEDCAKE.TIF 

BABYGIRL.TIF GRADUATN.TIF 

Religious 
Events 

NATIVITY.TIF BUNNY1.TIF BUNNY2.TIF EASTREGG.TIF 

CHANUKAH.TIF PRIESTHD.TIF HORN .TI F 

CROSS .TI F 

SHALOM.TIF EASTRLLY.TIF MINORAH.TIF PROPHET.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Borders 

WNTRMORT.TIF SPRGMORT.TIF 

SUMRMORT.TIF FALLMORT.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Education portfolio 
School 

symbols 

APPLE.TIF GLOBE.TIF LUNCHTRY.TIF 

SUPPLIES.TIF CLOCK.TIF BIKE .TI F 

PENCIL.TIF 

PENClL1.TIF DONFRGET.TIF 

School 
supplies 

PAINT.TIF MARK.TIF SHARPENR.TIF 

BOOKSTAC.TIF 

STAPLER.TIF TOOLS.TIF CRAYONS.TIF 

BINDERS.TIF PUSHPINS.TIF TAPE2.TIF NTBKRULE.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Students 

READING.TIF SCHOOL2.TIF 

LUNCH1.TIF 

3STUDENT.TIF 2STUDENT.TIF GIRLBOY.TIF 

CLASS2.TIF CLASS1.TIF 
School 

Personnel 

TEACHER2.TIF PRINCPAL.TIF 

BUSDRVR.TIF 

NURSE.TIF JANITOR.TIF POLICE.TIF 

PATROL.TIF TEACHER1.TIF FIREMAN.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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School 
events 

GRAD2.TIF CARWASH.TIF 

PROM1.TIF PROM2.TIF 

SCHLRING.TIF GRAD3.TIF HOTDOG.TIF HMCOMING.TIF 

Theater 
and music 

ACTOR .TI F CLPBOARD.TIF 

JESTER.TIF 

6ANDPLYR.TiF DIRECTOR .TI F 

TRUMPET.TIF 
GRLPIANO.TIF DRUMS.TIF 

MINIBAND.TIF VIOLIN.TIF CLEF.TIF 

All artworkcopyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 

A d d i t i o n a l  c l i p  a r t  177 



Clubs 

Cartoon 
Animals 

ARTCLUB.TIF DANCECLB.TIF PHOTOCLB.TIF 

SCOUTS3.TIF SCOUTS4.TIF 4HCLUB.TIF CHESSCLB.TIF 

SCOUTS1.TIF SCOUTS2.TIF 

BIRD.TIF LION.TIF NUT.TIF 

RAIN.TIF OWL.TIF BEAVER.TIF 

FISH .TI F MOUSE.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Female 
Athletes 

SOCCER1.TIF SKIING.TIF 

CHEERLDR.TIF GRLBASKT.TIF 

GlRLGYM.TIF RELAYRAC.TIF GRLTENNS.TIF DIVING.TIF 

Male 
Athletes 

HURDLER.TIF TOUCHDWN.TIF BOYSOCCR.TIF 

BOYGYM.TIF 

WRESTLNG.TIF BOYSWIMG.TIF 

BOYVLLEY.TIF HOMERUN.TIF BOYBSKT.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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sports 
equipment 

WHISTLE .TI F SOCCER.TIF FOOTBALL.TIF 

BSKTBALL.TIF BBALEQIP.TIF 

TENNIS.TIF GOLF.TIF 

Mortises 

BINDER1.TIF MEGPHONE.TIF 

BLKBOARD.TIF SCHHOUSE.TIF 

All artwork copyright © 1976, 1980-1989 SCW Art Services Inc. All rights reserved. 
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Additional fonts 

Adding fonts to your system dramatically increases your design 
options. Atech’s FastFonts are compatible with your system. 
These fonts: 

are scalable from 6 to 144 points 
display clearly and accurately on the screen 
support bold, italic, bold italic underline, monospace, small 
cap, superscript, and subscript attributes 
can print on any supported printer. 

The following fonts are available from Atech: 

“Aaron” “Bach” “Cabel” 
“Abbot” ”Bas Relief” “Cairo” 
”Alexader” ”Basilica” ’‘Calculator” 
“Allegretto” “Basken” “Calico” 
“Alphabits” ”Basque” ”Campfire” 
“Alpine” “Baxter” “Carolian” 
“Amerigo” “Bengal” “Caslonic” 
“Amy“ “BengalGothic” “CaslonicAntiqu” 
“Andre” “Benjamin” “Cassius” 
“Antigua” ”Berkshire” ”Casual” 
“Aquarian” ”Berliner” “Cello” 
“Aquarian2” “Bernhardt” “Centurion” 
“Archetype” ”Bernice” “CenturionOld” 
“Articulate” “Bethel“ “Chancy” 
“AtechBrush” “BigApple” “Chandon” 
“Augustus” “BigTop” “Chauncy2” 
“AugustusInline” “Blimp” “Cherub” 
”Aurora” “Blimp2” ”Chimpanzee” 
“Autograph” “Bockloo” “Claire” 
”Baccarat” “Boone” ”Clearsight” 
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“Cleopatra” ”Grizzled” “Minstrel” “Savant” 
”Clips” “Gusto” ”Mixer” “Scanman” 
”Cobb” “Hancock” “Moderna” ”Senator” 
“Colt” ”Harmony” “Mozart” ”Show time” 
”Comics” ”Harpoon” “Neville” ”Sicilian” 
“ComicsTwo” “HarrietPlain” “Newland” “Silicon” 
”Contempo” ”Header” “News” ”Singapore” 
“CoopBlack” “Helvetian” “Newton” “Slavic” 

”Cygnet” “Hemlock” “NouveauCaps” ”Stampede” 
”Cymbal” “Hemlock2” ”Nova” “Steeler” 
”Delphi” “Hieroglyph” ”Oakland” ”Stencil” 
“Denver” “Hoffman” “Ocra” “Stile” 
”Ding Dong” “Improv” “OldGerman” “StixHairline” 
“Dingbat” “Indio” “OliveOil” “Stockton” 
“Dingbat3” ”Industry” ”Omnibus” “Sultan” 
“Dingbat2” ”International” ”Organdy” “Sunnyvale” 
”Dixon” “Isabella” “Oxford” ”Symbol” 
“EastSide” “Ivanhoe” ”Painter” ”Taipei“ 
“Elektron” “Jackal” “Palermo” ”Thinline” 
“Eros” “Jamul” “Palomar” ”Titanic” 
“Espresso” “Karina” ”Palomino” ‘‘Tooled” 
”Esther” “Karneval” ”Parker” ”Toons” 
”Eureka” “Keepsake” “Parsec” “TopHat” 
“Evian” “Kiki” “Patagonia” “Triumpf” 
”Excellence” “KingTut” “Pershing” “Twickenham’’ 
“FatCat” “LaCosta” “Pinon” “UltraSlim” 
“Fazer” ”Leaf” “Plate” ”Underwood” 
“FazerShadow” “Leeward” “Plenty” “Universal” 
“Finale” “Letterman” ”Prospector” “Us her” 
”Finch” “Linden” “Providence” “Valencia” 
”Florence” “Lubbock” “ProvLite” “Vesuvius” 
“Freedom” “Lynx” “Quincy” “West Side” 
“Fritz” ”Madrid” “Quotient” “Windmill” 
“Futurist” “Marin” ”Ramalama” “Wire” 
”Gallant” “Marina“ “Ramalama2” “Yarnada’’ 
”Galleria” “Marlowe” “Rancho” 
“Gamelan” “Martini” ”Reno” 
”Gargoyle” ”Maryland” “Repo’’ 
”Gaucho” “Mechanic” ”Robot” 
“Geos” ”Melon” “Rotunda” 
“Gilligan” “Memo” “Saloon” 
“Gilly” “Merced” “SanDiego” 
”Got ham” ”Mettle? “Sandstn” 
“GothamDark” “Miami” “SandstoneSans” 
”Graduate” “MiamiEngraved” “SandstoneSerif” 
“Grannick” ”Micro” “Santee” 

“CutOut” “Hemet” “Norse” ”Squish” 
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Glossary 

The symbol in the directory structure that indicates the parent 
directory, which is one level above the current directory. For 
example, in the directory structure C\Express\Art, Express is the 
parent directory of Art, and C \  (the root directory) is the parent 
directory of Express. 

A file with an extension of $$$ is a temporary file that was written 
to your hard disk. When using Express Publisher you can erase 
these files. 

The beginning point when using the drawing tool to draw an 
object. 

The mouse pointer used in Express Publisher to select objects. 

$$$ file 

anchor point 

Arrow pointer 

art See graphics file format. 

ASCII A standard code for representing characters as binary numbers. An 
ASCII text file is a basic text file that can be read by virtually any 
software application. 

An enhancement such as bold or italic added to a particular font (a 
typeface in one size) that changes how it looks. 

A batch file that a DOS computer runs automatically upon start-up. 
This file can be used to instruct DOS to handle some basic functions 
such as setting paths, and displaying the prompt, date, and time. 

The number of blank points between individual letters, punctuation 
marks, numbers, and symbols. See also kerning. 

To position the pointer on something, then press and quickly 
release the mouse button. 

Graphic images that are stored in a file format that a computer can 
read. 

A temporary storage place for text or graphics. Access the clipboard 
through the Cut, Copy, and Paste commands. 

The symbol indicating the insertion point for text. In Express 
Publisher, this is also called the I-beam pointer. 

attribute (font) 

AUTOEXEC.BAT 

character spacing 

click 

clip art 

clipboard 

cursor 

G l o s s a r y  183 



Cut command To remove a selected object or body of highlighted text from your 
document. The deleted item is moved to the clipboard. 

An assumption that is made unless specific instructions to the 
contrary are given. For example, if you start Express Publisher 
without specifying a file to work with, it defaults to a new one 
page, one column, blank document. 

A pop-up window that requests information, contains user- 
adjustable settings, alerts you to problems, or presents options. 
Normally you must respond to the dialog box by accepting the 
options or cancelling the action. 

A location on disk where any number of files are grouped together. 

A file that has intercepted all of the information normally sent to a 
printer when printing a document. This enables you to actually 
print your document at a different time without running Express 
Publisher, by sending the disk printer file to a printer with the DOS 
Print command. 

(Disk Operating System) The software that handles all communica- 
tion between your computer hardware and your application 
software. 

A printer that forms letters and graphic images by printing patterns 
of tiny dots. 

To click the mouse quickly, twice in succession. This is one way to 
select a file to be opened. 

dots per inch. See also resolution. 

The act of holding down the mouse button while moving the 
mouse. Drag the mouse over a body of text to select it. 

A mouse pointer that looks like a pencil; it indicates that the 
drawing functions are enabled. 

The key that can sometimes be used to cancel a command. For 
example, when printing, press ESCAPE to cancel the print job. 

To transfer data with certain characteristics intact from one pro- 
gram so that it can be used in a different program. 

Optional characters (up to three) after the period in a DOS filename. 
The extension often indicates the file type. 

default 

dialog box 

directory 

disk printer file 

DOS 

dot-matrix printer 

double click 

DPI 

dragging 

drawing pointer 

Esc key 

export 

extension 
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font A complete set of characters in one size, face and style. 12 point 
COBB italic is a font; COBB is a typeface. See also typestyle, typeface. 
Fonts (or typefaces) are either serif or sans serif. 

serif A fine line finishing off the main strokes of a letter. This letter 
A has serifs at the bottom; this letter A does not. 

sans serif A typeface without serifs. 

Keys along the top or left-hand side of a keyboard that begin with F, 
such as F1. These keys have particular tasks assigned to them 
within a software application. 

The arrangement or layout of graphics data on disk. Software 
applications that produce pictures usually create data using one or 
more of these common formats. Express Publisher supports the 
following graphics file formats: TIFF, PCX, ART, and MAC. 

The vertical and horizontal points on screen that help you align 
objects. When Snap To Grid is on, Express Publisher aligns any 
object that is drawn or moved to the closest grid marker. 

The space between two columns of text. 

The cursor that indicates that Express Publisher is in text mode. 

A graphic representation of an object or a concept. 

To bring data, with certain characteristics intact, from the program 
into the application you are currently using. 

An abbreviation for kilobyte, as in 135K. 

The number of points between lines (line spacing). 

A type of dialog box that presents choices in a list format. You use 
the scroll bar to view the list of choices, select the item(s) you want 
with the mouse, and click OK. 

One thousand kilobytes (1000K). 

The horizontal strip at the top of the screen that contains the menu 

function keys 

graphics file format 

grids 

gutter width 

I-beam pointer 

icon 

import 

K 

leading 

list box 

megabyte (MB) 

Menu bar 
options. 

Message line The horizontal strip at the bottom of the screen that contains 
pertinent information on the current action. 
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more text marker An arrow at the bottom of a text frame indicating there is more text 
in the story than will fit in the frame. 

A special input device connected to the computer that rolls along 
the desktop and controls cursor movement. 

The software that allows your mouse to communicate with your 
computer. 

(Also hanging indent) An indent that hangs out to the left of the 

mouse 

mouse driver 

outdent 
margin. 

paragraph spacing The line spacing between paragraphs. When you set paragraph 
spacing for text, you are setting the amount of extra space that will 
be inserted after the carriage return. 

To place something from the clipboard into your document. 

The route that shows the way from the disk's root directory to some 
other location (subdirectory) on the disk. For example, if EXPRESS 
is a subdirectory off of the root of drive C, the pathname is 
C:\EXPRESS. 

Paste 

pathname 

PCX See graphics file format. 

pica 

point 

A unit of measure. One pica is equal to twelve points. See point. 

The printer's basic unit of type measurement, approximately 1/72 
of an inch. 

The area on the outer edge of the page where the printer will not printer margins 
print. 

printer port The plug in the back of the computer where you connect the printer 
to the computer. LPT1, LPT2, COM1, and COM2 are the most usual 
ports. 

print spooler A temporary storage place for information being sent to the printer. 
The print spooler holds information while the printer is busy 
processing something else. 

A symbol that signals to the user that the computer is ready to 
receive input. 

The computer’s temporary memory, it functions only when the 
computer is on (as opposed to hard disk memory). A software applica- 
tion is loaded into RAM upon start-up. Any changes you make to a 
document are stored only in RAM until you save the document on disk. 

prompt 

RAM 
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reboot To restart a computer. To reboot, simultaneously press CTRL-ALT- 
DELETE. 

The number of dots per inch (dpi) used to represent graphics or 
text. 

resolution 

sans serif See font. 

scroll bar The shaded rectangle on the right side and bottom of the Express 
Publisher screen. Click the scroll bar to move to the corresponding 
part of the page. Or drag the thumb (the white box) to scroll to a 
different section of the page. You can also click the arrows at either 
end of the scroll bar to move in that direction. 

serif See font. 

Style A group of formatting commands saved under one name, which 
can then be applied to multiple paragraphs. 

A file that contains the basic page elements of a document that you 
produce regularly, like a newsletter. The template is your starting 
point, but you use Save As to save it as a regular document and 
produce the newsletter. 

template 

text cursor See I-beam cursor. 

thumb The black box on the scroll bar that you can drag to quickly move to 
a different part of the page. 

TIFF See graphics file format. 

typeface 

type size 

typestyle 

A named type design, such as Marin. 

The size of type in points (10 point). 

The font attribute applied to a particular typeface, such as bold or 
italic. See also font. 

Also known as global filename characters, wild card characters 
such as * and ? give you a method of specifying part of a filename 
so that several files may match the specification. See your DOS 
manual for more information on wildcard characters. 

wild card characters 
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Index 

A 
accelerators 8 
adding 

art 23, 78 
pages 42, 56 
pictures 44 
text 34, 95 

aligning objects 40 
anchorpoint 17, 62 
Arrowtool 12, 30, 63, 89 
art 

ART pictures 80 
MAC pictures 80 
PCX pictures 80 
resolution 82 
TIFF pictures 81 

ASCII files 95 

B 
Banner (style) 107 
bitmap 82 
Box tool 16, 62 
boxes 

drawing 62 
stretching 20 

Bring to Front 
command 22, 65 
Bulleted (styles) 107 
Busy icon 5 

C 

Caption (style) 107 
Centered (style) 107 
centering (text) 99 
centimeter 58 
changing fonts 97 
changing objects 20 
character spacing 105 
Choose Font command 28, 97 
Choose Printer command 11 1 
Choose Style command 36 
choosing options 6 
Clear Clipboard 77, 92 
clicking 4 

clip art 78 

clipboard 30, 76 

menus 7 
document 59 

colors, reversing 84 
columns 47 
commands 6, 87 

insufficient memory 79 

closing 

selecting with keyboard 7 
selecting with mouse 6 

CONFIG.SYS xi 
Copy page command 56 
copying 

clip art x 
objects 77 
pages 56 
text 91 

Create New command 56 
cursor 26 

moving with the arrow 

moving with the mouse 27 
movement 27 

keys 27 

Cutcommand 30, 76, 91 

D 

defaults 51 
line type 68 
settings 8 
style 107 

Delete command 57 
deleting 

objects 22 
deselecting 

objects 17, 64 
text 29 

dialog boxes 8 
checkboxes 8 
control keys 10 
editfields 9 
icons 10 
listboxes 9 
radio button groups 9 

dimensions 75 

directories xi 
ART 51 
changing 11 
default 51 
DOCS 49, 51 
TEXT 51 

diskspace x 
displaying 

bitmap images 58 
command 58 
hidden objects 59 

document window 3 
documents 13, 85 

creating 33, 47 
opening 51 
printing 111 
saving 36 

closing 59 

double-clicking 4, 29, 90 
dragging 4, 19, 90 
drawing 17, 62, 74 

tools 17 
Duplicate command 78 
duplicating 

E 

editing text 88 
elevator 4, 5 
Elvis 84 
endpoint 17 
Equate tool 72 
exiting 25, 46 

F 
files. See also documents 

textframe 92 

extensions 52 
names 3, 52 

illegal 50 
File Name text box 49 
File Utility dialog boxes 11 
fills 21 

changing 66 
flowing text 92 
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fonts 97 
changing 29, 97 

formatting levels 85 
function keys 7 

G 

getting started 15 
Go to Page command 55 
graphic images. See clip art 
grid 73 

H 
handles 18, 63 
hard disk x 
hardware requirements x 
Headline (style) 107 
Help Index 14 

I 
Import Picture 

Import Text command 34, 95 
inch 58 
Install program x 

modifying xi 

J 

Justify Text command 99 

L 
layout 115 
leading 104 
leaving Express Publisher 59 
Left (style) 107 
line 

changing 67 
moving 20, 69 
spacing 104 
white and non-printing 68 

snap to 74 

command 23, 78 

Line Spacing command 105 
Link tool 43 
linking text frames 43, 87, 92 
loading Express Publisher 2 

M 
MAC (MacPaint) pictures 80 
margins 

printer 114 
text frame 101 

installation and RAM vs. 
memory 

diskspace x 

menu 
bar 3 ,  6  
closing 7 
options 3 

Messageline 3 
More Text marker 31, 93 
mouse 4 
Mouse Type (style) 107 
moving 

between pages 55 
cursor 27 
in the document window 5 
lines 20, 69 
objects 19, 68, 74 
pictures 24 

N 
naming files 50 
Newcommand 16, 33, 47 
New Page command 42 
newsletters, creating 32 
Next command 55 

O 

objects 16, 61 
aligning 40, 69 
changing 20 
changing shape of 19 

covered 65 
creating 16 
cutting and pasting 20 
definition of 61 
deleting 22 
drawing 17, 62, 74 
duplicating 78 
filled 76 
hidden 76 
locked 76 
moving 19, 68, 74 
order 22 
overlapping 22, 64 
placement on page 75 
resizing 70, 74 
selecting 63 
specifications for 75 
Specifications command 76 
status 75 

copying 77 

Open command 42, 51 
Opening a template 53 
Options menu 57 
outdent 101 
overview (page 

production) 85 

P 

page 
adding 42; 56 
copying 56 
moving to another 55 
numbers 4 
size options 48 
up/down 6 

paragraph spacing 104 
Pastecommand 30, 77, 91 
PCX picture 80 
pica 58 
pictures. See also clip art 

definition of 82 
formats 78, 80 
importing 23, 44, 78 
large 81 
moving 24 
resizing 24, 83 
wrapping text 

around 44, 109 
placement on page 75 
pointers 4, 5 

I-beam 27 
preset options 47 
Previous command 55 
printers x 

changing options 111 
margins for 114 
supported printers 111 

documents 45 
options for 113 
resolution 114 
speed of 114 

Pullout (style) 107 

Q 
quickkeys 28 
quitting 46, 59 
Quotation (style) 107 

R 
replacing text 96 
requirements (hardware) x 
resizing 

printing 111 

objects 70, 74 
pictures 83 

resuming 51 
Reverse Colors command 84 
Right (style) 107 
Rulers 3 

putting away 58 
units of measure in 58 
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S 

Save As command 49 
Save command 50 
saving 36, 49 
Scalecommand 24, 72 
screen 2 
Scrollbars 4, 5 
selecting 

commands 6 
objects 17 
text 28, 89 

Send to Back command 22, 65 
Set Fill tool 21 
Set Grids command 73 
Set Line tool 67 
Set Tabs command 102 
shift-clicking 90 
shortcut keys 7 
Show Clipboard command 30 
Show Page command 45, 55 
Shuffle Down command 65 
Shuffle Up command 65 
sizing 

one dimension 70 
two dimensions 71 

Snap to Grid command 74 
spacing 

character 105 
line 104 
paragraph 104 

Specifications 
command 75, 84 

stacking order, changing 65 
starting Express Publisher 2 
Sticky tool 63 
stories 86 

capacity 86 
definitionof 13, 86, 92 

styles 36, 107 
applying 108 
default 107 

subhead 38 
system requirements x 

T 

tabs 102 
templates 52 

creating 53 
included 53 
opening 54 
revising 53 

appending 96 
centering 99 
control-clicking 98 

text 85 

copying 91 
deselecting 29 
editing 88 
entering 26, 87 
flowing 92 
importing 34, 9 
insertion point See cursor 
replacing 96 
selecting 28, 89 
wrapping 44, 109 

Text (style) 107 
Text Frame tool 26, 88 
textframes 26, 86 

advanced formatting 103 
changing 38 
creating 88 
cutting 91 
definition of 13, 92 
duplicating 92 
formatting 99 
linking 43, 92 
margins 101 
unlinking 94 

Text tool 88 

Thumb 5 
TIFF picture 81 
Title bar 3 
Toolbox 3, 12 

tools 12 

U 
Undo Move command 57 
units of measure 58 
Unlinktool 94 

V 
viewing document 55 

W 
wild card characters 11, 52 
word wrap 27 
WordPerfect 95 
wrapping text around 

pictures 44, 109 

putting away 30 

putting away 58 
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Addendum 

Important user information 

As a new user of Express Publisher for DeskMate, you need to be 
aware of the following information. Please read this information 
closely and keep it in mind when using the product. 

1. When using Express Publisher, as with any software package, it 
is extremely important to save your work frequently. 

2. Many of the features of Express Publisher, such as full justifica- 
tion, line and character spacing options, and styles, require a lot 
of memory. If you experience sluggish performance while 
editing a complex document, wait to apply style and typesetting 
options until the final stages of composition. 

3. If you are working on a large or very complex document and 
performance continues to be slow, or if you experience difficul- 
ties while editing or formatting, you may have memory prob- 
lems. Save your work, exit Express Publisher and DeskMate, and 
then restart both programs. Exiting to DOS will free some 
memory and make it easier to work. 

4. When you are running Express Publisher as a stand-alone 
Runtime product, the only option available from the F10 menu is 

5. In order to improve performance during a heavy editing session, 
Express Publisher does not always redisplay the screen after an 
editing change. This allows you to continue working more 
quickly, but it may cause some text to overlap or “disappear” 
from the screen. Press CTRL-L to redisplay the screen properly. 

Setup. 

Part # 90082-P E x p r e s s  P u b l i s h e r  f o r  D e s k M e t e  



Supplement 

Express Publisher for DeskMate 1.0 

This supplement documents enhancements and changes made to 
Express Publisher for DeskMate since the printing of the manual. 
You should make a note in your manual where any of this informa- 
tion supplements or updates specific sections. 

The supplement is divided into 10 parts: 

Installation 
Beginning 
Objects 
Text 
Selecting a printer 
Trouble shooting 
Supported printers 
Additional clip art 
Additional fonts 
DeskMate accessories 

If you encounter a problem while using Express Publisher, try 
consulting the on-line Help system. 

Install pathname. When the Install program prompts you for the 
drive and program directory, do not type a backslash (\) at the end 
of the pathname. Just type the drive, a colon, a backslash, and the 
directory name, for example, c : \express 

The Install program automatically adds a backslash at the end of 
the pathname. 

Setting up directories, page xi. This paragraph replaces the third 
paragraph under this heading. 

The names of the default directories, \EXPRESS\DOCS, 
\EXPRESS\ART, \EXPRESS\TEXT, and \EXPRESS\FONT, 
cannot be changed. You can change the name of the main directory, 
\EXPRESS, when you first install Express Publisher. 

Installation 
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1. When the Install program prompts you for a pathname, type the 
drive and directory in which you want to install Express Pub- 
lisher. Do not type a final backslash after the directory name. For 
example: c: \publish 

2. Press the down arrow key. The program will change the name of 
the main directory in the pathnames of the four default directories. 

Modifying an existing installation, page xi. The following corrects 
the second bulleted item under this heading. This information also 
applies to the section "Changing the default directory" on page 51. 

After the first installation, you cannot change the name of the 
main program directory or the default directories. 

Beginning Using the mouse, pages 4-5. The mouse cursor may disappear 
when you turn on the Display Grid option by in the Set Grid dialog 
available from the Options menu, To restore it, click the mouse. 

Numeric edit fields, page 9. A numeric edit field is an area in a 
dialog box where you enter a number to specify a measurement. 
Some examples are the Top, Bottom Left, Right, and First Line 
Indent edit fields in the Set Text Frame Margins dialog box. 

If you want to replace the contents of a numeric edit field with a 
number that contains a decimal point, the number must begin with 
a digit. For example, to specify half an inch, enter 0.5, not .5. 

File Utility dialog boxes, page 11. To display all the files in a direc- 
tory in the Files list box, type * (asterisk) in the Extension edit field. 

Scaling objects, page 72. You can scale any object in Express 
Publisher except a line. 

Refreshing the screen. To refresh the screen (restore the corrected 
picture) manually after editing text, press CTRL-L. You may want to 
do this after inserting text, deleting text, or applying font attributes 
commands to selected text. 

Default styles, page 107. Note the following correction to the descrip- 
tion of the Pullout style: it is Marin, 14 pt., bold-italic, centered. 

Wrapping text around pictures, page 110. If the length of the text is 
shorter than the length of the picture frame, you may need to select 
the Text Wrap tool again and wrap the text a second time. 

Objects 

Text 
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If you click twice on the text frame while wrapping text, the text 
may not appear at the end of the process. Select the text frame and 
move it slightly, and the text will reappear. 

YOU must select a printer before you can print an Express Publisher 
document. Unless you change printers, you need to follow this 
procedure only once. 

1. Start Express Publisher. 

2. Pull down the F10 menu and choose Setup. 

3. Pull down the Options menu and choose Printer. 

Selecting a printer 

If you are a Runtime user, you will receive the following mes- 
sage: Please i n s e r t  a disk containing t h e  f i l e  
DMPD.CFG i n t o  any d r ive .  Enter t o  continue, ESC 
t o  cance l .  

4. Press ESC. 

The Printer Settings dialog box appears. 

See your DeskMate manual for instructions. 
5. Select the printer you are using and set the options as needed. 

Trouble shooting Install problems, page 139. The following replaces the first 
paragraph in this section. 

Express Publisher for DeskMate requires DeskMate 3.5. The Install 
program does not determine whether DeskMate is present in your 
system or what version of DeskMate you have. 

To install Express Publisher on a system that is running a version of 
DeskMate earlier than DeskMate 3.5, 

1. Insert Disk 1 in drive A. 

2. Type a: to switch to drive A. 

3. Type i n s t a l l .  

The program will ask you to enter the path name of a directory 
to which to copy the DeskMate 3.5 Runtime files. 

4. Type the name of the directory in which you plan to install 
Express Publisher. 

The Runtime files and the Express Publisher files must be 
installed in the same directory. 
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N o t  enough available memory to run, page 140-141. If this 
message appears, first check to make sure that the Auto-proof 
option in the DeskMate Spell Checker is turned off. Click F10 and 
choose Spell Checker. A check mark appears next to the Auto-proof 
option if it is turned on; click the option to turn it off. 

Pages 151-152. The following text replaces the first paragraph in 
this appendix. 

The column on the left lists all of the supported printers. The printer 
names are the same as the ones that appear in the DeskMate Setup 
Printer dialog box. 

The column on the right lists the name of the printer drivers. 

This table is especially useful if you are using an H P  LaserJet with 
font cartridges. Note that Tandy printers must be set to the stated 
emulation mode in order to print Express Publisher documents. 

See "Selecting a printer" earlier in this supplement for instructions 
on setting up your printer. 

Page 159. Note that Express Publisher for DeskMate does not 
support the HP DeskJet printer or EPS clip art. 

Page 181. Atech's FastFonts supports the following attributes for 
use with Express Publisher: bold, italic, bold-italic underline. 
FastFonts does not support monospace, small caps, superscript, or 
subscript with Express Publisher. 

DeskMate accessories The following DeskMate accessories are available from within 
Express Publisher: 

Setup 
Calculator 
Phone List 
Alarm 
Clipboard 

Supported printers 

Additional clip art 

Additional fonts 
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Express Publisher for DeskMate 
Quick reference card 

Menus 
To select a command with the keyboard, press a function key to pull down a menu 
Type the first letter of the menu command and press ENTER to select, or use the 
accelerator keys. 

Express Publisher Tools 
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Press To do this 

Text editing keys 

BACKSPACE delete the character to the left of 
the cursor. 

DELETE delete the character to the right of 
the cursor. 

INSERT toggle between insert and 
overstrike modes. 

LEFT,RIGHT move the cursor left and right. 
CTRL+LEFT/ move the cursor to the begin- 
CTRL+RIGHT ning of the previous or next word. 
UP, DOWN move the cursor up and down. 
HOME/END move the cursor to the beginning 

or end of the line. 
CTRL+PGUP/ move the cursor to the beginning 
CTRL+PGDN or end of the text in the current frame. 

Dialog bo x control keys 

TAB move the cursor from option to 
option. 

SHIFT-TAB move the cursor in the opposite 
direction. 

LEFT/RIGHT change selected option or icon. 
PGUP/PGDN move the cursor up/down a 

list box. 
ENTER accept the highlighted option, 

or click OK. 
cancel the command and close 
the dialog box without making 
any changes. 

ESC 

Power Up Software 
Corporation 

2929 Campus Drive 
San Mateo, CA 94403 

Function-key 
shortcuts 

F1 Help 
F2 File menu 
F3 Edit menu 
F4 Text menu 
F5 Page menu 
F6 Object menu 
F7 Options menu 
F9 Menu 
F10 DeskMate accessories 

CTRL+O Open a document 
CTRL+S Save a document 
ESC Exit dialog box or 

Express Publisher 
SHIFT+DEL Cut 

SHIFT+INS Paste 
CTRL+D Duplicate 
CTRL+K Show Clipboard 
CTRL+C Clear Clipboard 
CTRL+P Previous Page 
CRTL+N Next Page 
CTRL+G Go to Page 

CTRL+INS copy 

Click these tool icons to activate. 
Double-click, and they remain in effect until you click another tool. 

B o x  L i n e  Align 
Rounded Box Link Equa te  

Ellipse Unlink 
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